
SIMATIC Process Control System PCS 7 V7.0 SP1 PC Configuration and Authorization ______________
______________
______________
______________
______________

 

 

Preface 
 1

PC components of a PCS 7 
system 

 2

Hardware for PC stations 
 3

Installing PC stations 
 4

Appendix 
 5

SIMATIC 

Process Control System PCS 7 
V7.0 SP1 
PC Configuration and Authorization

Operating Manual 

09/2007 
A5E00783465-02 

 



 

 

Safety Guidelines Safety Guidelines 
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The device/system may only be set up and used in conjunction with this documentation. Commissioning and 
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes 
in this documentation qualified persons are defined as persons who are authorized to commission, ground and 
label devices, systems and circuits in accordance with established safety practices and standards. 

Prescribed Usage 
Note the following: 

WARNING  
This device may only be used for the applications described in the catalog or the technical description and only 
in connection with devices or components from other manufacturers which have been approved or 
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, 
positioning and assembly as well as careful operation and maintenance. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Preface 1
Purpose of this documentation 

This documentation provides you with an overview of the PC components used in PCS 7. 
It contains the following information:  
● The PC components that can be used in PCS 7 applications 
● The software and hardware you require for specific PC components 
● The licenses you require for individual products 
● The potential PC configurations for an application 
● How you can set up and configure your PC network 
This documentation is intended for persons involved in configuration, commissioning, and 
service. 

Required basic knowledge 
To understand this documentation, you should be familiar with automation engineering and 
process control engineering.  
You should also have experience of using PCs and similar (for example programming 
devices) and the Windows operating system used.  
Before installing PC components for PCS 7, make sure that you read the pcs7 readme file 
for the latest version of PCS 7. 

Validity of the documentation 
This documentation is valid for the Process Control System; PCS 7 Toolset V7.0 SP1 
software package.  
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Changes compared with the previous version 
Below you will find an overview of the most important changes in the documentation 
compared with the previous version: 
● New PC stations integrated in PCS 7: 

– SIMATIC PCS 7 BOX RTX and SIMATIC PCS 7 AS RTX 
You will find more information on this topic in the manual Process Control System 
PCS 7; SIMATIC BOX. 

– Open PCS 7 for access to PCS 7 systems over intranet/Internet 
You will find information on this topic in the section "Access to PCS 7 data with 
Open PCS 7 (Page 39)" 

● PCS 7 OS Web Option with PCS 7 OS single station system 
You will find information on this topic in the section "Remote access to the OS with the 
PCS 7 OS Web Option (Page 36)" 

● Using SQL Server 2005 
You will find information on this topic in the section "How to install the Microsoft 
SQL server (Page 75)" 

● PC Configuration security settings 
You will find information on this topic in the section "PC Configuration security settings 
(Page 63)" 

● Installing additional services for SIMATIC BATCH 
You will find information on this topic in the section "Installing additional services for 
SIMATIC BATCH (Page 78)" 

● Determining the process objects for the SIMATIC station 
You will find information on this topic in the section "Determining the process objects for 
the SIMATIC station (Page 120)" 

● Determining the process objects for the operator station 
You will find information on this topic in the section "Determining the process objects for 
the operator station (Page 123)" 

Conventions 
In this documentation the designations of elements of the user interface are shown in the 
documentation language. If you have installed a multi-language package for the operating 
system, some of the designations will be nevertheless be displayed in the base language of 
the operating system after you change the language and will, therefore, differ from the 
designations used in the documentation. 

PCS 7 glossary 
You will find a PCS 7 glossary containing definitions of important technical terms used in this 
documentation on the DVD SIMATIC PCS 7; Manual Collection or in the PCS 7 software via 
the SIMATIC Manager Help menu (menu command Help > Contents > "Glossary" button). 

See also 
● Preconfigured PC systems for PCS 7 (product bundles) (Page  49) 



 Preface 
  

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 9 

Further Support 
If you have any technical questions, please get in touch with your Siemens representative or 
responsible agent. 

You will find your contact person at:  

http://www.siemens.com/automation/partner 

You will find a guide to the technical documentation offered for the individual SIMATIC Products 
and Systems at: 

 http://www.siemens.com/simatic-tech-doku-portal 

The online catalog and order system is found under: 

http://mall.automation.siemens.com/ 

Training Centers 
Siemens offers a number of training courses to familiarize you with the SIMATIC S7 automation 
system. Please contact your regional training center or our central training center in D 90327 
Nuremberg, Germany for details:  
Telephone:  +49 (911) 895-3200.  
Internet: http://www.sitrain.com 

http://www.siemens.com/automation/partner
http://www.siemens.com/simatic-tech-doku-portal
http://mall.automation.siemens.com/
http://www.sitrain.com/
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Technical Support 
You can reach the Technical Support for all A&D products 

• Via the Web formula for the Support Request 
http://www.siemens.com/automation/support-request 

• Phone:  + 49 180 5050 222 

• Fax: + 49 180 5050 223 

Additional information about our Technical Support can be found on the Internet pages 
http://www.siemens.com/automation/service 

Service & Support on the Internet 
In addition to our documentation, we offer our Know-how online on the internet at: 
http://www.siemens.com/automation/service&support 

where you will find the following: 

• The newsletter, which constantly provides you with up-to-date information on your products. 

• The right documents via our Search function in Service & Support. 

• A forum, where users and experts from all over the world exchange their experiences. 

• Your local representative for Automation & Drives. 

• Information on field service, repairs, spare parts and more under "Services". 
●  

http://www.siemens.com/automation/support-request
http://www.siemens.com/automation/service
http://www.siemens.com/automation/service&support
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PC components of a PCS 7 system 2
2.1 Basic configuration of the PCS 7 system 

PC components for ES/OS/SIMATIC BATCH/SIMATIC Route Control/SIMATIC IT 
In a PCS 7 system, PC components are used for the following stations: 
● Engineering stations (ES) 
● Operator stations (OS) 
● BATCH stations (BATCH) 
● Route Control Stations (RCS) 
● Stations for connecting SIMATIC PCS 7 to the SIMATIC IT environment 
PCS 7 refers to these stations collectively as "PC stations". The following figure outlines the 
most important components in a PCS 7 plant.  
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Legend for figure 
 
Station Function 
Engineering station 
(Page 15) 

You configure and download all system components of PCS 7 with the engineering station: 
operator stations, BATCH stations, Route Control stations, automation systems, central and 
distributed I/O. 
Engineering stations are PCs on which the PCS 7 engineering software is installed for the 
configuration of a PCS 7 project. 

Operator station 
(Page 16) 

The operator station is used to operate and monitor the PCS 7 system in process mode. 
You connect the operator station to the plant bus to enable the required data communication 
with the automation system. 
Operator stations are PCs on which the PCS 7 OS software is installed.  

Maintenance station 
(Page 16) 

You can view the status of plant components using the maintenance station.  
Maintenance servers are PCs on which the PCS 7 OS software is installed and specially 
configured for diagnostics. 
An engineering station is used as a maintenance client. 

BATCH station 
(Page 16) 

The BATCH station is used to operate and monitor batch process sequences in process mode. 
A connection to an operator station is required for data communication with the automation 
system. The BATCH station is connected to the terminal bus for this purpose. 
BATCH stations are PCs on which the SIMATIC BATCH software is installed. 

Route Control Station 
(Page 16) 

You use a Route Control station (RCS) to automate the transport of materials and products in a 
PCS 7 plant. 
The Route Control station is connected to the plant bus to provide the required data 
communication. A connection to an operator station is required to display messages. 
Route Control stations are PCs on which the SIMATIC Route Control software is installed. 

Bus (terminal bus and 
plant bus) (Page 44) 

The PCS 7 AS, OS, BATCH, RCS and ES components communicate (between and among each 
other) via a bus system (Industrial Ethernet). In PCS 7 plants, this bus is divided into: 
• A terminal bus for communication between the following components: 

– Operator control and monitoring systems (OS, BATCH, RCS) 
– Engineering station 
– Higher-level components (e.g., MES, office networks) 

• A plant bus for communication between: 
– Servers (OS, RCS) and automation systems 
– Automation systems (SIMATIC connections) 

Automation  
system 

The automation system performs the following tasks: 
• The AS acquires and processes the process tags from the connected I/O (centralized and 

distributed) and outputs control information and set points to the process. 
• The AS supplies the operator station with data for visualization. 
• The AS recognizes operator inputs and returns them to the process. 

SIMATIC PCS 7 BOX 
(Page 34) 

An industrial PC, which comprises the functions of a PCS 7 process control system (engineering, 
automation, operator control and monitoring) when used in conjunction with a distributed I/O. 
You use PCS 7 BOX for small stand-alone systems or combined AS/OS stations that can be 
integrated in the PCS 7 network.  
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2.2 Fault-tolerant (redundant) configurations 

Introduction 
The use of fault-tolerant components in a process control system minimizes the risk of a 
production downtimes. A redundant design ensures increased availability of a control 
system. This means that all components involved in the process have a backup and perform 
a portion of the control tasks. 
If a fault occurs or one of the process control system components fails, the still functional 
redundant component takes over the control task. 

Redundancy for PC stations in a PCS 7 system 
You can use redundant components in PCS 7 to ensure high availability of PC stations.  
● Note the following properties for redundant server pairs: 

 
Property Description 
Reaction to server failure In a project with a redundant server pair, the advantage is that if one of 

the servers fails, operator control and monitoring of the process can 
continue via the redundant server. 

Number of servers Maximum 12 servers (pairs) in a PCS 7 system 
Behavior from the client 
perspective 

From a client perspective, a redundant server pair behaves like one 
server. 

Configuration You configure all of the configuration data for one server only. You then 
download the configuration data to both redundant servers. 

● Note the following properties for redundant network components: 
 

Property Description 
Switch over in the event 
of a terminal bus failure 

The following network adapters are used for a redundant connection of 
the PC stations to a terminal bus: 
• Server adapter: Pro/1000MT 
• Desktop adapter: Pro/1000GT 
You can find additional information about this in the function manual 
Process Control System PCS 7; Fault-Tolerant Process Control 
Systems. 

Switch over in the event 
of a plant bus failure 

The CP 1613 is used for a redundant connection of the PC stations to a 
plant bus. 
You will find more information on this topic in the function manual 
Process Control System PCS 7; Fault-Tolerant Process Control 
Systems. 

Response to cable failure 
(disruption in a ring line) 

The typical networks in a ring structure in PCS 7 feature cable 
redundancy.  
The network remains in operation even if one cable fails.  

Response to failure of 
network adapters of PCs 
or switches 

If you use redundant network adapters and redundant network 
connections, the network remains in operation even when a network 
adapter or switch fails. 

Configuration ProSet® from Intel is used to configure the network properties. 
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Recommendations 
You should always use redundant server pairs when the availability of the respective 
application is critical to your PCS 7 plant. 
If PC stations of a PCS 7 plant are integrated in a domain, we recommend that you use 
several domain controllers. 

Additional information 
● You can find information about the client-server architecture in the section "Differences 

between a Multiple Station System and a Single Station System (Page 16)" 
● You can find information about activating redundancy for operator stations in the function 

manual Process Control System PCS 7; Fault-Tolerant Process Control Systems. 
● You can find information about configuring and implementing redundancy for BATCH 

stations in the manual Process Control System PCS 7; SIMATIC BATCH. 
● You can find information about configuring and implementing redundancy for Route 

Control stations in the manual Process Control System PCS 7; SIMATIC Route Control. 



 PC components of a PCS 7 system 
 2.3 Options when working with engineering stations 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 15 

2.3 Options when working with engineering stations 

Working with several PCs 
You have a variety of options available when working on engineering stations to engineer 
PCS 7 systems. You can, for example, use more than one PC when engineering a PCS 7 
system if a single PC is inadequate for the job.  
The difference between working with multiple PCs when engineering and working with a 
single engineering station only involves a few steps. 

 
Property Working with multiple engineering stations Working with a single engineering station 
Area of application • Medium-sized and large systems 

• Configuration phases 
• Spatially distributed configuration of 

engineering stations 

• Small systems 
• Local operator stations 
• Training systems 

Monitors 1 or 2 recommended 
Combination/ 
Method 

• Engineering for a PCS 7 project with 
multiple engineering stations (Page 19) 

• Engineering for a PCS 7 project with a single 
PC (Page 20) 

• Combination of engineering station and operator 
station on a single PC (Page 21) 

• Engineering with SIMATIC PCS 7 BOX: 
You will find information on this topic in the 
manual Process Control System PCS 7; 
SIMATIC PCS 7 BOX 
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2.4 Differences between multiple station systems and 
single station systems 

You can configure each PCS 7 application for process mode (OS, BATCH, RCS) as a single 
station system or a multiple station system with client-server architecture.  

Definition of a multiple station system 
A multiple station system is a system of related PCs in which the functionality of a PCS 7 
application in a client/server architecture is distributed over several PCs (for example, OS 
clients, OS servers). The PCS 7 Toolset DVD provides the appropriate client or server 
software for this.  
In the case of multiple station systems, we recommend that you configure a terminal bus 
(separate from the plant bus) for data communication between clients and servers.  

Definition of a single station system 
A single station system is a PC that provides the entire functionality of a PCS 7 application 
(e.g., operator station). The PCS 7 Toolset DVD provides the single station software for this.  
You can connect single station systems to the plant bus as well as to the terminal bus (for 
example, when there are also multiple station systems in the PCS 7 system). 

Properties of multiple and single station systems 
 
Property Multiple station system Single station system 
Areas of 
application 

Medium-sized and large systems • Small systems 
• Local operator stations 
• Training systems 

Configuration Client-server architecture with multiple PCs: 
• Operator station multiple station system 

(Page 22) 
• BATCH station multiple station system 

(Page 24) 
• Route Control station multiple station 

system (Page 25) 
• Maintenance station (MS) multiple station 

system (Page 26) 

One PC for all functions of a  
PCS 7 application: 
• OS single station (Page 29) 
• BATCH single station (Page 31) 
• Route Control single station (Page 32) 
• SIMATIC PCS 7 BOX stations (Page 34) 
• Maintenance station single station system 

(Page 33) 

Workstations Up to 32 workstations per server 1 workstation with a maximum of 4 monitors 
(depending on the application) 
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Property Multiple station system Single station system 
Availability To guarantee high availability of the PCS 7 plant, you can configure the server as redundant server 

pairs (PCs): 
• Operator station 

– OS server 
– Central archive server 
– MS server 

• BATCH station 
– BATCH server 

• Route Control Station 
– Route Control server 

You can find additional information on this in the section "Fault-Tolerant (Redundant) Configurations 
(Page 13)". 

Number of servers Maximum 12 server (pairs) in the PCS 7 system. The following each count as one server: 
• Server for multiple station systems 
• Redundant server pair 
• MS server 
• Central archive server 

Intranet and Internet connection 
You can realize the connection to an Intranet and Internet via Open PCS 7 or 
PCS 7 Web Option. 
You can find additional information about this in the sections "Remote Access to the 
OS Using PCS 7 OS Web Option (Page 36)" and "Access to PCS 7 Data Using Open PCS 7 
(Page 39)".  
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Example configuration 
The following example configuration show the use of multiple station and signal station 
systems in a PCS 7 plant: 
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2.5 Solutions for engineering stations 

2.5.1 Engineering for a PCS 7 project with multiple engineering stations 

Distribution of engineering tasks 
You can distribute the engineering tasks for a PCS 7 system over several engineering 
stations. PCS 7 provides the following options for this:  

 
Option Application 
Configuring in a 
multiproject 

You can use multiproject engineering to allow several project teams to work 
on complex projects at the same time. 
The engineering stations can be connected over a network or be located in 
separate areas. 

Branching and 
merging charts of a 
project 

You can branch and merge the projects at the chart level (S7 program) to 
allow several engineers to work at the same time. 

Configuring over a 
network 

Several engineers can work on specific parts of a project (e.g., AS, OS) 
stored on a central engineering server at the same time, working from their 
networked engineering stations. 

Example configuration for multiproject engineering 

 
 

Additional information 
The engineering procedure is described in detail in the configuration manual Process Control 
System PCS 7; Engineering Station. 
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2.5.2 Engineering for a PCS 7 project with a single PC 

Central engineering 
You can configure a PCS 7 system centrally for all PCS 7 applications (OS, BATCH, 
Route Control, AS) with a single engineering station. 
Connect the engineering station to the plant bus and terminal bus if you want to download 
the configuration data to the target systems and test it in process mode. 

Example configuration 

 
 

SIMATIC PCS 7 BOX 
SIMATIC PCS 7 BOX can also be used as an engineering station for small standalone 
systems. You can find additional information about this in the manual Process Control 
System PCS 7; SIMATIC PCS 7 BOX. 
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2.5.3 Combination of engineering station and operator station on a single PC 

Engineering station and operator station on a single PC 
You can configure a small system (such as a training station) centrally for all PCS 7 
components (OS, BATCH, Route Control, AS) with a single engineering station. You can 
combine the engineering station and an operator station for this purpose. 
The example configuration below shows a plant with a joint plant/terminal bus. You use this 
bus to download the configuration data to the target system both for testing and for process 
mode. 

Example configuration 

 
 

SIMATIC PCS 7 BOX 
SIMATIC PCS 7 BOX can also be used as an engineering station for small standalone 
systems. You will find more information on this topic in the section "SIMATIC PCS 7 BOX 
stations (Page 34)" and in the manual Process Control System PCS 7;  
SIMATIC PCS 7 BOX. 
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2.6 Solutions for multiple station systems 

2.6.1 Operator station multiple station system 

Operator station as multiple station system with client-server architecture 
● The OS multiple station system consists of OS clients (workstations), which are supplied 

with data (project data, process values, archives, alarms, and messages) from an 
OS server (or multiple OS servers) via a terminal bus (OS LAN). 

● The OS server can supply process data to up to 32 OS clients. 
● The OS clients can access data from up to 12 OS servers simultaneously (multi-client 

mode). 
● Up to 4 monitors can be connected to a workstation (OS client) via a multi-VGA card. You 

can operate the resulting system areas with a single keyboard and mouse. 
● The OS servers feature additional client functions that allow them to access data on other 

OS servers (their archives, messages, tags and variables). Process pictures from an 
OS server can then also contain tags of other OS servers. 

● You can achieve high availability for the operator station by configuring redundant 
OS servers or by using more than one OS server with the same configuration. The 
OS Software Redundant Server Pack is required for redundant OS servers. 

  
 

 Note 
If you operate no more than four OS clients on an OS server, you can use the OS server as 
an operation and monitoring station. 

 

Example of a configuration 
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Central archive server 
You can configure an OS server as a central archive server.  
● The central archive server is a node on the terminal bus and is not connected to the plant 

bus. 
● The central archive server can be configured redundantly. 
You will find more information on this topic in the section "Long-term archiving using the 
central archive server (Page 28)". 

Maintenance station 
The maintenance station is configured in the client-server architecture, with the engineering 
station as the maintenance client (MS client). 
You can find more information on this topic: 
● In the section "Maintenance station multiple station system (Page 26)" 
● In the configuration manual Process Control System PCS 7, Operator Station 

PCS 7 OS Web Option for an operator station multiple station system 
In PCS 7 you can use Internet Explorer to access the OS of a PCS 7 plant, provided that the 
PCS 7 OS Web Option is installed on it and the necessary access rights have been set in 
the network. 
You will find information on this topic in the section "Remote access to the OS with the 
PCS 7 OS Web Option (Page 36)". 
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2.6.2 BATCH station multiple station system 

BATCH station as multiple station system with client-server architecture 
● A BATCH station multiple station system consists of BATCH clients (workstations) that 

are supplied with data (project data, process values, archives, alarms and messages) 
from a BATCH server via a terminal bus. 

● A BATCH server supplies process data to up to 32 BATCH clients. 
● There can only be one BATCH project with one BATCH server in a PCS 7 plant.  

Only one BATCH project can be activated on a BATCH server. 
● Several PCS 7 systems can be operated and monitored with one BATCH client. To do 

this, start several BATCH client applications on the BATCH client and select different 
BATCH projects (each with a BATCH server) at startup. In this situation, you will find a 
multi-VGA card practical. 

● You can achieve high availability for the PCS 7 plant by configuring a redundant BATCH 
server. In terms of the number of servers in a PCS 7 project, a redundantly configured 
BATCH server is counted as a single BATCH server. 

 

  Note 
If you operate no more than 4 BATCH clients on a BATCH server, you can use the 
BATCH server as an operator control and monitoring station in PCS 7 V6.0 SP3 and 
higher. 

Example of a configuration 
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2.6.3 Route control station multiple station system 

Route control station as multiple station system with client-server architecture 
● A route control station multiple station system consists of route control clients 

(workstations) that are supplied with data (project data, process values, archives, alarms 
and messages) from a route control server via a terminal bus. 

● A route control server supplies process data to up to 32 route control clients. 
● There is only one route control project with one route control server in a PCS 7 system 

(even when redundant). 
● The route control server requires a connection to an OS to store messages. 
● Up to 4 monitors can be connected to a workstation (route control client) via a multi-VGA 

card. You can operate the resulting system areas with a single keyboard and mouse. 
● You can achieve high availability for the route control station by configuring a redundant 

route control server. In terms of the number of servers in a PCS 7 project, a redundantly 
configured route control server is counted as a single route control server. 

 

  Note 
If you operate no more than 4 route control clients on a route control server, you can to 
use the route control server as an operator control and monitoring station in PCS 7 V6.1 
and higher.  

Example of a configuration 
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2.6.4 Maintenance station multiple station system 

Maintenance stations 
Maintenance stations are PC stations intended for diagnostics of a PCS 7 plant and asset 
management of the PCS 7 plant. 
The maintenance station consists of the following components: 
● Maintenance server (MS server) 
● Maintenance client (MS client) 

Maintenance station as multiple station system with client-server architecture 
The maintenance station multiple station system consists of the MS client (workstation) that 
is supplied with data (project data, archives, alarms and messages) from an MS server. 
● MS client 

The MS client uses diagnostic screens to visualize the diagnostic status and provides 
required operation and monitoring functions. The MS client is a configured as the 
engineering station for this. 

● MS server 
The MS server concentrates the picture information and data required for system 
diagnostics on one PC. The MS server needs the following data to display information on 
the MS client: 
– Server data from the OS servers 
– Configuration of the network components 

Up to 4 monitors can be connected to a workstation (MS client) via a multi-VGA card. You 
can operate the resulting system areas with a single keyboard and mouse. 
You can achieve high availability for the maintenance station by configuring a redundant MS 
server. 

Example configuration 
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Notes on installing the maintenance station 
Note the following points during installation: 
● The MS server is an OS server configured for system diagnostics. 
● The MS client is a component of the engineering station. You can find instructions for 

configuration in the configuration manual Process Control System PCS 7; Operator 
Station 

You can find more information about installation in the section "How to install the PCS 7 
software (Page 85)". 

Additional information 
● Appendix "Approved configurations (Page 204)" 
● Configuration manual Process Control System PCS 7, Operator Station 
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2.6.5 Long-term archiving with the central archive server 

Introduction 
The central archive server is used for long-term archiving of diverse data from PCS 7 in a 
central database. Using the central archive server, you can manage measured values and 
messages transferred from the OS archives, OS reports and batch data of SIMATIC BATCH. 
The archive data is available regardless of the status of PCS 7 runtime systems. This allows 
you to view all data clearly organized using Internet Explorer. 
You can achieve high availability of the central archive server by configuring the central 
archive server redundantly. 

Functions 
You can perform the following functions with the central archive server: 
● Archive messages and process values from PCS 7 OS 
● Archive OS reports 
● Archive batch data from SIMATIC BATCH 
● Transfer all archive data to external storage media 
● Catalog all archive data 
● Display messages using filter functions 
● Display the process values in graphs and tables using filter functions 
● Export process values as a CSV or XML file 
● Display the archive data of a batch 
● Display archive data in a web-based display 

Access protection  
You can configure access protection with user-specific rights on the central archive server. 

Notes on installing the central archive server 
Note the following points during installation: 
● To improve performance, install the central archive server on a separate PC. 
● We recommend a RAID system for data integrity. 
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2.7 Solutions for single station systems 

2.7.1 OS single station 

OS as single station system on a single PC 
● The OS single station is an operator station on a single PC with complete operator control 

and monitoring functionality for a PCS 7 project (process cell/unit). 
● The OS single station system on the plant bus can be used at the same time as other 

single station or multiple station systems. 
● You can achieve higher PCS 7 plant availability by configuring redundant OS single 

stations or by using more than one OS single station with the same configuration. You 
can also use the WinCC/Redundancy software to operate two OS single stations 
redundantly. 

● The operator single station can also be used in combination with an engineering station 
on a PC. 
You will find more information on this topic in the section "Combination of engineering 
station and operator station on a PC (Page 21)". 

● You can also use the operator single station in combination with an engineering station 
and an automation system on a PC. This solution is offered as the SIMATIC PCS 7 BOX. 

Example configuration 
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PCS 7 OS Web Option for an OS single station 
In PCS 7 you can use Internet Explorer to access the OS of a PCS 7 plant, provided that the 
PCS 7 OS Web Option is installed on it and the necessary access rights have been set in 
the network. 
You will find information on this topic in the section "Remote access to the OS using PCS 7 
OS Web Option (Page 36)". 

More information 
● Section "Combination of engineering station and operator station on a single PC 

(Page 21)" 
● Function manual Process Control System PCS 7; SIMATIC PCS 7 BOX 
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2.7.2 BATCH single station 

BATCH as single station system on a single PC 
● The BATCH single station is a BATCH station on a single PC. Complete operator control 

and monitoring functionality is available for a process cell. A BATCH single station is 
associated with a BATCH project (process cell/unit). 

● A connection to an operator station (OS server) is required for data communication with 
the automation system. 

● You use a BATCH single station to operate and monitor an entire plant. When several 
process cells are operated in parallel, an additional BATCH single station with 
corresponding connections to the OS server is needed for each process cell. If you are 
monitoring several process cells, we recommend using a BATCH station multiple station 
system (Page 24). 

● If several BATCH single stations are used: Each BATCH single station used must be 
connected to another OS system. 

● You can operate BATCH single stations redundantly. 
● A connection to an OS server must exist in order to use process mode. 

Example configuration 
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2.7.3 Route control single station 

Route control as a single station system on a single PC 
● The route control single station is a route control station on a single PC. You use the 

route control single station to automate the transport of materials and products in a 
PCS 7 system. 

● You can operate route control single stations redundantly. 
● A connection to an OS server is required for process mode. 

 

  Note 
If you use route control single stations at the same time as other route control systems, 
you will need to separate the areas that are controlled by one system.  

Example of a configuration 

 
 



 PC components of a PCS 7 system 
 2.7 Solutions for single station systems 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 33 

2.7.4 Maintenance station single station system 

Maintenance station as a single station system 
● Maintenance stations are PC stations intended for diagnostics of a PCS 7 plant and asset 

management of the PCS 7 plant. 
● The maintenance station as a single station system consists of a combination an OS 

single station and engineering station. 

Additional information 
● Section "Maintenance station multiple station system (Page 26)" 
● Section "OS Single Station (Page 29)" 
● Section "Combination of Engineering Station and Operator Station on a Single PC 

(Page 21)" 
● Appendix "Approved Configurations (Page 204)" 
● Configuration manual Process Control System PCS 7, Operator Station 
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2.7.5 SIMATIC PCS 7 BOX stations 

SIMATIC PCS 7 BOX stations as combined AS/ES/OS for small systems 
PCS 7 Box PCs (bundle PCs) with various hardware configurations and software 
installations are available for use as a PC station or automation system in PCS 7. 
The following configurations are possible with PCS 7 Box PCs (bundle PCs):  
● Bundle: SIMATIC PCS 7 BOX as SIMATIC PCS 7 complete system with AS, ES and OS 

functionality: 
– SIMATIC PCS 7 BOX as a single station system with AS/ES/OS 

● Bundle: SIMATIC PCS 7 BOX as SIMATIC PCS 7 runtime system with AS, ES and OS 
functionality: 
– SIMATIC PCS 7 BOX with separate engineering 
– SIMATIC PCS 7 BOX in the PCS 7 network 

● Bundle: SIMATIC PCS 7 AS RTX 
– SIMATIC PCS 7 AS RTX is an automation system (AS) with PLC WinAC RTX 

software on a MICROBOX PC. 
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Example configuration 
The following figure shows an example of a SIMATIC PCS 7 BOX as a single station system 
with AS/ES/OS and connected distributed I/O. 
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Ordering information 
 

 Note 
You can find the ordering information for bundles PCs in the ST PCS 7 catalog. 

 

Additional information 
● Section "Selecting the Correct License Keys/Authorization (Page 117)" 
● Section "Software Packages and Required License Key (Page 166)" 
● Manual Process Control System PCS 7; SIMATIC PCS 7 BOX 
● Product information SIMATIC; PCS 7 V7.0 SP1 BOX 416 
● Product information SIMATIC; PCS 7 V7.0 SP1 BOX RTX 
● Product information SIMATIC; PCS 7 V7.0 SP1 AS RTX 
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2.8 Solutions for accessing PC stations 

2.8.1 Remote access to the OS using PCS 7 OS Web Option 

PCS 7 OS Web Option for remote access to the OS 
You can use the PCS 7 OS Web Option for operator control and monitoring of automated 
processes with PCS 7 via the Intranet/Internet. You will find additional information on this 
topic in the manual Process Control System PCS 7; PCS 7 OS Web Option. 
PCS 7 OS Web Option consists of two components: 
● PCS 7 OS Web Server  

Within the OS, the PCS 7 OS Web server is an OS client with PCS 7 OS Web server 
functionality. 

● PCS 7 Web client 
The PCS 7 Web client accesses project data available on the PCS 7 OS Web server via 
the Intranet/Internet, with the help of Internet Explorer. The process can be operated and 
monitored. 

PCS 7 OS Web Option can be used in a PCS 7 system with the following configurations:  
● For an OS multiple station system 

– Configuration with PCS 7 OS Web server and PCS 7 Web client 
● For an OS single station 

– Configuration with PCS 7 OS Web standard server and PCS 7 Web standard client 
– Configuration with PCS 7 OS Web diagnostics server and PCS 7 Web diagnostics 

client 
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Example configuration 
The following figure is an example of a configuration using a PCS 7 OS Web server and a 
PCS 7 Web client. 
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Notes on the PCS 7 OS Web server and Web client  
● For an OS multiple station system: 

– An OS client that is configured as a PCS 7 OS Web server can no longer be utilized 
as an operator station (OS client) within the PCS 7 system. 

– The maximum number of Web clients per OS Web server is restricted by the license 
key (licensing for 3, 10, 25 or 50 Web clients). 

● For an OS single station: 
– The OS single station that is configured with PCS 7 OS Web server can still be utilized 

within the PCS 7 plant as an operating station (OS). 
– An OS single station (as OS Web server) can simultaneously access data on up to 3 

Web clients. 
– A Web diagnostic client can simultaneously access data on up to 3 OS single stations 

(OS Web diagnostic server). 
● The maximum number of Web clients is limited by the license key. 

Additional information 
● You will find information about installation in the manual Process Control System PCS 7; 

PCS 7 OS Web Option. 
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2.8.2 Access to PCS 7 data using Open PCS 7 

Open PCS 7 
Data from a PCS 7 plant can be made available to third-party systems using OLE DB or 
OPC via a PC station with Open PCS 7 (Open PCS 7 station). 
You can use Open PCS 7 at the following levels:  
● Automation level 
● Plant control and production control levels 
● MES level (Manufacturing Execution Systems) 
● ERP level (Enterprise Resource Planning) 

Configuration of the Open PCS 7 station 
The Open PCS 7 station is a PC on which a server for OPC and OLE/DB is installed. 
The Open PCS 7 station performs the following tasks: 
● It makes the PCS 7 data of the automated process available over the OPC interface. 
● It allows the client applications (OPC or OLE DB) to access the available PCS 7 data. 
The Open PCS 7 station is connected to the PCS 7 plant via the terminal bus. 
In process mode, the Open PCS 7 station communicates with the automation systems via 
the operator station (OS server). 
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Examples of configurations 
Typical configurations with Open PCS 7 are shown in the following figure. 

 
 
 

No. Configuration Area of application 
1 Open PCS 7 station, OS client, and client applications 

(OPC or OLE/DB) on a shared PC 
Single station system:  
Recommended for small systems 

2 Open PCS 7 station and client applications (OPC or 
OLE/DB) on separate PCs connected to one another 
via an additional network (Intranet/Internet in the 
diagram)  
With this configuration, the Open PCS 7 station can 
also be installed on an OS client. 

Multiple station system with client-
server architecture:  
Recommended for medium-sized and 
large systems 

3 Open PCS 7 station and client applications (OPC or 
OLE/DB) on separate PCs connected to one another 
via an additional network (Intranet/Internet in the 
diagram), which access the PCS 7 plant's terminal 
bus, protected by a firewall 

Multiple station system with client-
server architecture:  
Recommended for medium-sized and 
large systems 

Client applications, standard interface formats, and access possibilities 
Client applications access data on the Open PCS 7 station via interfaces. 
● Open PCS 7 uses the following standard interface formats for data communication: 
● OPC DA (Data Access) 
● OPC A&E (Alarm and Event and Historical Alarm and Event) 
● OPC HDA (Historical Data Access) 
● OLE/DB (integration of data in applications that support OLE (e.g., MS Office)) 
 You will find more information on this topic in the configuration manual Process Control 
System PCS 7; Engineering Station. 
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Accessing data of redundant server pairs 
You can access data of redundant server pairs using the Open PCS 7 station. If a PC station 
(master) fails, the redundant PC station is connected automatically for the next read job. 
If the connection is interrupted during a read job, the Open PCS 7 station attempts to read 
data from the redundant partner. 

Possible access depending on the license key used 
PCS 7 data can be accessed via Open PCS 7 under the following conditions as regards 
license keys: 
● If you use the "OpenPCS 7/WinCC" license key and operate the Open PCS 7 station on 

an OS client, the OS client must be in process mode. 
● If you use the "OpenPCS 7" license key, you can always access PCS 7 data via 

Open PCS 7. 

More information 
● Configuration manual Process Control System PCS 7; Engineering Station 
● Configuration manual Process Control System PCS 7; Operator Station 
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2.9 Connecting PC stations 

2.9.1 Bus connection between AS, OS, BATCH, RCS and ES 

Terminal bus and plant bus 
With PCS 7, the AS, OS, BATCH, Route Control and ES communicate via a bus system 
(Industrial Ethernet). The bus system is divided as follows in PCS 7: 

 
Bus For communication between the following components 
Terminal bus • Operation and monitoring systems (OS, BATCH, Route Control) 

• Engineering station 
• Higher-level components (for example, MES, office networks) 

Plant bus • Servers (OS, Route Control) and the automation systems 
• Automation systems (SIMATIC connections) 

Example configuration 
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More information 
The configuration manual "Process Control System PCS 7, Engineering Station" contains 
information on  
● Cables and network components 
● Distances between the components of a PCS 7 plant 
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2.9.2 Connection to the terminal bus/plant bus 

Attachment of OS, BATCH, Route Control and ES 
You connect operator stations, BATCH stations, Route Control stations and engineering 
stations to Industrial Ethernet using communication cards. The communication cards use a 
slot in the PC or programming device (PG). You use different communication cards 
depending on your requirements.  

Additional information 
You will find an overview of the possible communication cards in the section "Components 
for connecting to the terminal/plant bus (Page 53)". 

Example configuration 
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Connecting the AS 
You connect automation systems to Industrial Ethernet using the CP 443-1 communications 
processor or the CPU's Ethernet interface. The protocols used are TCP/IP, ISO, and UDP. 

Cables and network components 
You will find information on this topic in the configuration manual "Process Control System 
PCS 7, Engineering Station": 
● Cables and network components 
● Possible distances within a PCS 7 plant 

Redundant bus systems 
You can use redundant communication paths in PCS 7. You will find information on this topic 
in the PCS 7 Function Manual; Fault-Tolerant Process Control Systems. 
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2.9.3 Connecting PC Stations via Wireless LAN 

Connecting a PC station via Industrial Wireless LAN (IWLAN) 
Industrial Wireless LAN (IWLAN) enables you to integrate mobile or stationary PC stations 
via an access point in a PCS 7 plant. You can integrate the following PC stations: 
● OS clients  

Up to 2 OS clients (to IWLAN) 
● Web clients  

Up to 2 Web clients to a PCS 7 Web server (to IWLAN) 
● PC station  

One PC station for remote access to an engineering station using NetMeeting or Remote 
Desktop, during commissioning, for example 

Components for IWLAN in PCS 7 
The "PCS 7 - Released Modules" documentation lists the network and PC components that 
are approved for IWLAN in PCS 7. 
You can find the documentation on the PCS 7 Toolset DVD or following installation of PCS 7 
with the menu command Start > SIMATIC > Documentation > <language> > PCS 7 - 
Released Modules. 

Example for IWLAN in PCS 7 
The figure show a basic configuration of WLAN components in a PCS 7 plant. 

Additional information 
You can find information on WLAN components, installation guidelines and settings in the 
following documentation: 
● Product Information Process Control System PCS 7; PCS 7 - Released Modules 
● System manual SIMATIC NET; Basics - Industrial Wireless LAN 
● Operating instructions SIMATIC NET;  

SCALANCE W788-1PRO (Access Point),  
SCALANCE W788-2PRO (Dual Access Point),  
SCALANCE W788-1RR (Access Point iPCF), 
SCALANCE W788-2RR (Dual Access Point iPCF) 

● Operating instructions SIMATIC NET; CP 7515 
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2.9.4 Time-of-day synchronization 

Time synchronization 
In a synchronized process control system, all the individual time-dependent components 
have an identical date and identical time of day. We recommend that you use SIMATIC 
components as the time master for a PCS 7 plant (for example, SICLOCK TM). 

Synchronizing the time of day throughout the system 
To obtain process data that can be evaluated, all the components of the process control 
system need to work with an identical time of day. This allows you to assign messages in the 
correct sequence over time. The result is then consistent regardless of the time zone where 
the messages originate. 
To achieve this, an OS server, for example, assumes the function of time master. All the 
other operator stations and automation systems on the plant bus then have the identical time 
that they received from this time master. 
The time of day is synchronized through both busses in a system: 
● Terminal bus 

OS servers synchronize OS clients via the terminal bus. BATCH and Route Control 
stations get the time from the terminal bus via a client program (DCF77) if they are not 
installed on a PC with an OS. In a Windows domain the domain controller can send the 
time of day to the OS server that is currently acting as the active time master. 

● Plant bus 
OS servers synchronize automation systems via the plant bus. 
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Synchronization options 
 

Station Synchronization options Additional information 
Operator station 
and  
Maintenance station 

• Synchronize the time via the 
terminal bus 

• Synchronize the time via the plant 
bus 

Configuration manual Process Control 
System PCS 7;  
Operator Station 

BATCH station • Synchronize the time via the 
operating system 

Synchronize SIMATIC BATCH 
components using resources of the 
operating system. 

Route Control 
Station 

• Synchronize the time via the 
operating system 

Synchronize Route Control station 
components using resources of the 
operating system. 

SIMATIC PCS 7 
BOX 

• Synchronize the time during 
integration in a PCS 7 plant 

Manual Process Control System PCS 
7; SIMATIC PCS 7 BOX 

AS • Synchronize the time with the AS 
• Synchronize the time with the AS 

as the time slave 

Configuration manual Process Control 
System PCS 7; Engineering Station 

Domains • Synchronize the time with a 
domain controller as the time 
master on the terminal bus 

Configuration manual  
Process Control System PCS 7;  
Operator Station 

Time master • The time master is integrated in a 
PC or connected to Ethernet as a 
bus component. 

• The time master can be any 
device which can transmit a time 
signal via Ethernet (e.g., a PC). 

Configuration manual  
Process Control System PCS 7;  
Operator Station 
Manual  
SIMATIC NET; SICLOCK TM 
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Hardware for PC stations 3
3.1 Preconfigured PC systems for PCS 7 (product bundles) 

PC hardware for engineering stations (ES) and operator stations (OS)  
Special versions of the basic hardware (bundles), which have been optimized for the 
corresponding application, are available for engineering stations (ES) and operator stations 
(OS).  
The preconfigured PC systems that are available for PCS 7 can be found in the current 
ST PCS 7 catalog under the keyword "basic devices". 
We recommend PCS 7 BOX PCs for use in small standalone systems or for combined 
AS/OS stations in the PCS 7 network.  
You will find more information on this topic in the manual Process Control System PCS 7; 
SIMATIC BOX. 
If you use other PCs for PCS 7, you will find the relevant hardware requirements in the 
section "Recommended basic hardware configuration (Page 50)". 

Color monitors 
Siemens industrial monitors are available for use as PCS 7 process monitors, depending on 
the prevailing environmental conditions. 
We recommend you use monitors with a minimum resolution of 1280 x 1024, which will 
enable you to fully utilize the graphical options offered by the PCS 7 software. 

Connecting preconfigured PC systems to the network 
All PCS 7 bundle PCs are configured for a Windows workgroup. 
If you include preconfigured PC systems in a Windows domain, you must reactivate the 
security settings by means of the PCS 7 setup. 
You will find more information about security settings in the section "How to retro-activate the 
security settings for PCS 7 (Page 145)". 

More information  
● Catalog ST PCS 7  
● Catalog ST PCS 7.1 (Add Ons for SIMATIC PCS 7) 
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3.2 Basic hardware configuration 

Introduction 
This section contains information on equipping the PC stations with basic hardware: 
● Recommended basic hardware configuration 
● Minimum basic hardware configuration 

Recommended basic hardware configuration 
We recommend the following configuration for PC components (the higher the quality of the 
equipment, the better): 

 
Parameters Central engineering station with server 

operating system, central archive server,  
PCS 7 OS/SIMATIC BATCH/SIMATIC 
Route Control on a PC,  
engineering station,  
OS server,  
OS single station,  
maintenance station,  
PCS 7 Web server, OS client, and BATCH 
client on a PC,  
BATCH server,  
BATCH single station,  
Route Control server,  
Route Control single station 

OS client,  
BATCH client,  
Route Control client 

Basic PC (see catalog) SIMATIC Rack PC 547B 
Processor Intel Core2Duo E6600 
Clock-pulse rate 2.40 GHz 
Second-level cache (SLC) 4 MB 
Front-side bus (FSB) 1066 MHz 
Work memory (RAM) 2.0 GB 1.0 GB 
Hard disk 
 
 
Partition size 

250 GB SATA RAID 1 array in servers and  
ES/OS single stations 

250 GB SATA in client systems 
C:\ 50 GB 

250 GB SATA 
 
 

C:\ 50 GB 
Network 
adapters/Communications 
interfaces  
• For terminal bus 

communication 
• For plant bus 

communication 

 
 
 
• RJ45 on-board gigabit Ethernet  

 
• CP1613 A2 or BCE network adapter for 

engineering station and OS server 

 
 
 
• RJ45 on-board gigabit Ethernet 
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Parameters Central engineering station with server 
operating system, central archive server,  
PCS 7 OS/SIMATIC BATCH/SIMATIC 
Route Control on a PC,  
engineering station,  
OS server,  
OS single station,  
maintenance station,  
PCS 7 Web server, OS client, and BATCH 
client on a PC,  
BATCH server,  
BATCH single station,  
Route Control server,  
Route Control single station 

OS client,  
BATCH client,  
Route Control client 

Opt. drive • For all apart from engineering station:  
DVD-ROM 

• For engineering station:  
DVD+/-RW 

DVD-ROM DV 

 
 
Parameters SIMATIC BOX PC 627B SIMATIC Microbox PC 427B 
Processor Intel Core2Duo Mobile T7400 Pentium Mobile M738 
Clock-pulse rate 2.16 GHz 1.4 GHz  
Second-level cache (SLC) 4 MB 2 MB 
Front-side bus (FSB) 667 MHz 400 MHz 
Work memory (RAM) 2.0 GB 1.0 GB 
Hard disk 
Partition size 

160 GB SATA 
C:\ 30 GB 

CompactFlash card: 2.0 GB 

Network 
adapters/Communications 
interfaces 

• 2 x RJ45 on-board gigabit Ethernet 
• On-board CP5611 
• In "SIMATIC PCS 7 BOX RTX" bundle, 

additional CP5613 A2 

• 2 x RJ45 on-board gigabit Ethernet 
• On-board CP5611 

Opt. drive DVD-ROM  
Special features  Without fan 

 
 

 Note 
Please note the following: 
• In the case of multiproject engineering, it is beneficial for the engineering stations if you 

use PCs with high clock-pulse rates, large main memories and hard disks, and high-
speed disk drives. 

• If the central archive server is used in conjunction with large amounts of data, we 
recommend that you use the premium server found in the PCS 7 Add On Catalog. 
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Minimum basic hardware configuration 
We recommend the following minimum configuration for smaller projects: 

 
Parameters Central engineering 

station with server 
operating system,  
central archive server,  
PCS 7 OS/SIMATIC 
BATCH/SIMATIC Route 
Control on a PC 

Engineering station,  
OS server,  
OS single station, 
maintenance station,  
PCS 7 Web server,  
OS client and BATCH 
client on a PC,  
BATCH server,  
BATCH single station, 
Route Control server, 
Route Control single 
station 

OS client,  
BATCH client,  
Route Control client 

SIMATIC PCS 7 
BOX 416  
(basic PC must 
be a BOX PC 627 
or better) 

Processor Intel Pentium IV Intel Pentium IV Intel Pentium IV Pentium Mobile 
Clock-pulse rate >= 2.0 GHz >= 2.0 GHz >= 2.0 GHz >= 2.0 GHz 
Hard disk 
Minimum partition size 

>= 120 GB 
 

C:\ 20 GB 

>= 120 GB 
 

C:\ 20 GB 

>= 80 GB 
 

C:\ 20 GB 

80 GB 
 

C:\ 20 GB 
Work memory (RAM) 2 GB 1 GB 512 MB 1 GB 
Network 
adapters/Communicati
ons interfaces  
• For terminal bus 

communication 
• For plant bus 

communication 

 
 
 
• RJ45 connector (fast 

Ethernet) 
• CP1613 or BCE 

network adapter for 
engineering station 
and OS server 

 
 
 
• RJ45 connector (fast 

Ethernet) 
• CP1613 or BCE 

network adapter for 
engineering station 
and OS server 

 
 
 
• RJ45 connector 

(fast Ethernet) 

2 x RJ45 
connectors (fast 
Ethernet) 
available on BOX 
PC 627 

Opt. drive DVD-ROM DVD-ROM DVD-ROM DVD-ROM 

 

Latest information in the PCS 7 readme file 
Always read the latest information in the pcs7-readme file on the PCS 7 Toolset DVD for 
every new PCS 7 version or service pack. 

More information  
● Catalog ST PCS 7  
● Catalog ST PCS 7.1 (Add Ons for SIMATIC PCS 7) 
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3.3 Components for connection to the terminal bus/plant bus 

Attachment of OS, BATCH, Route Control, and ES 
You can connect the following PC stations to Industrial Ethernet via communication modules: 
● Operator stations 
● BATCH stations 
● Route control stations 
● Engineering stations 
The communication modules require a slot in the PC or programming device (PG). A variety 
of communication modules can be used depending on the requirements: 
● For connection to the terminal bus: 

– Standard communication modules (for example, desktop adapter Intel Pro/1000GT) 
– Redundant connection of the PC station to the terminal bus: 

Two network adapters working in a PC in team mode 
- Intel Pro/1000MT server adapter 
- Intel Pro/1000GT desktop adapter 

● We recommend the following network adapter for attachment to the plant bus and 
communication connections with a maximum of 8 communication partners (automation 
systems or servers): 
– Intel Pro/1000GT desktop adapter 

● Communications processors with on-board processors are used if the maximum number 
of 8 automation systems per operator station is not sufficient or if fault-tolerant 
automation systems are connected to the plant bus: 
– CP 1613 with S7-1613 software 
– CP 1613 with S7 REDCONNECT software for redundant communication with S7-

400H/FH 
 

  Note 
Communication can be established with up to 64 automation systems (including 
redundant systems) using a CP 1613. 

Firewall on the plant bus 
If you use a firewall on the plant bus, you will need one of the following types of the 
CP 443-1 communications processor for the SIMATIC stations: 
● CP 443-1 EX 10 with firewall version V2.5.5 or later 
● CP 443-1 EX 11 with firewall version V2.5.5 or later 
● CP 443-1 EX 20 
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Driver 
The driver software for the communication modules described above is available on the 
PCS 7 Toolset DVD. You will find more information on this topic in the section "Additional 
devices and drivers for PCS 7 (Page 107)". 

Time-of-day synchronization 
CP 1613 supports time-of-day synchronization on Industrial Ethernet (Fast Ethernet). A PC 
with a CP 1613 can receive time frames from the following time transmitters: 
● SIMATIC S7-400/H/FH with CP 443-1 
● SIMATIC NET time transmitters for Industrial Ethernet  

(for more information see catalog IK PI) 
● SIMATIC SICLOCK 
● PC with CP 1613 
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3.4 Optional hardware components 

Overview 
 

Components Application 
Chip card reader This is used to access the PC stations via chip cards. Every authorized user 

must have a chip card. 
Chip card readers can be used for serial and USB interfaces.  
Note: If you use SIMATIC Logon, the chip card reader must support chip cards 
with the TCOS 2.0 operating system.  
You will find the necessary drivers for the OMNIKEY CardMan 3121 USB chip 
card reader on the PCS 7 Toolset DVD in folder: 
\Additional_Products\Drivers\CHIPCARD\CardMan 3121 USB 

Printer Use a graphics-enabled printer or a line printer for message sequence reports. 
Printers must be supported by the operating system. 

Signal module You can use the signal module to control three visual or acoustic signal 
transmitters. Variables are assigned to these three signal transmitters in the 
"audible signal device" WinCC editor. If a variable has the status "1", the 
corresponding signal transmitter of the signal module will be activated. 
The signal transmitter is acknowledged/reset by means of software control or 
via an external acknowledgment on the signal module. 
A group signal is also available to you on the signal module. The group signal is 
triggered when one of the three signal transmitters is present and can control an 
acoustic or visual signal transmitter. 
Connecting a signal module also facilitates sign-of-life monitoring thanks to the 
watchdog function. 

Sound card You can use a standard sound card to expand OS single station systems and 
OS clients. Files (e.g., *.wav) are played back through suitable devices 
(loudspeakers, piezo transmitters) via the signal module. 

Radio clock This is used to synchronize the PCs and plant bus. 
Intrinsically safe 
operating unit 

If required, use an intrinsically safe PC operating unit (add-on product) in 
hazardous areas, zone 1 or 2 - distances of up to 750 m are possible. 

Multi-VGA cards Install a multi-VGA graphics card in a PC used as: 
• An engineering station or 
• A client for an operator station or SIMATIC Route Control 
This allows you to connect up to four monitors to a PC (for clients and 
engineering stations). 

EPROM 
programming 
device 
USB prommer 

This allows you to program SIMATIC memory cards and EPROM modules. 

Redundant 
network adapters 

These allow you to connect PC stations to the redundant terminal bus. 

More information  
● Catalog ST PCS 7  
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3.5 Configuring and ordering 

Configurator software 
On the Interactive Catalog CA01; Automation and Drives CD, you will find configuration 
software that you will find useful when creating your PC networks. 

Ordering information 
In the Process Control System PCS 7; ST PCS 7 catalog, you will find the ordering 
information for tested PC configurations and software components. The catalog offers 
complete installed solutions providing the optimum components for your system whatever 
your application. 

Custom solutions  
If you require customized solutions for PC systems (for example for RAID systems), please 
contact your local Siemens representative. 
You will find your local Siemens representative at: 
http://www.siemens.com/automation/partner 

http://www.siemens.com/automation/partner
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Installing PC stations 4
4.1 Overview of the installation procedure 

Introduction 
Below you will find a practical outline of the basic procedure for installing PC stations for 
PCS 7. 
Siemens AG offers training courses on PC and network administration. Please contact your 
regional training center or the central training center for more information. 

Overview of the individual steps for installation 
This overview shows the recommended sequence of installation tasks. 

 
Step What? 
Installation of the operating system 
1 Installing the operating system (Page 65) 
2 Installing operating system service packs (Page 68) 
3 Setting the location where the swap file is to be stored (Page 69) 
4 Making system settings (Page 70) 
5 • Installing the Message Queuing service for Windows XP Professional (Page 72) 

• Installing the Message Queuing service for Windows Server 2003 (Page 73) 
6 Installing the Microsoft SQL Server (Page 75) 
7 Installing additional components (Page 74) 
8 Configuring the server function for the central archive server (Page 77) 
9 Installing additional services for SIMATIC BATCH (Page 78) 
10 Setting the color scheme and font size (Page 79) 
11 Creating a backup (Page 80) 
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Step What? 
Installation of PCS 7 
12 Installing the PCS 7 software (Page 85) 
13 Installing the central archive server (StoragePlus) (Page 89) 
14 Configuring the redundancy for redundant servers (Page 91) 
15 Installing a PC for PCS 7 OS Web Option (Page 91) 
16 Activating the firewall in the PC stations (Page 95) 
17 Installing additional communication modules and PCS 7-specific settings (Page 98) 
18 Installing interfaces for the plant/terminal bus (Page 99) 
19 Licensing and authorizing the PCS 7 software (Page 112) 
20 Preparing the PC stations (overview) (Page 131) 
21 Creating a backup (Page 80) 

PCS 7 security settings in the network 
SIMATIC Security Control (SSC) is called up automatically in the PCS 7 setup. 
SIMATIC Security Control makes all necessary security settings for the PC station so you 
don't have to. 
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4.2 Hard disk partitioning 

Partitioning the hard disks 
To make data backup easier, you should divide your PC station hard disks into partitions as 
follows: 
● For the operating system and the PCS 7 installation: approx. 20 GB 
● For PCS 7 project structures: More than 15 GB, possible several partitions 
● For backups: Back up to a data storage medium which will not be affected should the PC 

or hard disk containing the original data fail, e.g, CD, MOD, or even the network. 

Example 
Example of a hard disk with 120 GB: 

 
Drive 
letter 

Size in 
GB 

Drive name Formatting Intended use 

C: 20 SYSTEM NTFS Operating system installation and PCS 7 
installation 

D: 60 DATA NTFS PCS 7 project data 
... ... BACKUP NTFS Backup files 
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4.3 Installing the operating system 

4.3.1 Notes on installing the operating system 

Introduction 
Only appropriately qualified personnel may install the operating system, particularly the 
servers, and configure networks. 

Integration in networks 
You can integrate PC stations for PCS 7 in a network. Note the following: 

 

 Note 
Install the PC stations locally or in a workgroup. Using this procedure prevents group 
guidelines or domain restrictions from hindering the installation. 
Do not use the following PC stations in PCS 7 for domain management (DHCP or DNS 
server, for example): 
• OS server 
• BATCH server 
• Route Control server 
If a server (OS server, BATCH server, Route Control server) is also used as a server for 
these services, then the PCS 7 functions may be impaired due to overloading of the PC's 
resources. 

 
NOTICE  
Only install PCS 7 software products listed in this manual on a PC station. This especially 
applies to PC stations for process mode (OS, SIMATIC BATCH, SIMATIC Route Control). 
Installing and simultaneously activating applications that are not approved by Siemens can 
adversely impact the PCS 7 system performance. 
The user bears sole responsibility when third-party products are used. 
If you nevertheless require third-party products, these should be installed before you install 
PCS 7. PCS 7 and these third-party products should not run at the same time. 
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Reinstalling and updating 
Note the following general information in regard to updating software. 

 

NOTICE  
Notice: 
• If the operating system for PCS 7 is not yet installed on the PC station, reinstall the PC. 

This requires the operating system to be changed. 
• Check the suitability of your hardware before performing a new installation. You can find 

additional information in the file pcs7-readme. 
• Back up your authorizations. 
• Save your unchanged project and associated data prior to reinstallation (in an image, for 

example). You can find additional information about this in the manual SIMATIC; 
Process Control System PCS 7; Service Support and Diagnostics. 

• Make the preparations for updating the software. You can find additional information 
about this in the manual Process Control System PCS 7; Software Update. 

• Back up the data required for the software update. 
• Format the hard disks and create new partitions. 

 

Operating systems 
There are different procedures that depend on the various 32-bit operating systems: 
● Procedure for installation with Windows XP Professional 
● Procedure for installation with Windows Server 2003 
Possible operating systems and their use in PCS 7: You can find additional information 
about this in appendix "Software Packages and Necessary License Key (Page 166)". 

 

 Note 
You can operate domain controllers with the following operating systems: 
• Windows Server 2003 
• Windows 2000 Server 
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Languages for the operating system 
The menus for configuration and for the process management can be displayed in the 
following languages: 
● Chinese 
● German 
● English 
● French 
● Italian 
● Spanish 
The bundle PCs from PCS 7 are provided with a multilingual operating system. 
If you install a PC yourself, we recommend the following when selecting the operating 
system language: 
● If the PC users only use one language, select the operating system language used for 

configuration/process management. 
● If the PC users use several languages, select a multilanguage operating system (with 

English as the default) and also install the additional Multilingual User Interface Packs. 

Name of the PC station 
Do not use underscores. Otherwise, problems may arise when accessing data using the 
StoragePlus WebViewer. You will find the name of the PC in the Windows Control Panel 
under "System", on the "Computer Name" tab. 
When configuring an OS or BATCH server and an engineering station, please note that it is 
essential that the PC station name must be the same as that of the server PC (computer 
name).  
Exception: When setting up a maintenance station (see Process Control System PCS 7; 
Operator Station Configuration Manual). 
You will find more information on this topic in WinCC information system > Working with 
projects > Appendix > Invalid characters. 
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4.3.2 PC configuration security settings 

Introduction 
Current production methods increasingly require process control systems and the IT 
environment to come together. The need to connect company networks to public ones brings 
with it increased hazard potential. Information system and network security has therefore 
become an important factor in operating process control systems. Accurate knowledge of the 
sources of risks and the implementation of measures to prevent these risks from occurring is 
of utmost importance. 
Comprehensive knowledge of administrating Microsoft Windows networks is required if you 
want to integrate PCS 7 PC stations into a PC network.  

Recommendations and instructions 
The manual Process Control System PCS 7; Security Concept PCS 7; Recommendations 
and Notes helps Administrators to plan and configure PC networks: 
● It will give you an overview of network, computer and user management, as well as the 

management of user and access rights in PCS 7. 
● It will provide you with important information about integrating PCS 7 networks into the 

Windows management system. 
● You will learn what the options are for time-of-day synchronization in a PCS 7 plant. 
● You will find information about how to establish patch management and secure 

communication paths between the PC stations in a PCS 7 plant. 
 

  Note 
This manual builds on the options available in Windows XP Professional and Windows 
Server 2003 and requires knowledge of how these operating systems are used and 
managed. 

Network 
You must isolate the network for a PCS 7 plant via switches, routers, or gateways to ensure 
that no faults reach the PCS 7 plant, via office networks, for example. 

Security settings on a PC 
When you install PCS 7, you can either activate the required security settings on the PC 
when the installation is taking place or at a later time. 

 

NOTICE  
When the PCS 7 plant is operated in a domain, the security settings must be coordinated 
over the entire domain. Coordinate the security settings with the appropriate Administrator. 
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Virus scanners and updates 
Virus scanners and updates approved for PCS 7 can be installed later. 

 

NOTICE  
Please note that some updates will require you to restart your PC and cannot, therefore, be 
installed in process mode. 

 

More information 
● You will find more information about security settings in: 

– Section "How to retro-activate the security settings for PCS 7 (Page 145)" 
– Section "Installing security patches, hotfixes, and service packs (Page 144)" 

● You will find more information about virus scanners and updates in: 
– Section "Virus scanners (Page 153)" 
– Section "Installing security patches, hotfixes, service packs (Page 144)" 

● Manual Process Control System PCS 7; Security Concept PCS 7; Recommendations and 
Notes 

● File pcs7-readme 
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4.3.3 How to install Windows XP and Windows Server 2003 

Requirement 
All the necessary modules and devices have been installed in your PC. 

Procedure  
 

 Note 
For a multi-language installation, the names of dialog boxes appear in square brackets  
"[ ... ]". 

 
1. Insert the installation CD for the operating system in the CD drive. 
2. Follow the Setup instructions for installing the operating system. 
3. Make the settings for your specific system in the "Regional and Language Options" dialog 

box. 
4. Make the settings for your specific system in the "Personalize Your Software" dialog box. 
5. Enter you product key in the "Product Key" dialog box. You can find it on the CD 

envelope. 
6. The "Licensing Modes" dialog box only appears in the setups for Windows Server 2003 

and Windows Advanced Server 2003 (not in Windows XP). 
The default setting for the licensing mode is: "per server". 
Select the "per device or per user" radio button for the licensing mode if more than one 
server or more than five clients are present in one area.  
In this context, "area" means a subnet, a workgroup or a domain.  

 

  Note 
One standard Windows 2003 Server software package contains licenses for five seats. 
Make sure that you have the correct number of licenses. 

7. Make the settings for your specific system in the "Computer Name and Administrator 
Password" dialog box. 

 

  Note 
Recommendation: Select short and descriptive computer names that provide some 
information about the role of the PC station in the overall system. 
Use only letters and number for the computer names. 

8. Make the settings for your specific system in the "Date and Time Settings" dialog box. 
9. You can make the settings in the "Network Settings" dialog box now or later. 
10. Make the settings for your specific system in the "Workgroup or Computer Domain" dialog 

box. You can also configure this later. 
The installation is complete. 
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Installation of specific language components for a multilingual installation 
1. Start the setup on the Multilingual User Interface Pack CD. 
2. Follow the Setup instructions for the installation. 
3. In the "Windows Multilingual User Interface Pack" dialog box, select the languages to be 

made available in the menus and dialogs (multiple languages can be selected). Select 
the default language. Select the "Match Language for non-Unicode ..." and "Match the 
default shell ..." check boxes. 

4. Follow the Setup instructions for the installation. 
5. Reboot the PC. 
After installation of the Windows multilingual user interface pack 
The selected language is English. 
1. Select the menu command Start > Settings > Control Panel > Regional Language 

Options. 
The "Regional and Language Options" dialog box opens. 

2. Open the "Regional Options" tab and make the settings for your specific system. 
3. Open the "Languages" tab and make the settings for your specific system. 
4. Open the "Advanced" tab and make the settings for your specific system. 
5. Reboot the PC. 
Adding more system components 
1. Select the menu command Start > Settings > Control Panel > Add or Remove Programs 

The "Add or Remove Programs" dialog box opens. 
2. Click the "Add/Remove Windows Components" button. 

The "Window Components Wizard" opens. 
3. In the list, check the boxes for components as specified in the "Selecting options in the 

'Window Components Wizard'" table found below. 
4. Click "Next". 
5. Click "Finish".  

This completes the installation. 
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Selecting options in the 'Windows Components Wizard' 
 

Where? What? 
Accessories and Utilities 1. Click "Details". 

2. Clear the check box for "Games" when installing Windows XP. 
3. Click "OK". 

IIS - Internet Information 
Service 

1. Activate the service only for: 
– OS Web server 
– Central archive server 
– PC stations where BATCH archives are stored 

2. Activate the "Application server" check box. 
3. Click "Details". 
4. Deactivate the service for all other installations. 

Message Queuing 
services 

1. Activate the service. 

More information 
● Section "How to install the Message Queuing Service for Windows XP Professional 

(Page 72)" 
● Section "How to install the Message Queuing Service for Windows Server 2003 

(Page 73)" 
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4.3.4 How to install service packs for the operating system 

Introduction 
If you installed the operating system without a service pack, you must install the service pack 
later. 

Versions 
 

 Note 
Refer to the pcs7 readme file to find out which version is required. 

 

Requirements 
● The operating system has been installed. 
● The PC station is operated locally or in a workgroup (but is still not included in a domain). 

Procedure 
1. Insert the installation CD in the CD drive. 
2. Double-click the appropriate "<operating system>.exe" file to start the installation routine. 
3. Select the "I agree with the license agreement" check box and click "Install". 
4. When the installation has been successfully completed, reboot the computer and remove 

the installation CD. 

Additional information 
● Section "Installing Security Patches, Hotfixes, Service Packs (Page 144)" 
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4.3.5 How to configure paged memory 

Introduction 
The operating system requires additional disk space for the paging file (virtual memory; this 
is created by default on the operating system partition). 

Rules for setting the size of the paging file 
The size of the paging file depends on the memory configuration of the PC. We recommend 
the following settings: 
● Specify about 1.5 to 2 times the RAM available in the PC for the paging file. 
● Enter the same value for the initial size and maximum size of the paging file. 

Requirement 
● The PC station is operated locally or in a workgroup (but is still not included in a domain). 

Procedure 
1. Select the "My Computer" object in the Windows Explorer. 
2. Select the menu command File > Properties. 
3. Open the "Advanced" tab. 
4. In the "Performance" group, click "Performance Options". 

The "Performance Options" dialog box opens. 
5. Open the "Advanced" tab. 
6. In the "Virtual Memory" group, click "Change". 
7. Use the option "User defined size" to enter the required values. 
8. Click "OK" to save the settings. 
9. Click "OK" twice to close the opened dialog boxes for this procedure. 
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4.3.6 How to make additional system settings 

Requirement 
The PC station is operated locally or in a workgroup (but it has not yet joined a domain). 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Administrative Tools > 

Computer Management > Local Users and Groups to set up the users. 
You will find more information on this topic in the section "Setting up user Groups and 
users (Page 92)". 

2. Select the menu command Start > Settings > Control Panel > Display.  
The dialog box for setting the display properties opens. 
– Open the "Settings" tab and select the screen resolution (recommended for PCS 7: 

1280x1024).  
A higher resolution allows you to better utilize the display features of the PCS 7 
software, e.g., for the online operation of faceplates from the libraries. Please ensure 
that you have installed appropriate drivers and are using suitable monitors. 

– Open the "Screen Saver" tab. 
– In the "Screen saver" area, select "[None]" from the drop-down list box. 
– In the "Monitor power" area, click the "Power..." button. 
– In the "Settings for Home/Office Desk power scheme" area, select "Never" in all the 

drop-down list boxes. 
– Click "OK" to close the dialog box. 

3. Select the data throughput for network applications for a Windows server. 
– Windows Server 2003: Select the menu command Start > Settings > Network 

Connections. 
– Select the network connection for the terminal bus.  

Recommendation: Name the network connections in accordance with use, 
e.g., terminal bus or plant bus. 

– Select the menu command File > Status. 
– Select the "General" tab. 
– Click "Properties". 
– Select "File and Printer Sharing for Microsoft Networks". 
– Click "Properties". 
– Select "Maximize data throughput for network applications". 
– Click "OK" to close the dialog box. 
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4. Disable the energy saving option for network adapters.  
You will find more information on this topic in the section "How to disable the energy 
saving options for network adapters (Page 103)". 

5. Select the menu command Start > Settings > Control Panel > Administrative Tools > 
Computer Management > System Tools > Event Viewer to check that all services and 
drivers are functioning correctly. 

6. OS server: In the Control Panel, select the "Background services" radio button. 
– Select the menu command Start > Settings > Control Panel > System.  

The "System Properties" dialog box opens. 
– Select the "Advanced" tab. 
– In the "Performance" area, click the "Settings" button. 
– Select the "Advanced" tab. 
– For Windows Server 2003: In the "Processor scheduling" area, select the "Background 

services" radio button. 
– Click "OK" to close the dialog box. 
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4.3.7 How to install the Message Queuing Service for Windows XP Professional 

Introduction 
Install the Message Queuing service on the PC station prior to installing PCS 7. 

Requirements 
● The Windows XP Professional operating system must be installed, along with a service 

pack and Internet Explorer. 
● The PC station is operated locally or in a workgroup (but it has not yet joined a domain). 
● You are logged in to Windows XP Professional as an Administrator. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Add or Remove Programs. 
2. Click the "Add/Remove Windows Components" button. 
3. Select the "Message Queuing" component.  

The "Details" button is active. 
4. Click "Details".  

The "Message Queuing" dialog box opens. 
5. Select the "General" subcomponent.  

Disable all other subcomponents and click "OK". 
6. Click "Next". 
7. If you have stored the software for the Message Queuing service on the PC with the 

operating system, the installation will start immediately. If the software for the Message 
Queuing service is not yet available, the "Data Medium" dialog box opens: 
– Insert the required Windows installation CD into the CD drive. 
– Click "OK". 
MS Message Queuing is installed. 

8. Click "Finish" to close the Wizard. 
9. Use the Event Viewer to check that the Message Queuing services have been activated 

correctly: 
– Select the menu command Start > Settings > Control Panel > Administrative Tools > 

Event Viewer. 
– In the tree view, select "Event Viewer > Application". 
The Message Queuing service has been installed correctly if the "Source" column 
contains the entry "MSMQ". 

Incorrect function 
If an error message appears under "Description" in the "Event Properties" dialog box, the 
installation has not been executed correctly. Uninstall and then reinstall "Message Queuing 
Services". 
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4.3.8 How to install the Message Queuing Service for Windows Server 2003 

Introduction 
Install the Message Queuing service on the PC station prior to installing PCS 7. 

Requirements 
● The Windows Server 2003 operating system must be installed, along with a service pack 

and Internet Explorer. 
● The PC station is operated locally or in a workgroup (but it has not yet joined a domain). 
● You are logged in to Windows Server 2003 as an Administrator. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Add or Remove Programs. 
2. Click the "Add/Remove Windows Components" button. 
3. Select the "Application Server" line (do not check the box) and click the "Details" button.  

The "Application Server" dialog box opens. 
4. Select the "Message Queuing" line (do not check the box) and click the "Details" button.  

The "Message Queuing" dialog box opens. 
5. Check the "Shared Components" box. Uncheck all other boxes and click "OK". 
6. If the software for the Message Queuing service is stored on the PC with the operating 

system, the installation will start immediately. If the software for the Message Queuing 
service is not yet available, the "Data Medium" dialog box opens: 
– Insert the required Windows installation CD into the CD drive. 
– Click "OK". 
MS Message Queuing is installed. 

7. Click "Finish" to close the Wizard. 
8. Use the Event Viewer to check that the Message Queuing services have been activated 

correctly: 
– Select the menu command Start > Settings > Control Panel > Administrative Tools > 

Event Viewer. 
– In the tree view, select "Event Viewer > Application". 
The Message Queuing service has been installed correctly if the "Source" column 
contains the entry "MSMQ". 

Incorrect function 
If an error message appears under "Description" in the "Event Properties" dialog box, the 
installation has not been executed correctly. Uninstall and then reinstall "Message Queuing 
Services". 
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4.3.9 How to install additional components 
You need to install additional Microsoft components for some PC configurations. You will find 
these components on the PCS 7 Toolset DVD in the "Microsoft" folder or on the 
"MS_ServicePacks_u_Tools" DVD. 

 

 Note 
If you install an additional Microsoft component for a PC configuration, you will find the latest 
information about it in the pcs7-readme file. 

 

Languages 
Install the additional Microsoft components in the language of the operating system. 
Example of how to store a hotfix in a language-specific directory: 

 
Language Language code Directory on the "MS_ServicePacks_u_Tools" DVD 
German german Tools\MS_XPSP2_KB319740\german\WindowsXP-KB319740-v5-x86-DEU.exe 
English english Tools\MS_XPSP2_KB319740\english\WindowsXP-KB319740-v5-x86-ENU.exe 
French french Tools\MS_XPSP2_KB319740\french\WindowsXP-KB319740-v5-x86-FRA.exe 
Italian italian Tools\MS_XPSP2_KB319740\italian\WindowsXP-KB319740-v5-x86-ITA.exe 
Spanish spanish Tools\MS_XPSP2_KB319740\spanish\WindowsXP-KB319740-v5-x86-ESN.exe 

Example of how to identify a component's language in its file name: 
 
Language Language code Example 
German xxx_de.xxx dotnetfx_de.exe 
English xxx_en.xxx dotnetfx_en.exe 
French xxx_fr.xxx dotnetfx_fr.exe 

Procedure 
1. Insert the DVD in the DVD drive. 
2. Select the relevant folder on the DVD. 
3. Install the components named in the pcs7-readme file. 
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4.3.10 How to Install Microsoft SQL Server 

Introduction 
The Microsoft SQL Server is required in PCS 7 for the following PC stations: 
● Operator stations 
● Engineering station 
With the "PCS 7 Toolset" software package you receive a CD containing Microsoft SQL 
Server software, adapted for PCS 7. 

Installation and setting 
 

 Note 
The Microsoft SQL Server settings required for PCS 7 are integrated in the PCS 7-specific 
SQL Server setup. No other settings are necessary. The SQL instance installed for the 
operator station for PCS 7 is "WinCC". 

 

Requirements 
● The operating system has been installed. 
● The installation CD for the PCS 7-specific SQL Server is available. As of PCS 7 V7.0, you 

will require SQL Server 2005. 
You can find version information, along with information about additional hotfixes or 
patches for the "MS SQL Server", on the PCS 7 Toolset DVD, in file pcs7-readme. 

Procedure 
1. Insert the MS SQL Server installation CD in the DVD drive.  

If the initial dialog box does not appear, go to the CD drive in Windows Explorer and run 
file "setup.exe" from there. 
The "Welcome ..." dialog box opens. 

2. Click "Next". 
The License dialog box opens. 

3. Select the "I accept the condition of this license agreement" radio button. 
4. Click "Next". 

The "Program packages ..." dialog box opens. 
5. Select "SQL Server 2005 (WinCC)" from the list. 
6. Click "Next". 

The "Programs ..." dialog box opens. 
7. Click "Next". 

The installation starts. 
The "Add password for the sa login" dialog box opens. 

8. Click "Continue". 
The "Start Copying Files ..." dialog box opens. 
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9. Click "Install". 
The files for the SQL Server are installed. 
The "Setup Complete ..." dialog box opens. 

10. Click "Finish". 
The "Setup SQL Server 2005 (WinCC) ..." dialog box opens. 

11. Following the installation, click "Finish" on the final screen. 

"SQLServer2005MSSQLUser$<Computername>$WINCC" user group 
Once the SQL Server software has been installed on the PC, the 
"SQLServer2005MSSQLUser$<Computername>$WINCC" user group is created in the 
operating system.  
The "Computername" is the name of the PC station (menu command Start > Settings > 
Control Panel > System > "Computer Name" tab). 
Example user group name: SQLServer2005MSSQLUser$OSServer1$WINCC 

 

 Note 
The necessary users must be entered following a successful version update/installation. 

 
You will find more information on this topic in the section "Setting up user groups and users 
(Page 92)". 

Installing an SQL Server hotfix 
1. Insert the PCS 7 Toolset DVD in the DVD drive. 
2. In Windows Explorer, select the DVD drive and folder 

Additional_Products/HF_für_SQL2005 in the tree structure. 
3. Select file "sqlncli.msi". In the shortcut menu, select the menu command "Install". 

The "Microsoft SQL Server Native Client Setup" dialog box opens. 
4. Click "Next". 

The License dialog box opens. 
5. Select the "I accept the condition of this license agreement" radio button. 
6. Click "Next". 

The "Registration Information" dialog box opens. 
7. Click "Next". 

The "Feature Selection" dialog box opens. 
8. Click "Next". 

The "Ready to Install the Program" dialog box opens. 
9. Click "Install". 

The hotfix is installed. 
10. Click "Finish". 

 

More information 
See the "MS SQL Server" installation CD, file SQL-readme.wri. 
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4.3.11 How to configure the server role for the central archive server 

Introduction 
If you use the StoragePlus software package on an OS server, perform the following steps 
on this OS server. 

Requirement 
● The Windows Server 2003 operating system is installed. 

Procedure 
For Windows Server 2003, you will need to configure IIS, ASP.net: 
1. In the Start menu, select Settings > Server Configuration Wizard.  

The "Server Configuration Wizard" opens. 
2. Click "Next". 
3. No settings are needed on the following page. 
4. Click "Next". 
5. On the following page, select the entry "Application Server (IIS, ASP.NET)" for the 

"Server Role". 
6. Click "Next". 
7. On the following page, place a check mark next to the entry "Enable ASP.NET". 
8. Click "Next". 
9. Follow the instructions on the screen. 
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4.3.12 Installing additional services for SIMATIC BATCH 

Introduction 
If you want to transfer SIMATIC BATCH archives using FTP, then additional installations are 
required on the PC stations. 

Which additional services need to be installed? 
 

PC station Service or software that needs 
to be installed 

PC station to which the BATCH archives are transferred IIS service 
FTP service 

PC station from which the transfer of BATCH archives will be 
activated 

FTP service 

PC station from which the transferred BATCH archives will be 
accessed 

BATCH Control Center 
(BatchCC) 

Additional information 
● You will find additional information on configuring services in the manual Process Control 

System PCS 7; SIMATIC BATCH. 
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4.3.13 How to set color schemes and font sizes 

Introduction 
The settings for the color scheme and font size can sometimes change automatically when 
other programs are installed. Correct the settings if necessary. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Display.  

The "Display Properties" dialog box opens. 
Color scheme 
1. Select the "Appearance" tab. 
2. Make the following settings: 

– Select "Windows Classic" in the "Windows and Buttons" drop-down list. 
– Select "Windows Classic" in the "Color Scheme" drop-down list. 
– Click "Apply". 
– Click "Advanced". 

The "Advanced Appearance" dialog box opens. 
– Select "Active Title Bar" in the "Item" drop-down list box. 
– Select the dark blue menu area in the "Color 1" list. 
– Select the dark blue menu area in the "Color 2" list. 
– Click "OK". 

Font size 
1. Select "Normal" in the "Font Size" drop-down list. 
Options 
1. Click "Effects". 

The "Effects" dialog box opens. 
2. Disable the "Show window contents while dragging" check box. 
3. Double-click "OK". 
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4.3.14 Creating a backup 

Recommendation 
After restarting and testing the installation, create a backup of the partitions on which the 
operating system/PCS 7 software is installed. 
We recommend creating an image of the installation for backing up partitions and hard drive 
data. An image allows you to restore partition and hard drive data at any time or to prepare 
the PC for a software reinstallation. 

 

 Note 
Please note that neither license keys nor authorizations can be backed up along with the 
data. 
• Move authorizations and license keys to a different medium (license key diskette, 

partition, etc.) before creating the image. 
• In selecting image software, ensure that it is suitable for the operating system in use. 
• To create an image, follow the image software manufacturer's instructions. 

 
 



 Installing PC stations 
 4.4 Installing the PCS 7 software 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 81 

4.4 Installing the PCS 7 software 

4.4.1 Notes on installing PCS 7 

Introduction 
The PCS 7 software contains applications that allow you to configure systems and operate 
and monitor them in runtime. In addition to the applications of the basic software, there are 
numerous optional packages and upgrade packages that you can install later and use for 
special applications. 
Refer to the latest ST PCS 7 catalog to learn about all of the software packages released for 
PCS 7 and how they can be used. You can find a detailed introduction in the configuration 
manual Process Control System PCS 7; Engineering System.  
The following describes the installation for the basic PCS 7 software. 

Versions of the software package 
You can find information on the software packages and versions associated with the current 
PCS 7 Toolset DVD in the pcs7-readme file on the PCS 7 Toolset DVD. 

Latest information about the installation 
 

 Note 
When installing PCS 7 in a network, make sure that at least one DVD drive and one diskette 
drive are available. 

 
 Note 

Read the latest information about installation and the software and hardware requirements in 
the pcs7-readme file on the PCS 7 Toolset DVD. 

 
 Note 

If you install PCS 7 in a domain, be aware of the group policies or other restrictions that can 
hinder the installation. Consult the appropriate Administrator as regards these settings and 
the required approvals and authorizations. 

 
 Note 

If you want to use the Windows firewall, you must wait to activate it until after PCS 7 is 
installed. 
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Rules 
 

NOTICE  
Only the software products listed in this manual should be installed on a PCS 7 PC. This 
applies in particular to PC stations used for process mode (OS, BATCH, Route Control). 
Installing and simultaneously activating applications that are not approved by Siemens can 
adversely impact the PCS 7 system performance. 
The user bears sole responsibility when third-party products are used. 
If you nevertheless require third-party products, these should be installed before you install 
PCS 7. PCS 7 and these third-party products should not run at the same time. 

 

Several PCS 7 applications on a single PC station 
A PC station can be used to run a single PCS 7 application (such as OS server). It can also 
be used to run several PCS 7 applications (such as OS server and BATCH client). You can 
find additional information on this in the section "Approved Configurations (Page 204)". 

Installation of the archive server 
 

 Note 
When installing the central archive server and StoragePlus, set the same language for the 
logged on user and the default user. 
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SIMATIC Security Control 
The setting are made in the registry, in DCOM and in the exception list for the Windows 
firewall are required for trouble-free operation of the PCS 7 software. When the setup is 
completed, the "SIMATIC Security Control" dialog appears, allowing you to make these 
settings. You have the following options: 
● If you want to apply the settings immediately, click "Apply". 
● If you want to make the settings at a later point in time, select the menu command Start > 

SIMATIC > SIMATIC Security Control > All Settings. 
● If you start "SIMATIC Security Control" via the menu command Start > SIMATIC > 

SIMATIC Security Control > Settings Made, the settings already transferred to the 
operating system will be displayed. 

 

  Note 
The settings must be applied again if the work environment changes (domains, 
workgroups) using the menu command Start > SIMATIC > SIMATIC Security Control > 
All Settings. 
The settings in the exception list of the Windows firewall are applied to the area of the 
local network (subnet). If your PC stations are located in different networks (subnets), you 
need to change this area. 
The settings in the exception list of the Windows firewall are made when the Windows 
firewall is disabled. 

You can find additional information on this in the section "How to Retro-activate the Security 
Settings for PCS 7 (Page 145)". 
The security settings must activated again if the work environment changes (domains, 
workgroup). 

 

 Note 
Notice: 
• With the factory state of the bundle systems, the setting are made in the registry, in 

DCOM and in the exception list for the Windows firewall. 
• With the factory state of the bundle systems V7.0, the local Windows firewall is disabled. 
• The log of firewall events is disabled. 

 
NOTICE  
When the PCS 7 system is operated in a domain, the security settings must be coordinated 
over the entire domain. Coordinate the settings with the appropriate Administrator. 
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4.4.2 How to install in a network 

Preparation 
If you want to install several PCs, make the following preparation: 
Copy the content of the PCS 7 Toolset DVD to a hard disk that can be accessed by all the 
PCs. In this way, you can install several PCs at one time. 

Rules 
Observe the following rules when installing PCS 7 over a network 
● Make sure the PC is set up to automatically restore the link to the directory containing the 

PCS 7 software after a restart of the PC. 
● Set up a share for the directory (folder or drive) on which the PCS 7 software is available. 
● Set up the following access rights for the share: 

– Operating user: Read 
– System: Read 

Procedure 
1. Copy the files of the DVD to a folder. 

Then continue working on the PC on which you want to install PCS 7. 
2. Open Windows Explorer and go to the folder in the network where you copied the DVD. 
3. Start the Setup program.  

You will find more information on this topic in the section "How to install the PCS 7 
software (Page 85)". 
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4.4.3 How to install the PCS 7 software 

Introduction 
The PCS 7 Toolset DVD contains the complete software for the PCS 7 applications. 
Depending on the PCS 7 application in question, you only need to install certain applications 
from the PCS 7 Toolset DVD. In this phase you are supported by the PCS 7 system setup. 

Licensing 
You can transfer the license keys required for the software package either before or after the 
installation of PCS 7. 
You will find a description of the licensing concept in the section "Licensing and authorizing 
the PCS 7 software (Page 112)". 

Checking the installation requirements 
The PCS 7 system setup automatically checks whether the software components needed for 
the PCS 7 installation are already installed on the PC.  
Missing software components are indicated with a message. The setup program is 
terminated after the message is confirmed. You must install the missing software 
components. Then, restart the PCS 7 system setup. 

Requirements 
● The operating system is installed and all the steps described in the "Installation of the 

Operating System" section have been completed. 
● All communications processors have been installed in the PC. 
● You need administrator rights on the PC station. 

Starting the PCS 7 setup 
1. Insert the PCS 7 Toolset DVD in the DVD drive. 
2. Double-click on "Setup.exe" to start the setup. 

Setup starts. 
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Settings in the setup 
Below you will find information about the settings made in the setup dialog boxes, listed in 
the order in which they are processed: 
1. Setup language 

– For example, "English" and "Next" 
2. Welcome 

– ... "Next" 
3. Product information 

... read this if needed and "Next" 
4. License agreement 

– ... Mark the check box "I accept the conditions of the licensing agreement as well as 
the conditions of the Open Source Licensing Agreement" 

– ... "Next" 
5. Setup type 

– ... Select this with the check box "Install" or "Update" and "Next" 
6. User information 

– Enter the user information and "Next" 
7. Installation type 

– Select the check box "User-defined Installation" if you need to modify preconfigured 
software packages for the PCS 7 application. 

– Click "Browse" if you want to set a different destination folder 
– "Next" 

8. Program packages (see following figure) 
– ... Select the program package and "Next" 
– Select the software packages for the PCS 7 application in the subsequent dialog box. 

Check the corresponding boxes (approved combinations can be found in the section 
"Approved configurations (Page 204)").  
Result: The software packages installed for this PCS 7 application are listed in the 
window in the lower section of the dialog box. 

9. Programs 
– ... The necessary program packages are shown. You can add additional (software) 

packages of PCS 7. 
– ... "Next" 

10. Ready to install the selection 
– ... "Install" 

11. SIMATIC Security Control 
The top section of the "SIMATIC Security Control" dialog box shows the settings which 
the PCS 7 system setup can make automatically. 
Read the information in the bottom section of the "SIMATIC Security Control" dialog box 
and select the appropriate button. 
You will find more information on this topic in the section "How to retro-activate the 
security settings for PCS 7 (Page 145)". 
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12. When the installation is complete, close setup. 
13. Reboot the PC. 

 
 

PC station as a file server for storing projects for multiuser engineering 
 

 Note 
If a PC station is to be used as a file server for multiuser engineering, an engineering station 
must be installed in the Windows Server 2003 operating system.  
PCS 7 licenses are not required for this file server.  
You will find more rules about storing projects on network servers in the STEP 7 Help. 

 

Setting the network connection to the terminal bus 
If several network adapters are installed in the PC, network connections to the terminal bus 
must be set in order for the PC to be operated in the PCS 7 plant. 
You will find more information on this topic in the section "How to set communication 
modules". 
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Display of installed software 
You can check which software packages are installed on the PC.  
Select the menu command Start > SIMATIC > PCS7 > Installed Software.  
You will find the installed software packages in the "Products" tab. 

See also 
● How to configure communication modules (Page  137) 
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4.4.4 How to install the central archive server (StoragePlus) 

Introduction 
When installing a central archive server (StoragePlus server) with the PCS 7 Toolset DVD, 
perform the following steps in the setup during installation: 

Requirements 
● The SQL server and application server (IIS and ASP.net) are installed. 
● The computer name is assigned for the specific plant. 

Making settings in the "StoragePlus Installation Settings" dialog box 
1. Click the "Install" button in the "Ready to install the selection" setup dialog box.  

The "StoragePlus Installation Settings" dialog box opens. 
 

  Note 
You cannot change the settings in the "StoragePlus Installation Settings" dialog box once 
they have been made. 

2. Make the following settings: 
 

Where? What? 
Name of the 
database: 

Enter a unique database name. 

Path of the 
database: 

When updating PCS 7: Enter the path for the database file on the local hard disk 
of the server. 

Path of the data 
log: 

Enter the path of the data log. 

Shared archive 
directory: 

Enter the path and name of the shared archive directory. 
The shared archive is used as a common location for swapping out the archive 
segments and reports of the OS server to the central archive server (backup 
path). 

You can find additional information about this in the section "How to Install the PCS 7 
Software". 
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Note on installation 
Notice: 
● The names of the database files are derived from the individual database names as 

follows: 
– Configuration database - name of database file: "DBName.mdf" 
– Configuration database - name of database log file: "DBName.ldf" 
– Runtime database - name of database file: "DBName_D.mdf" 
– Runtime database - name of database log file: "DBName_D.ldf" 

● If you wish to use an existing database, note that you also have to use the name of the 
database and corresponding path where it is located. 

The following recommendations for distributing the archives on the partitions provide 
optimized performance and operating security: 
● Do not set the paths for the interim archive or the shared archive directory to the partition 

containing the Windows operating system. 
● Do not store any other data (the virtual memory file of the operating system, for example) 

on the following partitions: 
– The partition of the shared archive directory 
– The partition of the interim archive, if you have selected the "Fraction of hard disk 

capacity" option for automatic archiving.  
With this option, the time period which the total archive can encompass depends on 
the remaining free space in the partition. This determines how far back you can 
access the tag logging data. 

● Ensure that there is enough free space on the partition for the shared archive directory so 
that the OS server can continue to swap out archive segments even after process mode 
has ended on the central archive server. 

We recommend the following to increase the performance of the archive server when large 
amounts of data are involved: 
● Use an archive server with several hard disks. 
● Do not set the path of the database to the hard disk where the operating system of the 

PC station is installed (additional hardware required). 

Increased performance and data security 
Notice: 
● We recommend the use of RAID systems (RAID 0) to increase performance. 
● We recommend the use of RAID systems (RAID 1) to increase data security for the 

archive server. 

See also 
● How to install the PCS 7 software (Page  85) 
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4.4.5 Configuring redundancy for redundant servers 

Introduction 
You will need to configure the redundancy monitoring for redundant servers in PCS 7. 
● A local Ethernet network with an additional network adapter for the redundancy 

communication needs to be configured for the OS server and BATCH server. 
● SIMATIC Route Control uses the terminal bus for redundant communication. 

Additional information 
You will find information on configuring fault-tolerant components, redundancy and 
redundancy monitoring for redundant servers in the manual Process Control System PCS 7; 
Fault-tolerant Process Control Systems. 

4.4.6 Installing a PC for PCS 7 OS Web Option 

Installation of PCS 7 OS Web Server and PCS 7 Web Client 
All information and step-by-step instructions for installing PCS 7 OS Web server and PCS 7 
Web client can be found in the manual Process Control System PCS 7; PCS 7 OS Web 
Option. 

Additional information 
● Section "Software packages and required license key (Page 166)" 
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4.4.7 Setting up user groups and users 
Some user Groups and users are created automatically when PCS 7 software is installed.  
The follow table shows the user group a user must be a member of to be able to use 
installed software. 

Note to the reader for the "User Groups and users" table 
In the following you will find notes for the reader on the "User Groups and users" table 
shown below: 
● The "Installation" column defines the software that must be installed on the PC station in 

order for the user groups and users to be created. 
● The "Component" column defines the standard component in the PCS 7 setup which 

creates the user groups and users. 
● The "User group with users" column lists the user groups and users which are 

automatically created when a software package is installed. The user groups are marked 
"bold". 

● The "Member" column lists the users that must be assigned to a user group in a PCS 7 
system. 

● The "SQLServer2005MSSQLUser$<Computername>$WINCC" user group is created 
automatically for the installation of the SQL server. All members of the "HMI" user group 
must be added to this group in order to work with PCS 7. 

User groups and users 
 
Installation Component User group with users Members 
Operating 
system 

 Power User Add all users of a PCS 7 PC to this user group. 

SQL Server for 
PCS 7 

 User group of the SQL server 
(see reader note 
"SQLServer2005...") 

Add all members of the "HMI" user group to this 
user group. 

PCS 7 
Engineering 

HMI 
 

OS project engineer 
Project administrator 
Operator 
Operator groups 

BATCH 
Engineering 

SIMATIC BATCH BATCH project engineer 

Engineering 
station 

Route Control 
Engineering 

RC_ENGINEER 
RS_MAINTENANCE 
RC_OPERATOR_L1 
RC_OPERATOR_L2 
RC_OPERATOR_L2 

Route Control project engineer 
Route Control administrator (with all rights) 
Operator (for operator permissions, see the 
manual "Process Control System PCS 7; 
SIMATIC Route Control") 
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Installation Component User group with users Members 
OS server HMI  Project administrator 

Operator 
Operator groups 

BATCH server SIMATIC BATCH Operator 

Runtime server 

Route Control 
server 

RS_MAINTENANCE 
RC_OPERATOR_L1 
RC_OPERATOR_L2 
RC_OPERATOR_L2 

Operator 

OS single 
station 

HMI 
 

Project administrator 
Operator 
Operator groups 

BATCH single 
station 

SIMATIC BATCH Operator 

Runtime 
Single Station 

Route Control 
single station 

RS_MAINTENANCE 
RC_OPERATOR_L1 
RC_OPERATOR_L2 
RC_OPERATOR_L2 

Operator 

OS clients HMI 
 

Project administrator 
Operator 
Operator groups 

BATCH clients SIMATIC BATCH Operator 

Clients 

Route Control 
clients 

RS_MAINTENANCE 
RC_OPERATOR_L1 
RC_OPERATOR_L2 
RC_OPERATOR_L2 

Operator 

SIMATIC Logon LOGON_Administrator  

 

User management options 
Distinguish between the following: 
● User management in Windows, without SIMATIC Logon: 

– User management on a single PC 
– User management performed from a central location in Windows (PCs in a domain) 

● User management expanded to include SIMATIC Logon 
Many PCS 7 applications support central user management with the SIMATIC Logon 
software of PCS 7, which is based on the basic mechanism of Windows user 
management. SIMATIC Logon provides the following enhancements for user 
management: 
– User management expanded to include SIMATIC Logon can be performed from a 

central location in Windows (PCs in a domain) 
– User management expanded to include SIMATIC Logon on a single PC 
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Setting up Windows users for PCS 7 
The user who installs the PCS 7 components, is automatically entered as a user of these 
components in Windows management. 
If you want to authorize other users to use a PCS 7 component, they must be set up in 
Windows and assigned to the relevant PCS 7 components (user groups). 

Basic procedure 
● The following applies to all configuration options for users and user groups: 

You should define the users and user groups available on the respective Windows server 
and define the passwords from a central location in Windows. 

● The following applies to defining user roles with the SIMATIC Logon: 
You can assign users and user groups particular roles within some PCS 7 applications 
(for example, SIMATIC BATCH). 
Example: SIMATIC BATCH 
– User permissions in a user role (global) 
– Permitted user roles per computer (for each specific computer) 
– Permitted user roles per plant unit (for each specific unit) 

● The PCS 7 applications are supplied with information about the logged on user via the 
central logon service and can be informed of any change of the logon, etc. 

Basic procedure in a Windows domain 
 

 Note 
A domain administrator is responsible for creating users and groups in a domain. This 
administrator must have the necessary experience and authorization to administer the 
network. 

 

Domain administrators in PCS 7 plants 
 

 Note 
Domain administrators must only use their authorization to administer the network (e.g., to 
set up users or add PC stations to a domain) and not to work within the PCS 7 project.  

 

Additional information 
● Manual SIMATIC; SIMATIC STEP 7 
● Online help WinCC Information System 
● Manual Process Control System PCS 7; SIMATIC BATCH 
● Manual Process Control System PCS 7; SIMATIC Route Control 
● Manual SIMATIC; SIMATIC Logon 
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4.4.8 Firewall in PC stations 

Windows firewall 
PCS 7 uses the operating system's firewall (see pcs7-readme). 
"SIMATIC Security Control" makes the necessary settings in the exceptions list of the 
Windows-Firewall. 
You will find more information on this topic in the section "How to retro-activate the security 
settings for PCS 7 (Page 145)" 

Requirement for using a firewall on the plant bus 
You require a specific firmware version of the CP 443-1 to use a firewall on the plant bus. 
You can find additional information about this in the section "Components for Connecting to 
the Terminal Bus/Plant Bus (Page 53)". 

Additional information 
● Section "Components for connection to the terminal bus/plant bus (Page 53)" 
● Section "How to change the settings of the Windows firewall for Open PCS 7 (Page 146)" 
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4.4.9 Reinstallation or updating 
If a PCS 7 software package is already installed on the PC, a dialog box for the type of 
installation appears during the PCS 7 system setup. You can specify which type of 
installation you require in this dialog box:  
● Reinstallation 
● Update 

Reinstallation 
A reinstallation allows you to install additional software packages on your PC. 

Update 
An update replaces existing software packages with newer versions of the software. Make 
sure that you select the latest software packages of the new version. 
Recommendation:  
Reboot the PC station before updating the PCS 7 software. 

 

 Note 
Some software packages of PCS 7 automatically reboot the PC station during updating. 

 
 Note 

If you want to update a PCS 7 project from a previous version of PCS 7 with the latest 
version of PCS 7, follow the procedure described in the manuals for the software update. 
You will find more information in the manual Process Control System PCS 7; 
Software Updates 

 



 Installing PC stations 
 4.4 Installing the PCS 7 software 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 97 

4.4.10 Removing PCS 7 
If you want to update your PCS 7 software, it can be overinstalled. 
If you no longer require PCS 7 on the PC station, you can remove the PCS 7 software by 
performing the steps described below. 

 

 Note 
The default folder containing PCS 7 projects is retained. 

 

Recommendation 
We recommend the procedure below: 
1. Uninstall the license keys. 
2. Back up any data you still need. 
3. Format the hard disk. 
4. Reinstall the PC. 

Uninstalling PCS 7 
1. Select the menu command Start > Settings > Control Panel. 

The "Control Panel" dialog box opens. 
2. In the tree structure, double-click on Add or Remove Programs. 

The "Add or Remove Programs" dialog box opens. 
3. Click "Change or Remove Programs". 
4. Select "SIMATIC PCS 7" from the list. 
5. Click "Remove". 

Follow the instructions to remove the PCS 7 software. 
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4.5 Installing drivers for PCS 7 

4.5.1 Drivers for communications processors 

4.5.1.1 Drivers for communications processors 

Introduction 
The PCS 7 system setup automatically installs the required drivers for the communications 
modules. This is only possible when the communications modules have been be inserted in 
the PC prior to installation of PCS 7. 
If the type of communications module changes after a PCS 7 installation, you will have to 
reinstall the driver for the communications modules from the PCS 7 Toolset DVD 
(SIMATIC NET PC software package).  

Plug-and-play capability 
The communications processors used for PCS 7 support plug-and-play. The required 
settings are made automatically when the PC starts up. 

 

 Note 
If plug-and-play components are not detected, check in the BIOS whether the detection of 
plug-and-play components is activated. You will find more information on this topic in the 
documentation of the BIOS manufacturer. 
Detection of plug-and-play components is activated as default for PCS 7 bundle PCs. 

 

Changing protocols on the bus (Industrial Ethernet) 
If you need to change the protocol of a bus in a system (from TCP to ISO, for example), you 
will need to set a mixed protocol (TCP and ISO) briefly on the engineering station.  
Now load the configuration data onto the AS and the operating and monitoring systems. 

 

NOTICE  
Do not disable the TCP/IP or ISO protocol during operation since they are both needed for 
configured operation! 
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4.5.1.2 How to install drivers for communications modules 

Requirement 
● The communications modules have been installed in the PC. 

Starting the PCS 7 setup 
1. Insert the PCS 7 Toolset DVD in the DVD drive. 
2. Double-click on "Setup.exe" to start the setup. 

Setup starts. 

Settings in the setup 
Below you will find information about the settings made in the setup dialog boxes, listed in 
the order in which they are processed: 
1. Setup language 

– ... For example, "English" and "Next" 
2. Welcome 

– ... "Next" 
3. Readme 

– ... Read this if needed and "Next" 
4. Software license agreement 

– ... Activate this with the "I accept ..." radio button and click "Next" 
5. Setup type 

– ... Activate this with the check box "Install" and "Next" 
6. User information 

– ... Enter user name and organization (company / ID number) and "Next" 
7. Installation type 

– ... Activate this with the check box "User-defined installation" and "Next" 
8. Programs 

– ... Activate the programs with the check box "SIMATIC NET PC Software" and "Next" 
9. Ready to install the selection 

– ... "Install" 
The installation of the software package starts and a window shows its progress. 
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10. Close the dialog box when the installation is complete. 
11. Reboot the PC. 

 

  Note 
Additional steps are required if a communications processor without a stand-alone 
processor has been subsequently installed: You can find additional information about this 
in the section "How to Set Up Standard Communications Processors (Page 101)". 
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4.5.1.3 How to configure standard communication modules 

Settings for BCE and Softnet CPs 
If the system has a separate bus (terminal bus and plant bus), we recommend that you 
select the ISO protocol and disable the TCP/IP protocol for the plant bus. An exception is 
communication with SIMATIC PCS 7 BOX, SIMATIC PCS 7 AS RTX, and automation 
systems, which provide the CPU with access to an integrated Ethernet interface. 

 

 Note 
You select the protocol for the plant bus during configuration of the communication modules 
in HW Config and/or NetPro. 

 

Requirements 
● PCS 7 has been installed. 
● There is no communication. 
● The user programs are closed. 
● The network adapter is not CP 1613. 

The CP 1613 uses another type of connection (S7 connection). 

Procedure 
1. Select the menu command Start > Settings > Network Connections. 
2. Right-click the communications processor (connection) for the plant bus for which you 

wish to disable the TCP/IP protocol, and select the menu command Properties. 
3. Deactivate the check box "Internet protocol (TCP/IP)" and in the area "Components 

checked are used by this connection" activate "SIMATIC Industrial Ethernet (ISO)" to use 
the ISO protocol. Click "OK". 
If a note appears stating that some additional services ("File and Printer Sharing", "Client 
for Microsoft Networks") have been disabled, just ignore it. 

4. For PCs with several network adapters: 
– Select the menu command Advanced > Advanced Settings. 
– Select the network connection to the terminal bus in the "Connections" area. 
– Move the selected network connection to the top position using the arrow keys. 

5. Click "OK" to close the dialog boxes. 
6. Reboot your PC to activate the settings. 
7. Select the menu command Start > Settings > Network Connections. 
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8. Clear the following options for the communications processor on the plant bus: 
– "Client for Microsoft Networks" check box 
– "File and Printer Sharing for Microsoft Networks" check box 

9. Click "OK" to close the dialog boxes. 
 

  Note 
Also refer to the notes in the WinCC Information System, under the topic "Special 
Communication Features for a Server with Several Network Adapters". 
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4.5.1.4 How to disable the power saving options of network adapters 

Introduction 
Many modern network adapters support energy management features. You can reduce 
energy consumption with these features.  
Energy saving options allow the PC to monitor the activity of input devices. If energy saving 
options are activated, they shut the PCS 7 PC down or trigger a restart if the PC is inactive 
for a set period of time. 
We recommend you disable this function for all PCs involved in the process mode. 

Procedure 
1. Windows Server 2003: Select the menu command Start > Settings > Network 

Connections. 
2. Select the network connection. 
3. Select the menu command File > Properties. 
4. Select the "General" tab. 
5. Click "Configure". 

The "Properties <network adapter>" dialog box opens. 
6. Check all the displayed tabs to see whether the PC can disable the network card in order 

to save power (see figure below). 
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7. Disable the energy saving function. 
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4.5.1.5 How to Prepare an Engineering Station with CP 1613 for Use in PCS 7 

Introduction 
When a CP 1613 is used as a network adapter in a engineering station, the NDIS adapter 
needs to be configured in the following cases: 
● You want to monitor the diagnostics of network components on the plant bus with a 

maintenance station (MS). A CP 1613 is used as a network adapter in the MS client 
(engineering station) for accessing the plant bus. 

● You want to load an automation system integrated in a Box PC using an external 
engineering systems. A CP 1613 is used as a network adapter in the engineering system 
for accessing the plant bus. 

Overview 
Perform the following tasks: 
● Install the SIMATIC CP 1613 NDIS adapter 
● Configure the network settings for the SIMATIC CP 1613 NDIS adapter 

 

  Note 
Perform these steps for every CP 1613 of the MS client or engineering system. 

Installing the SIMATIC CP 1613 NDIS adapter 
You must make the following settings on the PC station with the CP 1613. 
1. Select the menu command Start > Settings > Control Panel > Add/Remove Hardware. 

The "Add/Remove Hardware" dialog box opens. 
2. Click "Next". 
3. Select the check box "Yes, the hardware is already connected". Click "Next". 
4. Select "Add new hardware" from the list. Click "Next". 
5. Select the check box "Select and install hardware manually from a list". Click "Next". 
6. Select "Network adapter" from the list. Click "Next". 
7. Select the following entries: 

– Select the entry "SIEMENS AG" in the "Manufacturer" area. 
– Select the entry "SIMATIC CP 1613 NDIS Adapter" in the "Network adapter" area. 

8. Click "Next". 
9. Click "Next".  

The installation is performed. 
10. If you receive a message indicating an error in the Windows Logo Test in the "Hardware 

Installation" dialog box, ignore this message. Click "Continue installation". 
11. Click "Finish". 
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Result 
The NDIS adapter is installed. 

Configure the network settings for the SIMATIC CP 1613 NDIS adapter 
You must make the following settings on the PC station with the CP 1613. 
1. Select the menu command Start > Settings > Control Panel > Network Connections. 

The "Network Connections" dialog box opens. 
2. Select the menu command View > Details. 
3. Right-click on the NDIS adapter "SIMATIC CP 1613 NDIS Adapter" to select it.  

Recommendation: Select the shortcut menu command Rename. Enter a descriptive 
name, for example "CP 1613_NDIS_Adapter_No_1". 
Select the shortcut menu command Properties. 

4. Select the connection "Internet Protocol (TCP/IP)". Click "Properties". 
The "Internet Protocol (TCP/IP) Properties" dialog box opens. 

5. Select the check box "Use the following IP address".  
Configure: 
– IP address 
– Subnet mask 

6. Click "OK". 
7. Close the "(Network Connection) Properties" window. 

Result 
The network settings for the NDIS adapter are now applied. 
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4.5.2 Additional Devices and Drivers for PCS 7 

4.5.2.1 Additional Devices and Drivers for PCS 7 

Introduction 
If you want to use particular properties of PCS 7, additional drivers are available on the 
PCS 7 Toolset DVD. 

Overview of additional devices and drivers 
 

Application Driver Driver location on PCS 7 
Toolset DVD 

Additional information 

Multiple monitors 
on a single PC 

Matrox Multi VGA Additional_Products\ 
Drivers\Display\… 

Section "How to activate a 
multi-VGA graphics card 
(Page 108)" 

Acoustic or visual 
signal transmitter 

Horn module The required drivers are 
automatically installed 
with PCS 7. 

Configuration manual 
Process Control System 
PCS 7; Operator Station 

Acoustic signal 
transmitter 

Sound card Not included on the 
PCS 7 Toolset DVD – 
Located on sound card or 
standard Windows 
installation medium 

Section "How to activate a 
sound card (Page 110)" 

Time signal via 
DCF77  

Time reception 
service 

Additional_Products\ 
Drivers\DCF77 

Section "How to activate the 
DCF77 reception service 
(Page 111)"  

Chip cards Chip card reader The drivers required for 
chip card readers at the 
COM interfaces are 
automatically installed 
with PCS 7. 
You will find drivers for 
USB chip card readers 
under 
Additional_Products\ 
Drivers\chipcard. 

WinCC Information System 
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4.5.2.2 How to activate a multi-VGA graphics card 
The procedure below describes how to retro-install a Matrox multi-VGA graphics card in a 
PC station with an on-board graphics card.  

Multi-VGA graphics card 
The following graphic cards are recommended for PC stations in PCS 7: 
● G200 MMS (order number: 6ES7652-0XX02-1XE0 or 6ES7652-0XX02-1XE1) 
● G450 MMS (order number: 6ES7652-0XX03-1XE0 or 6ES7652-0XX03-1XE1) 

 
 

  Note 
Matrox G450 Dualhead 
The Matrox G450 Dualhead graphics card is not approved for multi-VGA operation. If this 
graphics card is used, it is essential that "bus mastering" is deactivated. 

Driver 
If the G200 MMS multi-VGA graphics card is used in PCS 7 V7.0 and higher, we recommend 
that the Matrox 5.96.005 driver is also used. You will find this driver on your "PCS 7 Toolset" 
DVD in folder Additional Products > Drivers > DISPLAY > Matrox_G450_MMS > 
XP2K_596_005.exe. 

Preparation 
1. Shut the PC station down. 
2. Install the multi-VGA graphics card in the PC station, taking the information contained in 

the PC station user manual into account. 
3. Start Windows in safe mode (press F8 while Windows is booting). 
4. Disable (but do not uninstall) the on-board graphics card in the Device Manager as 

follows: 
– Select the Device Manager from the My Computer shortcut menu on the desktop, 

using the menu command Properties > Hardware > Device Manager. 
– In the Device Manager, disable the on-board graphics card by right-clicking on 

Graphics Card. 
 

  Note 
This procedure saves you from having to reinstall the on-board graphics card, should 
you want to reactivate it at a later time. 
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5. Restart the computer and change the on-board graphics card to PCI in the PC station 
BIOS. 
– You reach the BIOS by pressing the F2 key when the PC station is starting up. 
– In the BIOS select "Main > Boot Options > Primary Display" and change "AGP VGA" 

to "PCI VGA". 
– Reset the PCI bus configuration in the BIOS under "Advanced > Reset Configuration 

Data > Yes". 
– Save the changes in the BIOS and start up the computer in the "VGA compatible" 

Windows mode. 

Procedure 
1. Install the driver for the multi-VGA graphics card. 
2. Restart your computer. 
3. Finally, the parameters of the multi-VGA graphics card need to be set. 

You will find more information on this topic in the WinCC Information System: 
– Options > Options for Process Control > OS Project Editor > Split Screen Manager > 

Notes on Multi VGA. 
– Release Notes > Options for Process Control > Multi VGA 

 

  Note 
The "Matrox screen properties" are only displayed in the Control Panel if the Matrox 
graphics card driver is installed. 
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4.5.2.3 How to activate a sound card 

Introduction 
You can use standard sound cards to output acoustic messages. A *.wav sound file created 
using standard software will be played repeatedly until you acknowledge the message. 

Requirements 
● The sound card has been installed. 
● The WAV file is on the computer. 
● The WAV file supports pulse code modulation format (mono/stereo). 
● DirectX has been installed. 

Procedure 
1. Select the menu command Start > Settings > Control Panel. 
2. Double-click on "Sounds and Audio Devices". 
3. Select the "Audio" tab. 
4. Select the sound module from the "Default device" drop-down list box. 

More information 
You will find more information about configuring sounds and assigning them to events in the 
configuration manual Process Control System PCS 7; Operator Station. 
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4.5.2.4 How to activate the DCF77 reception service 

DCF77 reception service 
The DCF77 reception service performs the following tasks: 
● Analyzes time signals from the DCF77 transmitter of the Physikalisch-Technische 

Bundesanstalt in Mainflingen in Darmstadt, Germany 
● Compares the time signals with the system time of the PC station 
● Corrects the system time if necessary 
A receiver module reads in the time signals in different ways. The reception service expects 
the time signals over one of the serial ports of the PC station. 

 

 Note 
You can use the "DCF77 Reception Service" application as a client application to 
synchronize any number of PCs without the DCF77 module. 

 

Requirement 
The DCF77 receiver module has been connected to an available serial port on the PC 
station. 

Procedure 
1. Select the folder Additional_Products > DCF77Client on the PCS 7 Toolset DVD. 
2. Start the "SETUP.exe" program. 
3. Change the settings in the Control Panel if necessary. 
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4.6 Licensing 

4.6.1 Licensing and authorizing PCS 7 software 

Important terms 
The following table lists terminology that is important for licensing: 

 
Term Description 
License A license provides the right to use products. This right is in the form of: 

• CoL (Certificate of License) 
• License key 

CoL (Certificate 
of License) 

The CoL certifies the license. The product may only be used by the license owner 
or authorized persons.  

License key The license key is the "technical representative" of the license (also called an 
"electronic license stamp").  

Authorization The authorization is a "technical representative" of a license, which was granted 
for older versions of software packages. It has the same function as a license key. 

 
 

 Note 
In this section, we only use the term license key, even if a product is still using the older 
"authorization". 
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License types 
Every license is made up of a basic license type and a license type.  
The basic license type defines how many PC stations the associated software may be 
installed and used on. The license type defines any applicable restrictions on how the 
associated software may be used. 
● The following basic license types are available to you: 

 
Basic license type Description 
Single license With this license, the software may be used on any single computer. The type 

of permissible usage is defined in the Certificate of License. 
Floating license With this license, the software may be used on any computer within a network. 

The software may be installed on several computers for this purpose. 

● The following license types are available to you: 
 

License types Description 
Unlimited license With this license, the software may be used without restriction. 
Count relevant 
license 

With this license, software usage is restricted to: 
• The number of days defined in the contract 

Rental license With this license, software usage is restricted to: 
• The number of operating hours defined in the contract 
• The number of days after first use defined in the contract 
Note: The information area of the task bar will display tooltips telling you how 
long the rental license has left to run. 

Trial license  With this license, software usage is restricted to: 
• A maximum of 14 days, for example 
• A certain number of days after first use 
• Test and validation purposes (disclaimer of liability) 

Pay per use license With this license, software usage is restricted by the terms of use defined in 
the contract. 

Demo license With this license, software usage is restricted to: 
• The number of operating hours defined in the contract 
• The number of days after first use defined in the contract 
Note: The information area of the task bar will display tooltips telling you how 
long the demo license has left to run. 

Contract license With this license, the software may be used without restriction. 
Upgrade license Specific system status requirements may have to be met for an upgrade to be 

performed: 
• With an upgrade license, a license of an "old" version x can be converted to 

a version >x+.... 
• An upgrade may become necessary due to an increased quantity structure, 

for example. 
 
 

 Note 
Not all products support all license types. In the Automation License Manager you can see 
which license form is valid for a specific product. 
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PCS 7 without a license key 
You may use the PCS 7 Engineering Toolset software package in a trial version for up to 
14 days. 

 

 Note 
You can activate the trial (demo) mode the first time the software is used. 

 

Missing license key  
When a software program requests a license key, but it cannot be located on the network in 
a "valid" format, it is described as a "missing license key". 

Automation License Manager 
All license keys are managed in a central location using the Automation License Manager 
software, which is installed by means of the PCS 7 system setup. 

Virus-free 
 

 Note 
Check that your PC is virus-free prior to each installation/uninstallation of a license key.  
You must disable the license key diskette's write protection in order to transfer the license 
key, which brings with it the risk that viruses may be passed between hard disks and the 
diskette. 

 

More information 
● Manual Automation License Manager 
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4.6.2 How to transfer license keys 

Introduction 
The following license keys are transferred with the Automation License Manager software: 
● License keys belonging to licenses purchased at a later date 
● License keys stored at locations which cannot be accessed by a computer's applications 

Possible license key storage locations  
● License key diskettes 
● Local storage media 
● Storage media on connected computers 
● Removable disks (e.g., USB stick, but not CDs or DVDs) 

Options for transferring license keys 
The Automation License Manager gives you the following options for transferring license 
keys between the various possible storage locations: 
● Drag-and-drop 
● Cut and paste 
● Offline transfer 

Requirement 
The Automation License Manager has been started up. 

Procedure - Drag-and-drop 
1. Select the appropriate view using the menu command View > Manage. 
2. On your own or the connected computer, open the storage location where you wish to 

insert the license keys. 
3. On your own or the connected computer, open the storage location from where you wish 

to remove the license keys. 
4. Select the license keys, hold down the left mouse button and drag the license keys to the 

folder where you wish to insert them. 
The license keys are transferred. 
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Procedure - Cut and paste 
1. Select the appropriate view using the menu command View > Manage. 
2. On your own or the connected computer, open the storage location from where you wish 

to cut the license keys. 
3. Select the menu command Edit > Cut. 
4. On your own or the connected computer, open the storage location where you wish to 

paste the license keys. 
5. Select the menu command Edit > Paste. 

The license keys are transferred. 

Procedure - Offline transfer 
The Automation License Manager online help describes how to perform an offline license 
key transfer. 

Defective cluster on hard disk 
 

 Note 
As part of the license key safety system, when license keys are transferred, clusters 
identified as "defective" are created on the target drive. You must not reconstruct these 
clusters, as this will destroy the license keys. 

 

Backing up license keys 
The Automation License Manager enables you to back up all license keys (authorizations) - 
see "Possible license key storage locations". 
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4.6.3 Selecting the correct license keys/authorizations 

Introduction 
The configurable size of a PCS 7 plant is scalable. The software product licenses for 
engineering stations, operator stations, SIMATIC BATCH stations, Route Control stations, 
and SIMATIC PDM are available with different quantity structures. You can expand these 
quantity structures using additional Power Packs. 

 

 Note 
Hereinafter, we use the term license key even for products that still use the older 
authorizations. 

 

Process objects 
In PCS 7 version V7.0 SP1 and higher, the following objects are classed as the process 
object (PO) for licensing purposes: 
Objects which can generate messages 

Levels of licenses 
The following table shows the available system size increments (for each component of the 
process control system).  

 
Component of 
process control 
system 

Levels of licenses Comment 

Engineering Max. PO:  
• 250 
• 1000 
• 2000 
• Unlimited 

• Limits the sum of all process objects on 
the ES 

Engineering system 
(ES) 

Downloadin
g to 
SIMATIC 
stations 

Max. PO (tags): 
• 100 
• 200 
• 250 
• 1000 
• 10000 

• Objects which can generate messages 
are classed as the process object (PO) 

• The license type of these license keys 
is "Count relevant license". 

• Limits the sum of process objects of all 
AS license keys on the ES 

Operator station 
(OS) 

Max. PO:  
• 250 
• 1000 
• 2000 
• 3000 
• 5000 
• 8500 

• Limited to 5,000 PO per single station 
system 

• Limited to 8,500 PO per OS server 
• Maximum of 12 servers each with max. 

5,000 PO = 60,000 PO 
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Component of 
process control 
system 

Levels of licenses Comment 

OS client   WinCC RT PO Client 
Central archive 
server 

 WinCC RT PO Client 

Archiving  
(OS server and 
central archive 
server) 

Max. archive tags: 
• < 512 
• 512 < 1500 
• 1500 < 5000 
• 5000 < 10000 
• 10000 < 30000 
• 30000 < 80000 
• 80000 < 120000 

• You can archive a maximum of 1,000 
archive tags per second with an OS 
server. 

• You can archive a maximum of 12,000 
archive tags per second with a central 
archive server. 

The license for < 512 archive tags is 
included in all OS server licenses. If you 
want to archive more archive tags, all 
additional licenses up to the desired 
capacity are required. 

Maintenance station 
(MS) 

Max. asset tags  
(hardware components): 
• 10 
• 100 
• 1000 

Number of monitored hardware 
components within a PCS 7 project 
The license type of these license keys is 
"Count relevant license".  

Max. Web clients 
• 3 
• 10 
• 25 
• 50 

Number of Web clients on the OS Web 
server 

PCS 7 OS Web 
Option 

Max. Web diagnostic clients 
• 3 

 

BATCH stations 
(batch processes) 

Max. units (plant units):  
• 10 
• 20 
• 40 
• 100 
• Unlimited 

Number of units within a PCS 7 project 
• The number of units that can be 

processed depends on the utilization of 
the BATCH server. 

Route Control 
Station (route 
control) 

Max. routes 
• 30 
• 31 to 100 
• 101 to 300 

Number of activated routes in process 
mode (material transports) 
The base of 30 active routes can be 
increased by upgrading to the next highest 
level. 

PDM  Max. devices:  
• 4 
• 128 
• 512 
• 1024 
• 2048 
• Unlimited 

Number of configurable devices 
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Component of 
process control 
system 

Levels of licenses Comment 

Engineering Max. PO:  
• 250 
• 1000 
• 2000 

• Limits the sum of all process objects on 
the ES 

• You can find additional information in 
this table for the engineering system 
(ES) 

Operator 
station  

Max. PO:  
• 250 
• 1000 
• 2000 

• Limited to 2.000 PO per single station 
system 

Downloading 
to SIMATIC 
stations 

Max. PO (tags):  
• 3 x 100 

• The license type of these license keys 
is "Count relevant license". 

• You can find additional information in 
this table for the engineering system 
(ES) 

PDM Max. devices:  
• 4 
• 128 

• Limited to 128 devices  
per SIMATIC PCS 7 BOX 416 

Maintenance 
Station 

Asset tags  
(hardware 
components): 
• 10 
• 100 

• The license type of these license keys 
is "Count relevant license". 

• You can find additional information in 
this table for the maintenance station 
(MS) 

BATCH Max. units (plant 
units):  
• 10 

• Limited to 10 units 
per SIMATIC PCS 7 BOX 416 

SIMATIC PCS 7 
Box PCs 

Route Control Max. routes 
• 30 

• Limited to 30 routes 
per SIMATIC PCS 7 BOX 416 

List of license keys 
You can find an overview of license keys in the section "Software Packages and Required 
License Key (Page 166)". 



Installing PC stations  
4.6 Licensing 

 PC Configuration and Authorization 
120 Operating Manual, 09/2007, A5E00783465-02 

4.6.4 Calculating the process objects for the SIMATIC station 

License key for the AS 
The required license key for all SIMATIC stations depends on the total number of process 
objects loaded and configured in a project (multiproject). 
When an AS is loaded, the loaded process objects are evaluated. The following procedure 
shows you how to calculate the number of process objects configured in a project. With a 
multiproject, you need to determine the number per project and add them together. 
The following applies as of PCS 7 V7.0 SP1:  
The number of process objects loaded into the AS is calculated and subtracted from the 
available process objects (countable license keys). 
You calculate the number of available (still to be loaded) process objects using the license 
key via the Automation License Manager or in SIMATIC Manager via the menu command 
Options > Charts > Process Objects Statistics.  

Display 
The display of the number of licenses is based on the object selected in the 
SIMATIC Manager (multiproject, project, SIMATIC station). 

Requirement 
The SIMATIC Manager is open. 

Procedure 
1. Select the multiproject in the component view. 
2. Select the menu command Options > Charts > Process Objects Statistics. 

The "Process Objects Statistics" dialog box opens. 
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Result 
The "Process Objects Statistics" dialog box shows the number of configured process 
objects, the existing license, and the process objects which are currently still available for the 
following system areas: 
● Multiproject 
● Project 
● SIMATIC station 
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4.6.5 Calculating the process objects for the engineering station 

License key for engineering 
Relevant process objects in the project are process objects that can be monitored with the 
OS. 
The license key for engineering provides the number of process objects that you can 
configure in the CFC as "process objects in the project". 

Procedure 
You can calculate the number of configured process objects as follows: 
1. Open any chart in CFC. 
2. Select the menu command Options > Chart Reference Data. 

The "Chart Reference Data" dialog box opens. 
3. Select the menu command View > Statistics. 

Result 
You will find the number of "Process objects (PO) [x]" and the scale of the license key in the 
"process objects in the project" path. The following figure shows an example. 
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4.6.6 Calculating the process objects for the operator station 

License key for process objects 
License keys for operator stations are differentiated as follows: 
● RT license keys 

RT license keys permit unlimited (in terms of time) use of WinCC in process mode 
(runtime mode). You can only use the editors for a limited period of time in demo mode. 

● RC license keys 
RC license keys permit unlimited (in terms of time) use of WinCC in process (runtime) 
mode and configuration mode. 

This license key allows you to operate and monitor a defined number of configured process 
objects with the operator station.  
Projects which use SIMATIC BATCH require a larger number of process objects. 

License key for archive values 
This license key allows you to archive a defined number of archive values with the operator 
station. The basic package is supplied with a license key for 512 archive values.  
The license key required for archiving archive values in the OS project depends on the 
number of values configured for archiving. 

License key designations 
The license key RT (x)/RC (x) defines how many external variables are permitted.  
Example 1: WINCC RC (5000) 
The following configuration is possible with this license key (RC): 
● Up to 5,000 process objects 
● Up to 512 archive values 
Example 2: WINCC User Archives (10000) 
This license key enables you to increase the number of archive values which can be 
configured for the archive server to 10,000. 

License key for OS clients 
A license key is required for OS client process mode (WinCC RT PO Client). 
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Requirement 
The OS project must be open in the WinCC Explorer. 

Procedure 
If you have executed the "Compile OS" function in SIMATIC Manager, you can determine 
the number of configured process objects in the WinCC Explorer: 
Determining the number of process objects 
1. Select the OS in the WinCC Explorer: 

The number of configured process objects is displayed at the bottom right of the dialog 
box.  
The screenshot below shows an example with "578 process objects". 

 
 

Determining the number of archive values 
1. Open the "Tag Logging" editor in the WinCC Explorer.  

The number of configured archive values is displayed at the bottom right of the dialog 
box. 
The screenshot below shows an example with 129 of 10,000 authorized archive values. 
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Extension by means of Power Packs 
You can use Power Packs to increase the number of configurable archive values. 
Example:  
If you need to archive around. 20,000 archive values, install Power Packs for 1,500 to 
30,000 archive values in addition to the basic license key. You will need the following Power 
Packs in addition to the basic license key: 
● Power Pack 512 < 1,500 configurable archive values 
● Power Pack 1,500 < 5,000 configurable archive values 
● Power Pack 5,000 < 10,000 configurable archive values 
● Power Pack 10,000 < 30,000 configurable archive values 

Insufficient license key 
 

 Note 
If you open a project with an insufficient number of configurable process objects, the OS 
program switches to demo mode automatically. 
If an RT/RC license key is present, the maximum number of configurable process objects is 
always permissible on a client, as the number of configurable process objects is only 
checked on a server. 
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4.6.7 Calculating the process objects for the central archive server 

Introduction 
The archive values of all OS servers in a PCS 7 plant are archived on a central archive 
server. The sum of the archive values of all OS servers gives the number of licensed archive 
values. 

License keys for the central archive server 
The following license keys are required for the central archive server: 
● License key for operating an OS client: WinCC RT PO Client 
● License key for the "StoragePlus" software package: StoragePlus 
● To use the central archive server: WinCC Server 
● To use the archives: WinCC Archive 
● To view archived data: WinCC DataMonitor 

Determining the number of archive values on an OS server 
1. Open the "Tag Logging" editor in the WinCC Explorer.  

The number of configured archive values is displayed at the bottom right of the dialog 
box. 
The screenshot below shows an example with 129 of 10,000 authorized archive values. 

 
 

2. Determine the number of archive values of all OS servers. 
 

  Note 
If redundant OS servers are used, the number of archive values must be doubled. 
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4.6.8 Calculating the asset tags (hardware components) for the maintenance station 

License key for maintenance station 
The license type of these license keys is "Count relevant license". The licensed scope is 
added together when several license keys are installed.  
● This license key allows you to monitor a defined number of diagnostic objects 

(asset tags). 
Example: Maintenance RT (100) 
This license key is sufficient for diagnosing up to 100 hardware components with a 
maintenance station. If you have three Maintenance RT (100) license keys on a 
maintenance station, you will be able to diagnose up to 300 hardware components. 

Components with diagnostics capability 
The following components with diagnostics capability are classed as asset tags within a PCS 
7 project: 
● PC stations 
● Network components with diagnostics capability (e.g., switches) 
● Automation systems (CPU) 
● Distributed I/O (ET 200 station) 
● Field devices with diagnostics capability 

Requirement 
SIMATIC Manager is open. 

Procedure 
1. Select the multiproject in the plant view. 
2. Select the menu command Options > Plant Hierarchy > Configured Objects. 

The "Configured Objects" dialog box opens. 
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Result 
The "Configured Objects" dialog box displays the number of configured diagnostic objects 
(asset tags). 
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4.6.9 Calculating the units for the BATCH station 

License key for BATCH station  
A defined number of units can be operated and monitored with this license key. The number 
of units that can be processed depends on the utilization of the BATCH server. 
Example: BATCH Server (20) 
The license key for BATCH server is adequate for configuring up to 20 units. 

Requirement 
● SIMATIC Manager is open. 

Procedure 
1. In the SIMATIC Manager, select the multiproject/project for which you want to calculate 

the number of configured units. 
2. Select the menu command Options > SIMATIC BATCH.. 

.The "Configure BATCH Process Cell" dialog box opens. 
3. Select the "BATCH Process Cell" folder in the tree view. 
4. In the "Process Cell" section, click "Check validity". 
5. In the "Log" group, enable the "Validate" check box. 
6. Click the "Display" button. 

Result 
A log file opens in the Internet Explorer. 
● If the "Check validity" or "Compile" function shows an error in the configuration, you will 

need to correct the error and calculate the process objects again. 
● If the configuration is free of errors, you will find the number of units configured in the 

multiproject/project in the table under the heading "Units". 
● You can calculate the number of configurable units based on the license keys through the 

Automation License Manager. 

Example of the layout of a log file: 
 

Plant Units Log Date, time Result 
<process cell 
name> 

11 Plausibility <date, time> 0 errors, 0 warnings 

No. ID Error Warning Remedy 
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4.6.10 Calculating the routes for the route control station 

License key for route control station 
For the process mode of SIMATIC Route Control, the number of active routes (material 
transports) is relevant and not the number of configured routes. The number of routes active 
in process mode is based on the process. 
Example: Route Control Server (300)  
This is the license key for a route control server in which 300 routes can be simultaneously 
active in process mode. 

Determining the route license 
The status bar of the Route Control Center shows how many routes were active 
simultaneously after a restart of the route control server. 

License key too small – server license key is installed 
 

 Note 
If the route control server detects a license key for 30, 100 or 300 routes during startup, the 
maximum number of simultaneous material transports will be limited to this value. If the 
server then receives a 31st, 101st or 301st route request, the Route Control Center reports 
that the license key is missing or that the limit has been exceeded. The route control server 
continues to operate. 

 

License key too small – server license key is not installed 
If no license key is installed on the route control server, the server is limited to a maximum of 
300 routes (maximum limit). Since information about the actual size of the system is lacking 
on the route control server, it makes an estimate on the safe side - you can continue to 
operate the system even when there is no license. The absence of a license is displayed in 
the Route Control Center.  

New license 
Restart the route control server after you have installed the license. 
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4.7 Preparing PC stations 

4.7.1 Preparing PC stations - an overview 

Introduction 
After installing the PCS 7 software, configure and set up the communication interfaces. 

Requirements 
● The PCS 7 software and PCS 7 hardware have been installed. 
● The communications processors have been installed. 

 

  Note 
To commission SIMATIC PCS 7 BOX, use the manual Process Control System PCS 7, 
SIMATIC PCS 7 BOX. 

 

Overview of the individual steps 
To enable you to configure, download and test all automation systems and PC stations (OS, 
BATCH) of a PCS 7 project from a central engineering station (ES), make the following 
settings on all PC stations. 
Make these settings on the central engineering station, too. 

 
Step What? 
1 Creating the "Logon_Administrator" user group for SIMATIC Logon (Page 132) 
2 Assigning the SQL access permissions for OS users (Page 134) 
3 Setting the language for a user (MUI) (Page 135) 
4 Setting the communication modules (Page 137) 
5 Configuring the PC station in the configuration console (Page 139) 
6 Setting the standard network adapters (Page 141) 
7 Changing the transmission rates and operating modes in the PC network (Page 142) 
8 Installing security patches, hotfixes, service packs (Page 144) 
9 Activating the security settings for PCS 7 (Page 145) 
10 Activating the firewall settings for Open PCS 7 (Page 146) 
11 Activating redundancy for fault-tolerant PCs (Page 147) 
12 Downloading the network configuration to the PC stations (Page 148) 
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4.7.2 How to create user groups for SIMATIC Logon 

Introduction 
If you want to use SIMATIC Logon for access protection in a PCS 7 plant, you have to set up 
the "Logon_Administrator" user group. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Administrative Tools > 

Computer Management. 
2. In the tree view, select "System > Local Users and Groups > Groups". 
3. Select the menu command Action > New Group. 

– Create user groups in accordance with their corresponding tasks (e.g., Operators, 
Service Engineers, Managers). 

– If you want to use SIMATIC Logon functions, create the "Logon_Administrator" group. 
4. In the tree view, select "System > Local Users and Groups > Users". 
5. Select the menu command Action > New User to create all users (with password) and 

user groups in the Windows network (Windows server). 

Requirements for defining user roles with SIMATIC Logon 
● SIMATIC Logon is installed on every computer with a PCS 7 application. 
● The group "Logon_Administrator" is created on one PC (logon computer). 

Information on the next steps 
● You will find instructions on how to use SIMATIC Logon to set-up user roles and assign 

them to the defined Windows user groups in the manual SIMATIC; SIMATIC Logon. 
● You will find information on the additional settings you need to make in the 

documentation relating to the applications that use SIMATIC Logon for access 
management purposes. 

More information 
● Manual SIMATIC; SIMATIC Logon 
A user must be a member of the following groups in order to access an OS project: 
● "SIMATIC HMI" group 
● "SYSTEM" group 

Requirement 
You are logged on as an Administrator. 
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Procedure 
1. Open Windows Explorer. 
2. In the tree view, select the drive on which the OS project is stored. 
3. Select the menu command File > Properties. 

The "... Properties" dialog box opens. 
4. Select the "Security" tab. 
5. If they are not listed already, add the "SIMATIC HMI" and "SYSTEM" groups to the 

"Groups or User Names" list. 
6. Enter all authorizations for the "SIMATIC HMI" and "SYSTEM" groups.  



Installing PC stations  
4.7 Preparing PC stations 

 PC Configuration and Authorization 
134 Operating Manual, 09/2007, A5E00783465-02 

4.7.3 How to assign the SQL access permissions for OS users 

Microsoft SQL Server 2005  
Since Microsoft SQL Server 2005 does not support additional user groups, you must enter 
all members of the "SIMATIC HMI" user group into the following user group: 
"SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC" 

Requirement 
● The local users for PCS 7 process mode have been created. 
● The users for process mode are members of the "SIMATIC HMI" user group. 
● You are logged on as an Administrator. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Administrative Tools > 

"Computer Management" dialog. 
2. In the tree view, select folder System > Local Users and Groups > Users. 

All local users are displayed in the detailed window. 
3. Check that all local users have been created for process mode. 
4. In the tree view, select folder System > Local Users and Groups > Groups. 

All local groups are displayed in the detailed window. 
5. Select group "SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC". 
6. Select the menu command Action > Add Member.... 

The "SQLServer2005... Properties" dialog box opens. 
7. Click the "Add" button. 

The "Select Users, Computers or Groups" dialog box opens. 
8. Enter the members of the "SIMATIC HMI" user group as users of the 

"SQLServer2005MSSQLUser$<RECHNERNAME>$WINCC" group. 

More information 
● Online help WinCC Information System 
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4.7.4 How to set the language for a user (MUI) 

Introduction 
To work with PCS 7 optimally, we recommend that you make all the language settings to 
meet the needs for the specific system. 
In PCS 7 you can set the interface language to one of the following for the engineering 
system and for process mode (depending on the languages installed):  
● Chinese 
● German 
● English 
● French 
● Italian 
● Spanish 

Requirement 
An operating system with a multilanguage user interface is installed. 

 

 Note 
When installing the central archive server and StoragePlus, set the same language for the 
logged on user and the default user. 
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Procedure 
1. Select the menu command Start > Settings > Control Panel > Regional and Language 

Options. 
2. Select the "Regional Options" tab.  

Recommendation: Make these settings in accordance with your PCS 7 plant. 
3. Select the "Languages" tab. 
4. In the "Language used in menus and dialogs" area, select the desired language from the 

drop-down list box. 
 

  Note 
The drop-down list box only contains languages which are installed. 

5. If you want to use this language for the default user (all new users), perform the following 
steps: 
– Select the "Advanced" tab. 
– Recommendation: In the "Language for non-Unicode programs" area, select the 

language in which you want to install PCS 7 from the drop-down list box. 
– Recommendation: In the "Language for non-Unicode programs" area, select the 

language in which you want to install PCS 7 from the drop-down list box. 
– Recommendation: In the "Code page conversion tables" area, check the box for the 

language in which you want to install PCS 7. 
– In the "Default user account settings" area, check the "Apply all settings to the current 

user account and to the default user profile" box. 
– Restart the PC. 

 

  Note 
Once the central archive server and StoragePlus have been installed, you can change 
the language for the default user. 
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4.7.5 How to configure communication modules 

Introduction 
Below you will find information about how to select the communication modules you will use 
to configure the PC stations. 

Setting the network connection to the terminal bus 
 

 Note 
If you use a PC station as a single-station system with no connection to other PC stations, 
the following steps do not need to be taken. 

 
1. Select the PC station (My Computer) in the tree view of Windows Explorer. 
2. Select the "SIMATIC Shell" folder. 
3. Select Settings in the context menu. 

The "Select Terminal Bus" dialog box opens. 
4. In the "Network Adapters" group, select the communication module via which you want to 

communicate on the terminal bus. 
5. Click "OK". 

 

NOTICE  
 

If you confirm the dialog box that follows, the network connection to this PC station will 
be temporarily interrupted. 

6. Confirm the dialog box that follows. 
The network adapter is reinitialized. 

Selecting the redundancy interface 
If you want to establish a redundancy connection between two OS servers, you must select 
the connection path to the redundant partner in the "SIMATIC Shell" dialog box. The 
redundancy connection can be established via the "Serial Port" or a "Network adapter". 
1. Select the PC station (My Computer) in the tree view of Windows Explorer. 
2. Select the "SIMATIC Shell" folder. 
3. In the shortcut menu, select the menu command "Settings". 
4. The "Select Terminal Bus" dialog box opens. 
5. Select the PC station (My Computer) in the tree view of Windows Explorer. 
6. Select the "SIMATIC Shell" folder. 
7. In the shortcut menu, select the menu command Redundancy Settings .... 

The "Redundancy Settings" dialog box opens. 
8. In the "Optional connection to the redundant partner" area, select the connection path. 
9. Click "OK". 
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Configuring redundant network adapters 
1. Select the menu command Start > Settings > Network Connections.  

The "Network Connections" dialog box opens. 
2. Select the menu command Advanced > Advanced Settings. 

The "Advanced Settings" dialog box opens. 
3. Select the "Adapters and Bindings" tab. 
4. Check that the connection via which the PC station on the terminal bus is to communicate 

is at the top of the "Connections" list. If necessary, move this connection to the top. 
 

  Note 
If redundant network adapters are used, the shared TEAM connection must be at the top 
of the list. You will find more information on this topic in the documentation Process 
Control System PCS 7; Fault-Tolerant Process Control Systems. 

NOTICE  
 

Once new network adapters have been installed, the most recently entered connection 
appears at the top of the list.  
Ensure that the connection via which the PC station on the terminal bus communicates 
is at the top of the list. 

5. Click "OK". 
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4.7.6 How to configure the PC station in the configuration console 

Introduction 
You next check or assign the addresses on the plant bus and select the access point for 
downloading and configuring the PC stations. 
You perform the following steps: 
● PC stations on the plant bus 

Check or assign addresses of the network adapters: 
– PC station on plant bus connected via CP 1613 communications processor 
– PC station on plant bus connected via standard network adapter (only if the ISO 

protocol is used on the plant bus) 
● All PC stations: 

– Select the access point for each PC station 

Requirement 
The Configuration Console has been opened via the menu command Start > SIMATIC > 
SIMATIC NET > Configuration Console. 

PC station on plant bus connected via CP 1613 communications processor 
If the PC station on the plant bus is to communicate via the CP 1613 communications 
processor, perform the following steps for all CP 1613 processors: 

 

 Note 
If you have reinstalled the PCS 7 software on the PC station, the first two steps preceded by 
"Standard" are not required. 

 
1. "Standard": In the tree view, select "Modules > <Network Adapter for Communication with 

the Plant Bus> > General". 
2. "Standard": Set the operating mode to "PG mode" for every PC network module you want 

to configure. 
3. In the tree view, select "Modules > <Network Adapter for Communication with the Plant 

Bus> > Address". 
4. Set the addresses (either TCP/IP address or MAC address, depending on the protocol). 
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PC station on plant bus connected via standard network adapter 
If you want to use the ISO protocol on the plant bus, but you do not know the MAC 
addresses of the network adapters, perform the following steps for all standard network 
adapters: 
1. In the tree view, select "Modules > <Network Adapter for Communication with the Plant 

Bus> > Address". 
2. Make a note of the MAC address, which you will need when configuring the PC station. 

Selecting the access point for each PC station 
Perform the following steps on all PC stations: 
1. In the tree view, select the "Access Points" folder. 
2. In the list, select "S7ONLINE". 
3. Select the menu command File > Properties. 

The "S7ONLINE" dialog box opens. 
4. Select the "PC internal (local)" entry from the "Assigned interface parameters" drop-down 

list box. 
5. Click "OK". 
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4.7.7 How to make the settings for standard network adapters 

Procedure 
If you want to use the TCP/IP protocol on the plant bus, you will need to perform the 
following tasks for all standard network adapters on the plant bus: 
1. Select the menu command Start > Settings > Network Connections.  

The "Network Connections" dialog box opens. 
2. Select the plant bus in the "Network Connections" dialog box. 
3. Select the menu command File > Properties. 
4. Select "Internet Protocol (TCP/IP)" from the list. 
5. Click "Properties". 
6. Configure the TCP/IP address: 

Typical: "Use the following IP address:" check box 
– Enter the IP address. 
– Enter the subnet mask. 

7. Click "OK". 
The TCP/IP addresses are set. 

Settings when using two or more network adapters  
 

 Note 
Setting the order 
If several standard network adapters are used (e.g., 3COM), the adapter for the terminal bus 
must appear first (Network Properties: "Advanced > Advanced Settings"). Any non-
functioning network adapters which are inserted must be disabled. 
Following a PCS 7 installation, a dialog appears, where you must select the network adapter 
for the terminal bus. If an adapter is selected, confirm it with "OK" and then confirm the 
"Reinitialize" dialog with "Yes". 
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4.7.8 How to change the transmission rate and the mode in the PC network 

Introduction 
For communication in a network, make sure that the following parameters are set 
consistently for all network nodes: 
● Transmission rate 
● Operating mode 

 

  Note 
The factory settings for Siemens devices are set so that parameters for the transmission 
rate and operating mode are identified automatically (autonegotiation). 
This setting only needs to be changed if nodes which do not have access to the 
autonegotiation setting must be communicated with in the network. 

Automatic identification of the transmission rate and operating mode 
Autonegotiation refers to the automatic identification/negotiation of the transmission rate 
(10/100 Mbit/s) and the operating mode (full duplex/half duplex). 
● Full duplex is an operating mode with bidirectional data communication, where the 

communication partners can send data on the transmission link independently of one 
another. 

● Half duplex is an operating mode with bidirectional data communication, where only one 
communication partner can send data on the transmission link. 

Requirement 
The autonegotiation setting needs to be changed if nodes which do not have access to this 
setting must be communicated with in the network. 
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Parameterizing network nodes 
 

Location of 
use 

Network node Calling the 
parameterization dialog 
window 

Parameter setting 

PC CP 1613 communications 
processor 

1. Start > SIMATIC > 
SIMATIC NET > 
Configuration Console 

2. PC Station > Modules > 
Network Parameters 

Select duplex mode and 
transmission rate radio 
buttons 

PC INTEL network adapter (or 
other similar standard 
network adapter) setting 

1. Start > Settings > 
Control Panel > 
Administrative Tools > 
Computer Management 
> Device Manager > 
Network adapters 

2. Select network adapter. 
3. File > Properties 
4. "Advanced" tab 

Set values for the 
property. 
Typical property 
designation (depending 
on the network module 
used): 
• Link Speed & Duplex 

Mode 
• Link Speed & Duplex 

Switches SCALANCE X400 
SCALANCE X 300 
SCALANCE X200 
SCALANCE X 200IRT 
ESM 
OSM 

• Configuration via Telnet 
or Web Based 
Management (WBM) 

• Call the 
parameterization dialog 
box for the switch via 
Internet Explorer: 

http : \\<TCP/IP 
address> 

Port configuration 

AS CP 443-1 communications 
processor 

HW Config:  
CP 443-1 properties > 
"Options" tab > "Individual 
Network Settings" group 

In the "Transmission 
medium/Duplex" drop-
down list box (default 
setting: Automatic setting)

More information 
● Operating instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-200 
● Operating instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-300 
● Operating instructions SIMATIC NET; Industrial Ethernet Switches SCALANCE X-400 
● Configuration manual SIMATIC NET; Industrial Ethernet Switches; SCALANCE X-300; 

SCALANCE X-400 
● Manual SIMATIC NET; Industrial Ethernet OSM/ESM 
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4.7.9 Installing security patches, hotfixes, service packs 

Introduction 
Security patches, hotfixes, and service packs are software packages, which serve to 
eliminate security vulnerabilities, unwanted software properties, and similar.  
Information is provided with the software package explaining the properties that need to be 
changed and the requirements for its installation. 

 

 Note 
You will find information on the software version for the current PCS 7 version in the 
pcs7-readme file. 

 

Microsoft security patches 
Siemens tests the compatibility of Microsoft security patches for the Microsoft operating 
system, the SQL server and Internet Explorer. You will find information on security patches 
for PCS 7 online from SIMATIC Customer Support under the entry ID: 18490004 
(http://support.automation.siemens.com/WW/view/en/18490004). 

More information 
● Section "How to install operating system service packs (Page 68)" 

http://support.automation.siemens.com/WW/view/en/18490004
http://support.automation.siemens.com/WW/view/en/18490004
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4.7.10 How to retro-activate the security settings for PCS 7 

Introduction 
Perform the following tasks if you want to activate the security settings. 

 

NOTICE  
When the PCS 7 system is operated in a domain, the security settings must be coordinated 
over the entire domain. Coordinate the security settings with the administrator responsible. 

 

Requirement 
You are logged on to the PC station as an administrator. 

Procedure 
If you want to make the settings required for PCS 7 on a PC at a later point in time, perform 
the following steps: 
1. Select the menu command Start > SIMATIC > SIMATIC Security Control > All Settings. 

The "SIMATIC Security Control" dialog box opens. 
2. Read the information in the lower section of the "SIMATIC Security Control" dialog box 

and select the appropriate button. 
– "Save" button 

The settings are not applied. The settings that can be applied to PCS 7 are saved in 
an XML file. 

– "Print" button 
The settings are not applied. The settings that can be applied to PCS 7 are sent to the 
printer. 

– "Apply" button 
The settings are applied. 

– "Close" button 
The settings are not applied. 

Activating the firewall 
The status of the Windows firewall remains unchanged in this case. 



Installing PC stations  
4.7 Preparing PC stations 

 PC Configuration and Authorization 
146 Operating Manual, 09/2007, A5E00783465-02 

4.7.11 How to change the settings of the Windows firewall for Open PCS 7 

Introduction 
The following settings are only required if PC stations that communicate with the PCS 7 plant 
via Open PCS 7 are located outside the local network (subnet) of the PCS 7 plant. 

Procedure 
1. Select the menu command Start > Settings > Control Panel > Windows-Firewall. 

The "Windows-Firewall" dialog box opens. 
2. Select the "Exceptions" tab. 
3. Activate the following check boxes in the "Programs and Services" list: 

– For a connection via OPC: "CCEServer" check box 
– For a connection via OLE DB: "SQL Server 2005" check box 

4. Click "Edit". 
The "Edit Program" dialog box opens. 

5. Click "Change Area". 
The "Change Area" dialog box opens. 

6. Enable the "User-defined list" check box. 
7. Enter the subnets with which the PC stations communicate in the input box. 
8. Click "OK" in the dialog boxes until the "Windows Firewall" dialog box closes. 
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4.7.12 How to activate redundancy for fault-tolerant PCs 
Additional steps are required to configure redundant stations. 
● You must establish a connection via a redundant cable for redundant PC stations. The 

redundant stations are the PC stations of a pair (server and single station systems). 
● With a server-client architecture, you will need to assign the clients to the servers. 

Redundant cable for PC stations 
The following redundancy connection options exist: 
● Network cable (cross-over cable) to an additional Ethernet network adapter 
● For OS servers: Null modem cable to the COM interface 

Additional steps for servers and single station systems (OS, BATCH) 
Configure redundant pairs: 
1. Connect the PCs with a redundant cable. 
2. Follow the instructions in the function manual Process Control System PCS 7; Fault-

Tolerant Process Control Systems. 

Additional steps for clients (OS, BATCH) 
Connect the clients with the redundant servers: 
1. Follow the instructions in the function manual Process Control System PCS 7; Fault-

Tolerant Process Control Systems. 

Additional steps for SIMATIC Route Control 
1. Follow the corresponding instructions contained in the manual Process Control System 

PCS 7; SIMATIC Route Control. 
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4.7.13 Downloading the network configuration to the PC stations 

Introduction 
To allow you to configure, download and test all automation systems and PC stations (OS, 
BATCH, RCS) of a PCS 7 project from a central engineering station (ES), make the following 
network settings and download the configuration to all PC stations. 

Additional information 
The required steps are described in the configuration manual Process Control System 
SIMATIC PCS 7; Engineering System. 
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4.8 Notes on add-ons and utilities 

4.8.1 Overview of add-on programs and utilities for PCS 7 

Introduction 
This section provides you with information on add-ons and utilities for PCS 7.  

Overview 
● Add-ons: 

– Remote diagnostics functions (Page 150) 
– Virus scanners (Page 153) 
– Burner software (Page 153) 
– DiagMonitor (Page 154) 

● Utilities: 
– Screen savers (Page 157) 
– Defragmentation programs (Page 158) 
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4.8.2 Remote diagnostics functions 

Options for remote diagnostics and remote administration of a PCS 7 plant 
We recommend that you use the "NetMeeting" operating system function for the remote 
diagnosis of PCS 7 plants and administrative access to PC stations with 
Windows XP Professional and Windows Server 2003. 

 
 

Transmission paths 
Data can be transmitted on the following paths: 
● Telephone line (modem) 
● TCP/IP connection (plant-internal network connection) 

Security requirements 
If you want to perform remote diagnostics on a PCS 7 plant, you must protect that plant 
against unauthorized access.  
Several steps have to be taken in order to implement a security concept. Only when taken 
together as a whole will these security measures offer the plant optimum protection.  
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Enabling NetMeeting with an active firewall 
If the Windows firewall has been activated, you must set up exceptions for when you use 
NetMeeting. 
1. Select the menu command Start > Settings > Control Panel> Windows Firewall. 

The "Windows Firewall" dialog box opens. 
2. Select the "Exceptions" tab. 
3. Check the "Remote Desktop" box. 
4. Click "Add Program...". 

The "Add a Program" dialog box opens. 
5. Click "Browse".  

In the "Browse" dialog box, select the "C:\Program Files\NetMeeting" folder. 
6. Select the "conf.exe" file. 
7. Click "Open". Click "OK".  

The "NetMeeting" program is added to the "Programs and Services" list. The 
"NetMeeting" box is checked. 

8. Click "OK".  
Select "NetMeeting" in the "Programs and Services" list. 

9. Click "Edit". 
The "Edit a Program" dialog box opens. 

10. Click "Change scope...". Make your plant-specific setting.  
Recommended: Custom list (enter the addresses of the authorized computers) 

11. Click "OK". 
12. Click "OK". 

The "Windows Firewall" dialog box opens. The "Exceptions" tab is selected. 
13. Click "Add Program...". 

The "Add a Program" dialog box opens. 
14. Click "Browse". 
15. Select file "mnmsrvc.exe" in the operating system's system folder. 

In the case of a standard installation, you will find this file in "C:\Windows\System32". 
16. Click "Open". Click "OK".  

File "mnmsrvc.exe" is added to the "Programs and Services" list. The "mnmsrvc.exe" box 
is checked. 

17. Click "OK". 
18. Click "Edit". 

The "Edit a Program" dialog box opens. 
19. Click "Change scope...". Make your plant-specific setting.  

Recommended: Custom list (enter the addresses of the authorized computers) 
20. Click "OK". 
21. Click "OK".  

The "Windows Firewall" dialog box opens. 
22. Click "OK". 

The settings are applied. 



Installing PC stations  
4.8 Notes on add-ons and utilities 

 PC Configuration and Authorization 
152 Operating Manual, 09/2007, A5E00783465-02 

More information 
● Manual Process Control System PCS 7; Security Concept PCS 7; Recommendations and 

Notes 
● Operating system online help 
● Internet: http://support.microsoft.com/kb/878451/en-us  

http://support.microsoft.com/kb/878451/en
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4.8.3 Virus scanners 

Virus scanners 
Virus scanners approved for PCS 7 can be installed later. 
The following virus scanners are approved for PCS 7: 
● Symantec AntiVirus Corporate Edition 
● McAfee VirusScan Enterprise 
● Trend Micro OfficeScan Corporate Edition 

 

  Note 
You will find information on the software version for the current PCS 7 version in the 
pcs7-readme file. 

Virus protection 
 

NOTICE  
Only copy scanned data to a PC station. 

 

More information 
Function manual Process Control System PCS 7; Notes and Recommendations for 
Configuring Virus Scanners 

4.8.4 Burner software 

Introduction 
In the interests of maintaining performance levels, data archiving devices must not be used 
on PC stations in process mode. We recommend that you only use data archiving devices 
(e.g., CD/DVD burners) on the engineering station. 

Bundle PC 
If you have purchased an engineering station as part of a bundle, that bundle will include 
burner software. This burner software can be installed after the main installation. 
During installation, follow the instructions of the burner software manufacturer. 
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4.8.5 DiagMonitor 

Introduction 
The DiagMonitor software is used for early detection and reporting of hardware and 
temperature problems on the SIMATIC PC. Messages can appear via: 
● Ethernet (SNMP) 
● Internet/telephone 

– E-mail 
– SMS 

● OPC (forwarded to the SIMATIC software applications) 
● Web browser 
The DiagMonitor software monitors, reports, alarms and visualized application-specific 
operating states on SIMATIC PCs. 

Hardware requirements 
Only SIMATIC PCs can be used as monitored computers: 
● SIMATIC Box PC 620 
● SIMATIC Box PC 620 V2 
● SIMATIC Box PC 627 
● SIMATIC Box PC 627 B 
● SIMATIC Box PC 840 
● SIMATIC Box PC 840 V2 
● SIMATIC Microbox PC 420 
● SIMATIC Panel PC IL 70 
● SIMATIC Panel PC IL 77 
● SIMATIC Panel PC 477 
● SIMATIC Panel PC 670 
● SIMATIC Panel PC 677 
● SIMATIC Panel PC 870 
● SIMATIC Panel PC 877 
● SIMATIC Rack PC 547B 
● SIMATIC Rack PC 627 B 
● SIMATIC Rack PC 840 
● SIMATIC Rack PC 840 V2 
● SIMATIC Rack PC IL 40 S 
● SIMATIC Rack PC IL 40 S V2 
● SIMATIC Rack PC IL 43 
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Software requirements 
The DiagMonitor software can be used with the following operating systems: 
● Microsoft Windows XP 
● Microsoft Windows Server 2003 
● Microsoft Windows XP Embedded (SIMATIC PC BOX) 

Restrictions 
 

 Note 
Remote monitoring is only possible with the TCP/IP Internet protocol since the required 
SNMP protocol is available in this protocol family. 

 

Installing the DiagMonitor software 
1. Insert the PCS 7 Toolset DVD in the DVD drive. 
2. In the Windows Explorer, open the folder Additional_Products > DiagMonitor. 
3. Run file Setup.exe. 
4. Select the language in which the installation is to be performed. 
5. Click "OK".  

The "SIMATIC PC DiagMonitor Setup" dialog box opens. 
6. Follow the on-screen instructions. 

If you do not want to install the DiagMonitor software in the specified target folder, you 
can change it by clicking "Browse". 
 
Three installation options are available in the "Setup Type" window: 
– Custom  

With the Custom installation, only the components you select during setup will be 
installed. 

– Development 
With the Development installation, only the components which enable the user to 
develop monitoring applications will be installed. 

– Full  
With the Full installation, all components will be installed. This includes the 
components of the Custom and Development setups. 



Installing PC stations  
4.8 Notes on add-ons and utilities 

 PC Configuration and Authorization 
156 Operating Manual, 09/2007, A5E00783465-02 

7. Select "Custom" and click "Next". 
 

  Note 
Siemens industrial PCs support DiagMonitor software. 

8. Click "Next". 
The "Question" dialog box opens. 

9. If you want to configure the SMS service, answer this question with "Yes" and select your 
service provider. 
You will find more information on this topic in the section "Configuring SMS services". 

10. Click "Exit".  
You must restart Windows/your computer before you can use the program. 

Configuring SMS services 
1. Select the menu command My Computer > Manage > Services and Applications > 

Services. 
2. Select "SNMP service" or "SNMP". 
3. In the shortcut menu, select the menu command Action > Properties. 
4. Select the "Security" tab. 
5. Select one of the following options: 

"Accept SNMP packages" option activated by every host 
– No other settings are required. 
"Accept SNMP packages" option activated by this host 
– The local address or the local computer name and the address of the maintenance 

station (both addresses for a redundant MS server) must be entered for the station 
being monitored. 

– The local address or the local computer name must be entered for the maintenance 
server. 

6. Enter the name with read/write access used in the configuration under "Accepted 
community names". 
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Configuring DiagMonitor 
 

 Note 
The diagnostic monitor's "Management Station" configuration tool can only be started by a 
user with administrator rights. Perform the configuration on all monitored stations. 

 
1. Select the menu command Start > SIMATIC > PC DiagMonitor > Management Station. 

The "SIMATIC PC DiagMonitor" dialog box opens. 
2. Select the menu command Station > Add. 
3. Make the following settings: 

Select "Local station" or check the "Allow access to all stations" box, or click "Add" and 
enter the "Name or IP address" of individual PC stations (e.g., of the maintenance 
server). 
– If desired, configure the necessary events, e.g., cyclic operating hours alarms 

(optional setting). 
– If you want to stop the "SIMATIC PC DiagMonitor" Management Station from 

automatically starting up each time someone logs on, delete the "Management 
Station" entry under Start > Programs > Autostart. 

4.8.6 Screen savers 

Using a screen saver 
It is not recommended to use a screen saver on the PC with PCS 7 for the following reasons: 
● The screen saver takes CPU time and can lead to a system overload. 
● The screen saver continuously reduces the usable RAM. It is known that some screen 

savers do not release the memory area they use. 
If you use a screen saver, you should disable it when running PCS 7. 
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4.8.7 Defragmentation programs 

Using defragmenters 
Defragmentation programs are used to optimize the time it takes to access a hard disk.  

 

NOTICE  
Defragmentation programs that move fixed blocks on a hard disk can destroy license key 
files and the files required for the authorization of software packages.  
Recommendation:  
Always exclude authorizations/license keys from the defragmentation. 

 

Excluding authorizations/license keys from processing 
You have the following options to exclude authorizations/license keys from optimization 
procedures: 
● Transfer all authorizations/license keys to an authorization diskette / license key diskette. 
● Transfer all authorizations/license keys to a partition that will not be defragmented 

(a backup partition, for example). 
●  
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Appendix 5
5.1 Appendix A - Use of software packages 

5.1.1 Software packages for basic engineering 

Brief description of the basic engineering applications 
The following applications for basic engineering are installed by the PCS 7 system setup 
from the PCS 7 Toolset DVD. License keys are required for use. 
You will find more information on this topic in the section "Licensing and authorizing the 
PCS 7 software (Page 112)". 

 
Applications Brief description 
Automation License 
Manager 

For transferring and managing license keys  

STEP 7 PCS 7 basic engineering: 
• SIMATIC Manager for managing project objects 
• HW Config for the hardware configuration 
• NetPro for the network configuration 

SCL Structured Control Language (S7 SCL)  
High-level language for programming user function blocks in accordance with 
IEC 61131-3 

CFC Continuous Function Chart (CFC) - For the graphical configuration of 
continuous automation functions in accordance with IEC 61131-3, 
with test and commissioning functions 

SFC Sequential Function Chart (SFC) - For the graphical configuration of 
sequential production sequences (step sequencers), with test and 
commissioning functions 

PH Plant Hierarchy (PH) - For displaying a project in a plant view; which enables 
the user to gain a quick overview of project resources 

IEAPO • Process Object view (PO) - For providing a process-control oriented view 
of basic automation data 

• Import Export Assistant (IEA) 
You will find more information on this topic in the section "Optional 
software packages (Page 164)" 

PCS 7 Library Standardized process-control libraries with preconfigured and tested blocks 
and drivers for hardware (e.g., blocks for I/O modules) 
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Applications Brief description 
WinCC Visualization and configuration software containing standards for the fast 

implementation of simple to complex visualization tasks in single or multiple 
station operation  

AS-OS Engineering AS/OS connection for faceplates, messages, and tags 
PV InsInfo-Server  Tool which supplies the WinCC variable browser with ES variables  
SIMATIC NET PC 
Software 

Software components for configuring and identifying network adapters 
installed in the PC 

BATCH Engineering Components for BATCH Engineering: 
BATCH Base, BATCH Builder, BATCH Blocks, BATCH WinCC Client Options, 
BATCH WinCC Server Options, BATCH Getting Started 
You will find more information on this topic in the section "Software packages 
for SIMATIC BATCH (Page 162)".  

Route Control 
Engineering 

Components for Route Control Engineering: 
Route Control Base, Route Control Engineering, Route Control Library, Route 
Control Faceplates 
You will find more information on this topic in the section "Software packages 
for SIMATIC Route Control (Page 163)".  

PDM Components for engineering field devices 
You will find more information on this topic in the section "Optional software 
packages (Page 164)".  
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5.1.2 Software packages for operator stations 

Brief description of the operator station applications 
The following applications for operator stations are installed from the PCS 7 system setup on 
the PCS 7 Toolset DVD. License keys are required for use.  
For more information please refer to the section "Licensing and authorization of the PCS 7 
software (Page 112)". 

 
Program name Brief description 
Automation License 
Manager 

For transferring and managing license keys.  

WinCC Visualization and configuration software for visualization in single station or 
multiple station mode. 
Scope of the license keys 
You will find information on this topic in the section "Selecting the correct 
license keys/authorizations (Page 117)". 

SFC Visualization Allows you to display and operate sequential control systems. 
PCS 7 Faceplates Contains standardized libraries with tested, ready-to-use blocks (connection to 

AS and faceplates) 
SIMATIC NET PC 
software 

You can configure and detect the network adapters installed in the PC using 
the provided software components 
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5.1.3 Software packages for SIMATIC BATCH 

Brief description of SIMATIC BATCH applications 
The following applications for SIMATIC BATCH are installed from the PCS 7 system setup 
on the PCS 7 Toolset DVD. License keys are required for use. 
For more information please refer to the section "Licensing and authorization of the PCS 7 
software (Page 112)". 

 
Program name Brief description 
Automation License 
Manager 

For transferring and managing license keys.  

BATCH Base Basis for all BATCH installations 
Includes the installation of the client database 
You require a license key for BATCH API to interface with a factory or 
enterprise-wide information system. 

BATCH Builder Software package installed on the PCS 7 ES for creation and configuration of 
BATCH project data 
• OM 
• Builder 

BATCH Fastobjects For installation of a database server. 
• POET Server 
• BATCH DBMON 

BATCH Client  • BCC - the Batch Control Center (Batch CC) is the central component in 
SIMATIC BATCH for batch planning and control. Batch CC manages all 
data relating to SIMATIC BATCH. You can therefore log all data in Batch 
CC. 

• The BATCH Recipe Editor is suitable for simple graphic creation and 
management of any number of recipes. 

• BATCH REPORT - The user-friendly print function of BATCH 
BATCH Server • BCS - Sequential control system of BATCH and allocation of units 

• CDV (BDM) - Batch Data Management collects, stores, logs, and exports 
batch data. 

• Scope of the license keys 
You will find information on this topic in the section "Selecting the correct 
license keys/authorizations (Page 117)". 

BATCH Blocks BATCH interface blocks 
BATCH WinCC 
Client Options 

Faceplates for the PCS 7 OS 

BATCH WinCC 
Server Options 

Faceplates for the PCS 7 OS 

BATCH Getting 
Started 

Sample project for SIMATIC BATCH 
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5.1.4 Software packages for SIMATIC Route Control 

Brief description of the applications for SIMATIC Route Control 
The following applications for SIMATIC Route Control are installed during the PCS 7 setup 
from the Toolset DVD. License keys are required for use.  
For more information please refer to the section "Licensing and authorization of the PCS 7 
software (Page 112)". 

 
Program name Brief description 
Automation License 
Manager 

For transferring and managing license keys. 

Route Control Base Basis for all route control installations 
Contains the documentation for SIMATIC Route Control 

Route control client For detailed diagnostics of the route and its elements 
Route Control 
Engineering 

For creating and administrating any number of partial routes with elements 

Route Control Server  For route searching and as an interface between Route Control Center 
and/or PCS 7 OS and the automation systems 
Scope of the license keys 
You will find information on this topic in the section "Selecting the correct 
license keys/authorizations (Page 117)". 

Route Control Library Contains interface blocks for the interconnection between user and other 
process blocks 
and faceplates for operator control and monitoring of routes on the Route 
Control client 

Route Control Faceplate Faceplates for the OS of PCS 7 
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5.1.5 Optional software packages 

Introduction 
The following applications can be used for engineering special applications. You will need 
additional license keys. 
For more information please refer to the section "Licensing and authorization of the PCS 7 
software (Page 112)". 

Add-ons in the PCS 7 setup 
You can install these programs directly in the PCS 7 system setup. 

 
Applications Brief description 
IEAPO Import-Export-Assistant (IEA) - tool for fast basic engineering (e.g., importing 

models and process tags) 
Note: IEA license required 

PLC simulation CPU simulation 
SFC Visualization This option allows you to display and control sequential control systems.  
VXM (Version 
Cross Manager) 

Compares engineering data versions with graphic display of differences 

PCS 7 PID Tuner Optimizes closed-loop control loops  
DOCPRO This allows you to create plant documentation and wiring manuals 
Open PCS 7 OPC interface as the basis for enterprise-wide data communication 
PCS 7 Faceplates Faceplates for the operator station 
DotNet Framework  
SIMATIC Logon • Assignment of roles defined for the PCS 7 applications to Windows 

users/user groups with corresponding administrator rights 
• Activation of user dialogs for applications managed with SIMATIC Logon 
• Sharing and logging of functions 

SIMATIC PDM Configuration, parameter assignment, commissioning, and diagnostics of 
intelligent process devices. SIMATIC PDM allows a wide variety of process 
devices to be configured using a uniform user interface. 

Remote Publisher  
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Add-ons on separate installation media 
These applications are not included on the PCS 7 Toolset DVD. 

 
Applications Brief description 
S7 F Systems Used to configure fail-safe functions of a SIMATIC S7-400F/SIMATIC S7-400FH 

- automatically adds functions for fault-detection and fault reaction to CFC 
charts created by the user and provides support functions, e.g., for comparison 
or acceptance tests for F programs. 

Additional information  
You will find more information on the software packages and their areas of application in the 
product brief Process Control System SIMATIC PCS 7 or the catalog ST PCS 7. 
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5.2 Appendix B - Licensing of software packages 

5.2.1 Software packages and required license key 

Introduction 
 

 Note 
In this section, we only use the term license key even when an older authorization is used for a product. 

 

Software packages and required license keys 
The table below shows which license keys you require for each software package. 
  

 

 Note 
The "Version" column is empty so that you can enter the correct data for your plant documentation. The versions for the current 
Process Control System; PCS 7 Toolset V7.0 program package can be found in the pcs7-readme file. 
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Product name Version License System 
setup 

Engineering 
station 

Single station or 
client  
for OS, BATCH 
or Route Control 

All servers for 
OS, Web, 
SIMATIC 
BATCH or Route 
Control 
redundant and 
non-redundant 

Remark 
X = installation required 
(X) = installation optional 

Operating systems Outside the scope of PCS 7 
MS Windows XP 
Professional 

 Microsoft license No X X  With product bundles the product is 
preinstalled and available on the 
Recovery DVD. 

Windows Server 2003 
(server operating system) 

 Windows Server 2003 
(connection licenses, 5 or 10 
as standard) 

No For 
multiproject 
engineering 

 X With product bundles the product is 
preinstalled and available on the 
Recovery DVD. 

Operating system service 
pack  

  No X X X With product bundles the product is 
preinstalled and available on the 
Recovery DVD. 

Note on installing a server - Ensure that you have a sufficient number of licenses available. 
 
Product name Version License System 

setup 
Engineering 
station  

Single station or 
client  
for OS, BATCH 
or Route Control 

All servers for 
OS, Web, 
SIMATIC 
BATCH or Route 
Control 
redundant and 
non-redundant 

Remark 
X = installation required 
(X) = installation optional 

Other  
MS SQL Server 2005   No X X X  
Internet Explorer   No X X X Supplementary CD for OPC (V6.1)  
Adobe Acrobat Reader   Yes X (X) (X)  
PKZIP for Windows   No X (X) (X)  
Automation License Manager   Yes X X X  
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 ES package OS package Remark 
Product name Version License key System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the correct license keys/authorizations 
(Page 117)" 

PCS 7 ES 
Runtime License AS  AS RT PO   (z) (z)    Scope: Limited to the number of process 

objects that can be loaded into the AS. 
STEP 7  STEP 7 Yes X X    H systems are integrated. 
  SIK/SIMATIC 

H Systems 
Vx.y 

 (X) (X)    For H systems: (X) product is always installed 
if STEP 7 is installed. 

CFC  CFC (z) Yes (z) (z)    Configuration limited to the number of process 
objects (PO = operator-controllable function 
block with attribute S7_m_c). 

SFC  SFC  Yes X X     
SCL  S7 SCL  Yes X X     
PH  PH PO Yes X X     
IEAPO  IEA Yes X X    License key only required to use the IEA 

option. 
AS-OS Engineering   Yes (X) (X)    (X) Product is always installed if STEP 7 and 

WinCC are installed. 
PV InsInfo-Server   Yes (X) (X)     
SFC Visualization  SFC 

Visualization  
Yes (X) (X) (X) (X) (X) (X) Product is always installed if WinCC is 

installed. 
DOCPRO  SIK/SIMATIC 

DOCPRO  
Yes (X) (X)     

Version Cross Manager  Version Cross 
Manager 

Yes (X) (X)     

S7 PLC Simulation  PLCSIM  Yes (X) (X)     
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 ES package OS package Remark 
Product name Version License key System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the correct license keys/authorizations 
(Page 117)" 

PCS 7 Library 7.0   Yes X X     
PCS 7 Faceplates   Yes X X X X X  
PCS 7 PID Tuner  SIK/SIMATIC 

PID Tuner  
Yes (X) (X)     

Version Trail   Yes X X     
SIMATIC BATCH 
Engineering 

  Yes (X) (X)    (X) Product only required for SIMATIC 
BATCH. 

Route Control Engineering  Route Control 
Engineering 

Yes (X) (X)    (X) Product only required for SIMATIC Route 
Control. 

Maintenance ES  Maintenance 
ES 

Yes (X) (X)    (X) Product only required for the maintenance 
station. 

 
 



Appendix  
5.2 Appendix B - Licensing of software packages 

 PC Configuration and Authorization 
170 Operating Manual, 09/2007, A5E00783465-02 

 ES package OS package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 

Optional packages for all PCS 7 PCs 
SIMATIC Logon Service Yes (X) (X) (X) (X) (X) (X) All stations which use applications 

managed by SIMATIC Logon Service require 
the SIMATIC Logon Service. 

SIMATIC Security Control 

 Logon Service 

Yes (X) (X) (X) (X) (X) (X) Activate security settings for PC stations. 
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 ES package OS package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 

PCS 7 - AS 
BCE  Yes X X X X  License only for a standard Ethernet interface 

module (not required for SIMATIC NET CP 
1613) 

Industrial 
Ethernet Softnet 
S7 Basic 

       

Industrial 
Ethernet Softnet 
S7 Power Pack 

       

Industrial 
Ethernet 
S7 1613 

       

Industrial 
Ethernet S7 
REDCONNECT 

       

SNMP OPC 
Server Basic 

       

SIMATIC NET PC SW  

SNMP OPC 
Server Power 
Pack 

       

S7 F Systems  SIK/SIMATIC S7 
F Systems 
V(x.x) 

No (X) (X)    Product is supplied on a separate CD. 
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 ES package OS package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 

SIMATIC PDM 
PDM BASIC – 
(up to 4 TAGs) 
The following 
TAG licenses 
are also 
available as 
options: 
- PDM ("*z")  
 
*z = 128, 512, 
1024, 2048, 
unlimited  
Number of 
TAGs 
(devices) 

Yes X X    SIMATIC PDM Basic Software V6.0 includes 
the following licenses:  
• Communication via HART modem 
• Communication via RS232 
• Communication via PROFIBUS DP/PA, 4 

TAGs 
You will find more information in the 
documentation relating to SIMATIC PDM. 

PDM 
Integration in 
STEP7 

Yes (X) (X)    This is only required if PDM is to be integrated 
in HW Config. 

PDM Routing Yes (X) (X)    Routing via S7-4xx 

SIMATIC PDM Basic 
Software  

 

PDM Hart Mux Yes (X) (X)    Communication via standard HART 
multiplexer 

 
 



 Appendix 
 5.2 Appendix B - Licensing of software packages 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 173 

 ES package OS package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the right license keys/authorizations 
(Page 117)" 

Operator station 
WinCC RC 
(z)/WinCC RT (z)
WinCC Archive 
(z) 

Yes (z) (z) (z) (z) (z) Only WinCC RT PO Client for OS client 

WinCC Server Yes (X)   X   
WinCC 
Redundancy 

Yes    (X)  Only required for redundancy 

Basic System  

WinCC User 
Archives 

Yes  (X) (X) (X) (X)  

WinCC Advanced 
Process Ctrl 

Yes X X X X X  

WinCC 

LTO  

Chip Card Yes  (X) (X) (X) (X) WinCC chip card reader required (only 
active in process mode) 

Drivers (Multi VGA)   No (X) (X) (X) (X) (X) Suitable graphics card drivers for the version 
(see readme.wri) 

PCS 7 Faceplates   Yes X X X X X Automatically installed with WinCC 
OPC   Yes X X X X X Automatically installed with WinCC 

BCE  Yes X X X X  License only for a standard Ethernet interface 
module (not required for SIMATIC NET CP 
1613) 

SIMATIC NET BCE  

S7 
REDCONNECT 

 X X X X  Only required for connecting to redundant AS 
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 ES package OS package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
OS  
single 
station 

OS server OS client X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the right license keys/authorizations 
(Page 117)" 

WinCC Connectivity 
Station 

 WinCC 
Connectivity 
Station 

       

Web Server   WinCC 
WebNavigator (z) 

Yes   (z)  (z) Note: Server operating system required 
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 OS package Remark 
Product name Version License keys System 

setup 
OS server for BATCH OS client for BATCH X = installation required 

(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the correct license keys/authorizations 
(Page 117)" 

Operator station for BATCH 
WinCC RC 
(z)/WinCC RT 
(z) 
WinCC Archive 
(z) 

Yes (z) (z) Only WinCC RT PO Client for OS client 

WinCC Server Yes (X) X  
WinCC 
Redundancy 

Yes  (X) Only required for redundancy 

Basic System  

WinCC User 
Archives 

Yes (X) (X)  

WinCC 
Advanced 
Process Ctrl 

Yes X X  

WinCC 

LTO  

Chip Card Yes (X) (X)  WinCC chip card reader required (only 
active in process mode) 

SFC Visualization   Yes X X  
PCS 7 Faceplates   Yes X X Automatically installed with WinCC 
SIMATIC NET  BCE  Yes X  License only for a standard Ethernet interface 

module (not required for CP 1613) 
BATCH WinCC Client 
Options 

  Yes X X  

BATCH WinCC Server 
Options 

  Yes X   
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Product name Version License keys System 

setup 
Central archive server Redundant central archive 

server 
Remark 
X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the right license keys/authorizations 
(Page 117)" 

Central archive server 
WinCC RT 
(128) 
WinCC Archive 
(z) 

Yes (z) (z) Only WinCC RT PO Client for OS client 

WinCC Server Yes (X) (X)  
WinCC 
Redundancy 

Yes  (X)  

Basic System  

WinCC User 
Archives 

Yes (X) (X)  

WinCC 
Advanced 
Process Ctrl 

Yes X X  

WinCC 

LTO  

Chip Card Yes (X) (X) WinCC chip card reader required (only 
active in process mode) 

StoragePlus  StoragePlus  Yes X X X 
Batch Report   Yes X X X 
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Product name Version License keys System 
setup 

Open PCS 7 station OS client with Open PCS 7 Remark 
X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the right license keys/authorizations 
(Page 117)" 

Open PCS 7 
Open PCS 7  OpenPCS 7 

Station 
 X X  

WinCC RC 
(z)/WinCC RT 
(z) 
WinCC Archive 
(z) 

Yes  (z) Only WinCC RT PO Client for OS client 

WinCC Server Yes  X  
WinCC 
Redundancy 

Yes  (X) Only required for redundancy 

Basic System  

WinCC User 
Archives 

Yes  (X)  

WinCC 
Advanced 
Process Ctrl 

Yes  X  

WinCC 

LTO  

Chip Card Yes  (X)  WinCC chip card reader required (only 
active in process mode) 

SFC Visualization   Yes  X  
PCS 7 Faceplates   Yes  X Automatically installed with WinCC 

 
 



Appendix  
5.2 Appendix B - Licensing of software packages 

 PC Configuration and Authorization 
178 Operating Manual, 09/2007, A5E00783465-02 

Product name Version License keys System 
setup 

ES BATCH 
single 
station 

BATCH 
server, 
redundant 
BATCH 
server 

BATCH 
client 

BATCH 
Engineering 

Remark 
X = installation required 
(X) = installation optional 
(z) Level of license keys - 
Section "Selecting the right 
license keys/authorizations 
(Page 117)" 

SIMATIC BATCH 
BATCH Base   Yes X X X X X Basic installation for all  

SIMATIC BATCH PCs 
BATCH Builder   Yes X    X  
BATCH Blocks   Yes X    X  
BATCH Server  BATCH (z) 

UNITs  
Yes  (z) (z)    

BATCH API  BATCH API   X X    
BATCH Fastobjects     X X   License  
BATCH Separation 
Procedures/Formulas 

 BATCH 
Formula 

  X X    

BATCH Hierarchical 
Recipe 

 BATCH 
Hierarchical 
Recipe 

  X X    

BATCH ROP Library V7.0  BATCH Library   X X    
BATCH Client - BCC  BATCH 

BatchCC 
Yes    X  And/or BATCH Recipe System 

BATCH Client - RZE  BATCH Recipe 
System 

Yes    X  And/or BATCH Control 

BATCH Client - Report       X   
BATCH Planning  BATCH 

Planning 
    X   

Getting Started   Yes    X   
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 ES package Route Control package Remark 
Product name Version License keys System 

setup 
ES Single 

station 
Route 
Control 
single 
station 

Route 
Control 
server 

Route 
Control 
client 

Route Control 
Engineering 

X = installation required 
(X) = installation optional 
(z) Level of license keys - 
Section "Selecting the right 
license keys/authorizations 
(Page 117)" 

SIMATIC ROUTE Control 
Route Control Base    Yes X X X X X X  
Route Control Engineering  Route Control 

Engineering  
Yes X X    X Wizard in context of SIMATIC 

Manager, library blocks, 
engineering tool 

Route Control Server   Route Control 
Server (z) 

Yes  (z) (z) (z)   (also redundant) 

Route Control Client  Route Control 
Center  

Yes  X X  X   

Route Control Library   Yes X X X   X  
Route Control Faceplate   Yes X X X  X X  

 
 Maintenance station Remark 
Product name Version License keys System 

setup 
ES Single 

station 
MS server Redundant 

MS server 
X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting 
the right license keys/authorizations 
(Page 117)" 

Maintenance station 
Maintenance Station  Maintenance RT (z) Yes  (z) (z) (z)  
Maintenance Station 
Engineering 

 Maintenance ES Yes X X    
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 SIMATIC PCS 7 BOX 416 SIMATIC PCS 7 BOX RTX Remark 
Product name Version License keys System 

setup 
With 
AS 
OS 
ES 

With 
AS 
OS 

With 
AS 
OS 
ES 

With 
AS 
OS 

X = installation required 
(X) = installation optional 
(z) Level of license keys - Section "Selecting the 
right license keys/authorizations (Page 117)" 

SIMATIC PCS 7 BOX 
WinAC for SIMATIC S7 
Slot CPU 416-2 PCI 

 WinAC for 
SIMATIC S7 Slot 
CPU 416-2 PCI 

No X X    

WinLC RTX  WinLC RTX No   X X  
Software on the PCS 7 
Toolset DVD 
(ES installation) 

  Yes (z)  (z)   

Software on the PCS 7 
Toolset DVD 
(OS installation) 

 WinCC RC 
(z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z) (z) (z)  

Software on the PCS 7 
Toolset DVD 
(SIMATIC PDM) 

  Yes (z)  (z)   

Software on the PCS 7 
Toolset DVD 
(SIMATIC BATCH) 

 BATCH (z) UNITs Yes (z) (z)    

Maintenance Station  Maintenance RT 
(z) 

Yes (z) (z) (z) (z)  
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Compete systems (product bundles) 
 

 Note 
The product is preinstalled with product bundles and available on the Recovery DVD. 

 

Required operating system 
 

 Note 
You can find information about the software version of the latest PCS 7 version in the pcs7-readme file. 
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PC station Operating system Service pack License 
Single station or Client for: 
• OS 
• SIMATIC BATCH 
• SIMATIC Route Control 

Required Microsoft license 

Engineering station 

MS Windows XP Professional 
(32-bit version) 

Required Microsoft license 
Engineering station for multiproject engineering  Required 
Server (redundant and non-redundant) for: 
• OS 
• Archive servers 
• Maintenance server 
• Web 
• SIMATIC BATCH 
• SIMATIC Route Control 

Required 

File server for multiuser engineering 

MS Windows Server 2003 
(32-bit version) 

Required 

Microsoft license  
Note on installing a server: 
 We recommend licensing per workplace.  
With licensing per server, you need to ensure a 
sufficient number of licenses. 

 

Introduction 
 

 Note 
In this section, we only use the term license key, even if a product is still using the older "authorization". 
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Legend for the tables below 
 
Column Value Meaning 

Yes Software is installed by means of the PCS 7 setup. 
No Software is not installed by means of the PCS 7 setup. 

PCS 7 setup 

No entry Software is automatically installed, with the software named in the Remark column, by means of the PCS 7 setup. 
X Installation required 
(X) Installation optional, see the Remark column  

PC station 
(type of PC station) 

(Z) You will find information on license key levels in the section "Selecting the correct license keys/authorizations 
(Page 117)". 
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Software packages and required license keys 
The table below shows which license keys you require for each software package. 

 

 Note 
The versions for the current Process Control System; PCS 7 Toolset V7.0 program package can be found in the pcs7-readme 
file. 

 
 

 
PC station Product name License PCS 7 

setup ES Single station 
Remark 

PCS 7 ES 
Runtime License AS (only required for 
loading the AS) 

AS RT PO  No (z) (z) Scope: Limited to the number of 
process objects that can be loaded 
into the AS.  

STEP 7 STEP 7 Yes X X H systems are integrated. 
H System (License) SIK/SIMATIC H Systems Vx.y  (X) (X) For H systems: (X) product is always 

installed if STEP 7 is installed. 
CFC CFC (z) Yes (z) (z) Configuration limited to the number 

of process objects (PO = operator-
controllable function block with 
attribute S7_m_c). 

SFC SFC  Yes X X  
SCL S7 SCL  Yes X X  
PH PH PO Yes X X  
IEAPO IEA Yes X X License key only required to use the 

IEA option. 
AS-OS Engineering  Yes (X) (X) (X) Product is always installed if 

STEP 7 and WinCC are installed. 
PV InsInfo-Server  Yes (X) (X)  
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PC station 
SFC Visualization SFC Visualization  Yes (X) (X) (X) Product is always installed if 

WinCC is installed. 
DOCPRO SIK/SIMATIC DOCPRO  Yes (X) (X)  
Version Cross Manager Version Cross Manager Yes (X) (X)  
S7 PLC Simulation PLCSIM  Yes (X) (X)  
PCS 7 Library 7.0  Yes X X  
PCS 7 Faceplates  Yes X X  
PCS 7 PID Tuner SIK/SIMATIC PID Tuner  Yes (X) (X)  
Version Trail  Yes X X  
SIMATIC BATCH Engineering  Yes (X) (X) (X) Product only required for 

SIMATIC BATCH. 
Route Control Engineering Route Control Engineering Yes (X) (X) (X) Product only required for 

SIMATIC Route Control. 
Maintenance ES Maintenance ES Yes (X) (X) (X) Product only required for the 

maintenance station. 
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PC station Product name 
Version 

License PCS 7 
setup SIMATIC PCS 7 BOX 

416 
SIMATIC PCS 7 BOX 
RTX 

Remark 

SIMATIC PCS 7 BOX (ES, OS, AS) 
WinAC for SIMATIC S7 Slot CPU 416-
2 PCI 

WinAC for SIMATIC S7 Slot  
CPU 416-2 PCI 

No X   

WinLC RTX WinLC RTX No  X  
Software on the PCS 7 Toolset DVD 
(ES installation) 

 Yes (z) (z)  

Software on the PCS 7 Toolset DVD 
(OS installation) 

WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z)  

Software on the PCS 7 Toolset DVD 
(SIMATIC PDM) 

 Yes (z) (z)  

Software on the PCS 7 Toolset DVD 
(SIMATIC BATCH) 

BATCH (z) UNITs Yes (z)   

Maintenance Station Maintenance RT (z) Yes (z) (z)  

 

Introduction 
 

 Note 
In this section, we only use the term license key, even if a product is still using the older "authorization". 
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Legend for the tables below 
 
Column Value Meaning 

Yes Software is installed by means of the PCS 7 setup. 
No Software is not installed by means of the PCS 7 setup. 

PCS 7 setup 

No entry Software is automatically installed, with the software named in the Remark column, by means of the PCS 7 setup. 
X Installation required 
(X) Installation optional, see the Remark column  

PC station 
(type of PC station) 

(Z) You will find information on license key levels in the section "Selecting the correct license keys/authorizations 
(Page 117)". 

Software packages and required license keys 
The table below shows which license keys you require for each software package. 

 

 Note 
The versions for the current Process Control System; PCS 7 Toolset V7.0 program package can be found in the pcs7-readme file. 
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Product name License key System setup OS  
single station 

OS server OS client Remark  

Operator station 
WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z) (z) Only WinCC RT PO Client for OS 
client 

WinCC Server Yes  X   
WinCC Redundancy Yes  (X)  Only required for redundancy 

Basic System 

WinCC User Archives Yes (X) (X) (X)  
WinCC Advanced Process Ctrl Yes X X X  

WinCC 

LTO 
Chip Card Yes (X) (X) (X) WinCC chip card reader required 

(only active in process mode) 
Drivers (Multi VGA)  No (X) (X) (X) Suitable graphics card drivers for 

the version (see readme.wri) 
PCS 7 Faceplates  Yes X X X Automatically installed with WinCC 
OPC  Yes X X X Automatically installed with WinCC 
SIMATIC NET BCE BCE  Yes (X) (X)  License only for a standard Ethernet 

interface module (not required for 
SIMATIC NET CP 1613) 

 S7 REDCONNECT  (X) (X)  Only required for connecting to 
redundant AS 

WinCC Connectivity Station WinCC Connectivity Station      
Web Server  WinCC WebNavigator (z) Yes (z)  (z) Note: Server operating system 

required 
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Product name License key System setup Central archive 
server 

Redundant central 
archive server 

Remark  

Central archive server 
WinCC RT (128) 
WinCC Archive (z) 

Yes (z) (z) Only WinCC RT PO Client for OS 
client 

WinCC Server Yes (X) (X)  
WinCC Redundancy Yes  X  

Basic System 

WinCC User Archives Yes (X) (X)  
WinCC Advanced Process Ctrl Yes X X  

WinCC 

LTO 
Chip Card Yes (X) (X) WinCC chip card reader required 

(only active in process mode) 
StoragePlus StoragePlus  Yes X X X 
Batch Report  Yes X X X 

 
 
Product name License key System setup Single station MS server Redundant 

MS server 
Remark  

Maintenance station 
Maintenance Station Maintenance RT (z) Yes (z) (z) (z)  
Maintenance Station 
Engineering 

Maintenance ES Yes X    

 
 
Product name License key System setup OS  

single station 
OS server OS client Remark  

PCS 7 - AS 
SIMATIC NET PC SW BCE  Yes X X  License only for a standard Ethernet 

interface module (not required for 
SIMATIC NET CP 1613) 
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Product name License key System setup OS server for BATCH OS client for BATCH  Remark  
Operator station for BATCH 

WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z) Only WinCC RT PO Client for OS 
client 

WinCC Server Yes  X  
WinCC Redundancy Yes  (X) Only required for redundancy 

Basic System 

WinCC User Archives Yes (X) (X)  
WinCC Advanced Process Ctrl Yes X X  

WinCC 

LTO 
Chip Card Yes (X) (X) WinCC chip card reader required 

(only active in process mode) 
SFC Visualization  Yes X X  
PCS 7 Faceplates  Yes X X Automatically installed with WinCC 
SIMATIC NET BCE  Yes X  License only for a standard Ethernet 

interface module (not required for 
CP 1613) 

BATCH WinCC Client Options  Yes X X  
BATCH WinCC Server Options  Yes X   
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Product name License key System setup SIMATIC PCS 7 BOX 
416 
(ES 
AS 
OS 
BATCH) 

SIMATIC PCS 7 BOX 
416 
(only 
AS 
OS 
BATCH) 

Remark  

PCS 7 BOX 
WinLC RTX WinLC RTX No    
Software on the PCS 7 
Toolset DVD 
(ES installation) 

 Yes (z)   

Software on the PCS 7 
Toolset DVD 
(OS installation) 

WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z)  

Software on the PCS 7 
Toolset DVD 
(SIMATIC PDM) 

 Yes (z)   

Software on the PCS 7 
Toolset DVD 
(SIMATIC BATCH) 

BATCH (z) UNITs Yes (z) (z)  

Maintenance Station Maintenance RT (z) Yes (z) (z)  
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Introduction 
 

 Note 
In this section, we only use the term license key, even if a product is still using the older "authorization". 

 

Legend for the tables below 
 
Column Value Meaning 

Yes Software is installed by means of the PCS 7 setup. 
No Software is not installed by means of the PCS 7 setup. 

PCS 7 setup 

No entry Software is automatically installed, with the software named in the Remark column, by means of the PCS 7 setup. 
X Installation required 
(X) Installation optional, see the Remark column  

PC station 
(type of PC station) 

(Z) You will find information on license key levels in the section "Selecting the correct license keys/authorizations 
(Page 117)". 
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Software packages and required license keys 
The table below shows which license keys you require for each software package. 

 

 Note 
The versions for the current Process Control System; PCS 7 Toolset V7.0 program package can be found in the pcs7-readme file. 

 
 

 
Product name Version 

License key 
System setup BATCH single 

station 
BATCH server, 
redundant  
BATCH server 

BATCH client Remark  

SIMATIC BATCH 
BATCH Base  Yes X X X Basic installation for all  

SIMATIC BATCH PCs 
BATCH Server BATCH (z) UNITs  Yes (z) (z)   
BATCH API BATCH API  X X   
BATCH Fastobjects   X X  License  
BATCH Separation 
Procedures/Formulas 

BATCH Formula  X X   

BATCH Hierarchical Recipe BATCH Hierarchical Recipe  X X   
BATCH ROP Library V7.0 BATCH Library  X X   
BATCH Client - BCC BATCH BatchCC Yes   X And/or BATCH Recipe System 
BATCH Client - RZE BATCH Recipe System Yes   X And/or BATCH Control 
BATCH Client - Report     X  
BATCH Planning BATCH Planning    X  
Getting Started  Yes   X  
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Product name License key System setup BATCH single 
station 

BATCH server, 
redundant BATCH 
server 

BATCH client Remark  

PCS 7 - AS 
SIMATIC NET PC SW BCE  Yes X X  License only for a standard Ethernet 

interface module (not required for 
SIMATIC NET CP 1613) 

 
 
Product name  

License key 
System setup OS server for BATCH OS client for BATCH  Remark  

Operator station for BATCH 
WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z) Only WinCC RT PO Client for OS 
client 

WinCC Server Yes  X  
WinCC Redundancy Yes  (X) Only required for redundancy 

Basic System 

WinCC User Archives Yes (X) (X)  
WinCC Advanced Process Ctrl Yes X X  

WinCC 

LTO 
Chip Card Yes (X) (X) WinCC chip card reader required 

(only active in process mode) 
SFC Visualization  Yes X X  
PCS 7 Faceplates  Yes X X Automatically installed with WinCC 
SIMATIC NET BCE  Yes X  License only for a standard Ethernet 

interface module (not required for 
CP 1613) 

BATCH WinCC Client 
Options 

 Yes X X  

BATCH WinCC Server 
Options 

 Yes X   
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Product name License key System setup SIMATIC PCS 7 BOX 
416 
(ES 
AS 
OS 
BATCH) 

SIMATIC PCS 7 BOX 
416 
(only 
AS 
OS 
BATCH) 

Remark  

PCS 7 BOX 
WinLC RTX WinLC RTX No    
Software on the PCS 7 
Toolset DVD 
(ES installation) 

 Yes (z)   

Software on the PCS 7 
Toolset DVD 
(OS installation) 

WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z)  

Software on the PCS 7 
Toolset DVD 
(SIMATIC PDM) 

 Yes (z)   

Software on the PCS 7 
Toolset DVD 
(SIMATIC BATCH) 

BATCH (z) UNITs Yes (z) (z)  

Maintenance Station Maintenance RT (z) Yes (z) (z)  
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Introduction  
 

 Note 
In this section, we only use the term "license key", even if a product is still using the older "authorization". 

 
 

 

 Note 
In this section, we only use the term "license key", even if a product is still using the older "authorization". 

 

Legend for the tables below 
 
Column Value Meaning 

Yes Software is installed by means of the PCS 7 setup. 
No Software is not installed by means of the PCS 7 setup. 

PCS 7 setup 

No entry Software is automatically installed, with the software named in the Remark column, by means of the PCS 7 setup. 
X Installation required 
(X) Installation optional, see the Remark column  

PC station 
(type of PC station) 

(Z) You will find information on license key levels in the section "Selecting the correct license keys/authorizations 
(Page 117)". 
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Software packages and required license keys 
The table below shows which license keys you require for each software package. 

 

 Note 
The "Version" column is empty so that you can enter the correct data for your plant documentation. The versions for the current Process Control 
System; PCS 7 Toolset V7.0 program package can be found in the pcs7-readme file. 

 
 

 
Product name Version License key System setup Route Control 

single station 
Route Control 
server 

Route 
Control 
client 

Remark  

Optional packages for all PCS 7 PCs 
SIMATIC Logon Service  Logon Service Yes (X) (X) (X) (X) All stations which use 

applications managed by SIMATIC 
Logon Service require the SIMATIC 
Logon Service. 

SIMATIC Security Control   Yes (X) (X) (X) (X) Activate security settings for PC 
stations. 

 
 
Product name Version License key System setup Route Control 

single station 
Route Control 
server 

Route 
Control 
client 

Remark  

PCS 7 - AS 
SIMATIC NET PC SW  BCE  Yes X X  License only for a standard Ethernet 

interface module (not required for 
SIMATIC NET CP 1613) 
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Product name Version License key System setup Route Control 
single station 

Route Control 
server 

Route 
Control 
client 

Remark  

SIMATIC ROUTE Control 
Route Control Base    Yes X X X  
Route Control Engineering  Route Control 

Engineering  
Yes    Wizard in context of SIMATIC 

Manager, library blocks, engineering 
tool 

Route Control Server   Route Control Server (z) Yes (z) (z)  (also redundant) 
Route Control Client  Route Control Center  Yes X  X  
Route Control Library   Yes X    
Route Control Faceplate   Yes X  X  

 
 
Product name Version License key System setup SIMATIC PCS 7 BOX 

416 
(ES, 
AS, 
OS, 
BATCH, SIMATIC 
Route Control) 

SIMATIC PCS 7 BOX 
416 
(only 
AS, 
OS,  
BATCH,  
SIMATIC Route 
Control) 

Remark  

PCS 7 BOX 
WinLC RTX  WinLC RTX No    
Software on the PCS 7 
Toolset DVD 
(ES installation) 

  Yes (z)   

Software on the PCS 7 
Toolset DVD 
(OS installation) 

 WinCC RC (z)/WinCC 
RT (z) 
WinCC Archive (z) 

Yes (z) (z)  

Software on the PCS 7   Yes (z)   



 Appendix 
 5.2 Appendix B - Licensing of software packages 

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 199 

Product name Version License key System setup SIMATIC PCS 7 BOX 
416 
(ES, 
AS, 
OS, 
BATCH, SIMATIC 
Route Control) 

SIMATIC PCS 7 BOX 
416 
(only 
AS, 
OS,  
BATCH,  
SIMATIC Route 
Control) 

Remark  

Toolset DVD 
(SIMATIC PDM) 
Software on the PCS 7 
Toolset DVD 
(SIMATIC BATCH) 

 BATCH (z) UNITs Yes (z) (z)  

Software on the PCS 7 
Toolset DVD 
(SIMATIC Route Control) 

 Route Control (z) Yes (z) (z)  

Maintenance Station  Maintenance RT (z) Yes (z) (z)  

 
SIMATIC PCS 7 BOX is supplied with preinstalled software and DVDs for restoring the factory state.  

 

NOTICE  
The required license keys are on a separate license key diskette in the factory state. Back up the license keys if possible before restoring the 
factory state. 
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Legend for the tables below 
 
Column Value Meaning 

Yes Software is installed by means of the PCS 7 setup. 
No Software is not installed by means of the PCS 7 setup. 

PCS 7 setup 

No entry Software is automatically installed, with the software named in the Remark column, by means of the PCS 7 setup. 
X Installation required 
(X) Installation optional, see the Remark column  

PC station 
(type of PC station) 

(Z) You will find information on license key levels in the section "". 
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Preinstalled software and required license keys 
● You can find information about which license keys are needed for the ES installation or SIMATIC PDM in the section "Software packages and 

required license key (Page 166)". 
● You can find information about which license keys are needed for the OS installation in the section "Software packages and required license 

key (Page 166)". 
● You can find information about which license keys are needed for the SIMATIC BATCH in the section "Software packages and required 

license key (Page 166)". 
● You can find information about which license keys are needed for the SIMATIC Route Control in the section "Software packages and required 

license key (Page 166)". 
 
Product name License key System setup SIMATIC PCS 7 BOX 

416 
(ES 
AS 
OS 
BATCH 
Route Control) 

SIMATIC PCS 7 BOX 
416 
(only 
AS 
OS 
BATCH  
Route Control) 

Note  

PCS 7 BOX 416 
Software on the PCS 7 Toolset 
DVD 
(ES installation) 

 Yes (z)   

Software of the PCS 7 Toolset 
DVD 
(OS installation) 

WinCC RC (z) /WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z)  

Software of the PCS 7 Toolset 
DVD 
(SIMATIC PDM) 

 Yes (z)   

Software of the PCS 7 Toolset 
DVD 
(SIMATIC BATCH) 

BATCH (z) UNITs Yes (z) (z)  
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Product name License key System setup SIMATIC PCS 7 BOX 
416 
(ES 
AS 
OS 
BATCH 
Route Control) 

SIMATIC PCS 7 BOX 
416 
(only 
AS 
OS 
BATCH  
Route Control) 

Note  

Software of the PCS 7 Toolset 
DVD 
(SIMATIC Route Control) 

Route Control (z) routes Yes (z) (z)  

Maintenance Station Maintenance RT (z) Yes (z) (z)  

 
 
Product name License key System setup SIMATIC PCS 7 BOX 

RTX 
(ES 
AS 
OS 
BATCH 
Route Control) 

SIMATIC PCS 7 BOX 
RTX 
(only 
AS 
OS 
BATCH  
Route Control) 

Remark  

PCS 7 BOX RTX 
PCS 7 ASRTX RTX No    
WinAC RTX WinLC RTX No    
Software of the PCS 7 Toolset 
DVD 
(ES installation) 

 Yes (z)   

Software on the PCS 7 Toolset 
DVD 
(OS installation) 

WinCC RC (z)/WinCC RT (z) 
WinCC Archive (z) 

Yes (z) (z)  
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Product name License key System setup SIMATIC PCS 7 BOX 
RTX 
(ES 
AS 
OS 
BATCH 
Route Control) 

SIMATIC PCS 7 BOX 
RTX 
(only 
AS 
OS 
BATCH  
Route Control) 

Remark  

Software on the PCS 7 Toolset 
DVD 
(SIMATIC PDM) 

 Yes (z)   

 
 
Product name License key System setup SIMATIC PCS 7 BOX AS RTX  
PCS 7 BOX AS RTX 
PCS 7 AS RTX RTX No    
WinAC RTX WinLC RTX No    

 

See also 
● Selecting the correct license keys/authorizations (Page  117) 
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5.3 Appendix C - Approved configurations on a PC station 

5.3.1 Approved configurations 

Introduction 
You can use a PC station for PCS 7 not only in the standard configuration. By installing 
additional program packages or taking advantage of special properties, you can use a PC 
station for several purposes (for example: 
● as an engineering station with BATCH client installation (Configurations with engineering 

station, clients and single station (Page 208)) 
● as an OS server and operator station (client installation on server (Page 209)) 
● as an OS server and BATCH server (server on server (Page 208)) 

Standard configurations 
The following program packages are offered in the PCS 7 system setup when a PC station is 
installed:  
● Engineering 

– PCS 7 Engineering, BATCH Engineering, Route Control Engineering, PDM 
or 
● Runtime 

– For a single station:  
OS Single Station, BATCH Single Station, Route Control Single Station 

– For a server:  
OS Server, OS Server for BATCH, Maintenance Station, Central Archive Server, 
BATCH Server, Route Control Server 

– For a client:  
OS Client, OS Client for BATCH, BATCH Client, Route Control Client 

– For an Open PCS 7 station: 
Open PCS 7, OS Client with Open PCS 7 

– For a Web server: 
OS Web Server 

Notes for the reader on this section 
 

 Note 
In this section the activation of a standard configuration refers to the activation of an 
application, e.g., activation of a BATCH client's process mode. 
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Optimum performance 
To ensure that PCS 7 performs at its optimum level, we recommend that you only use 
standard configurations on a PC station. However, plant-specific conditions may mean that 
you have to equip a PC station with several program packages for standard configurations. If 
this is the case, you must observe the rules described below. 

Rules 
 

Concerns Rules 
PCS 7 project Only use the PC configurations described here within a PCS 7 project. 
Program packages Several program packages may be installed on a PC station. However, 

these stations may only be used simultaneously in exceptional cases (see 
the configuration tables below). 

Performance Activating several PCS 7 program packages will impair the performance of 
the individual applications. 

Configuring the PC 
station 

More powerful equipment may be required for the PC configurations 
described here (e.g., larger work memory, operating system). 
You will find information about the minimum performance requirements of 
the individual standard configurations in the catalog ST PCS 7. 

Using the PC station 
(installation) 

You can activate the properties of several standard configurations on a PC 
station if: 
• Other program packages have been installed in addition to the standard 

configuration (e.g., BATCH client on engineering station) or 
• You activate special properties of the standard configuration  

(e.g., OS workstation on OS server) 
Number of monitors on 
a PC station 

If you use a server as a workstation also, you can connect a maximum of 
five workstations (monitors) to that server (workstation on server + 
workstations on assigned clients). 

Central archive server Only install the central archive server on a separate PC station. 
A central archive server can be configured redundantly. 

Maintenance station The maintenance station is a configuration in the client-server architecture. 
You can configure the MS server with PCS 7 servers on a PC station, in 
accordance with Table 2 below. You must always use an ES with a process 
connection as an MS client. 

Configurations with 
several servers 

In the interests of maintaining performance levels, you must not use more 
than two server applications on a PC station. 

Starting and stopping 
a PCS 7 server 
application on 
redundant servers with 
several PCS 7 server 
applications 

If several PCS 7 server applications are active in process mode on one 
server of a pair (e.g., BATCH server and Route Control server), we 
recommend the following: 
Make sure that you always start or stop all of a server's PCS 7 server 
applications. This will allow you to avoid faults should a redundant server 
fail. 
Note: Should a PCS 7 server application on a PC of a PCS 7 server pair fail, 
all PCS 7 applications for this PC's process mode will be terminated 
automatically. 
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Approved configurations - PC station for several PCS 7 applications 
The tables below show the approved configurations of PC stations for several PCS 7 
applications. The flow chart below displays how the configurations are assigned to the 
operating systems: 

 
 

Example configuration: 
Example configuration for a redundant small system with five workstations: 
● 1 PC = 1 engineering station = 1 workstation 
● + 2 PCs = 1 redundant OS server = 2 workstations 
● + 2 PCs = 1 redundant BATCH server = 2 workstations 

 

  Note 
Each workstation can be designed as an OS client and/or a BATCH client. 
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Notes for the reader on the tables below  
 

 Note 
Read Tables 1 - 3 carefully from left to right. This means that a PC with a standard 
installation can also be used for an additional purpose (by using properties or an additional 
installation by means of the PCS 7 system setup). 
Example: 
If you use a PC station with the standard configuration "engineering station" as an "OS single 
station" too, the notes and restrictions defined under "A" (configuration type "A") will apply. 
Notes and restrictions: 
You will find information on this topic in the following sections: 
• Section "Information on configuration type "X" (Page 210)" 
• Section "Information on configuration type "-" (Page 210)" 
• Section "Information on configuration type "A" (Page 210)" 
• Section "Information on configuration type "B" (Page 210)" 
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5.3.2 Configuration tables 

5.3.2.1 Configurations with engineering station, clients and single station 

See also 
● Information on configuration type "A" (Page  210) 
● Information on configuration type "-" (Page  210) 
● Information on configuration type "X" (Page  210) 
● Information on configuration type "B" (Page  210) 

5.3.2.2 Configurations with server operating system (server to server) 

See also 
● Information on configuration type "X" (Page  210) 
● Information on configuration type "-" (Page  210) 
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5.3.2.3 Configurations with server operating system (client installation on server) 

Table 3 - Configurations with server operating system (client installation on server)  
 

 
Use Engineering 

station 
OS single 
station 

OS  
client 

BATCH 
single station 

BATCH 
client 

Route Control 
single station 

Route Control 
client 

Standard 
configuration 

       

OS server --- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

X (Page 210) X 
(Page 21
0) 

X (Page 210) X (Page 210) 

Redundant OS 
server 

--- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

--- (Page 210) X 
(Page 21
0) 

--- (Page 210) X (Page 210) 

Maintenance 
server 

--- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

X (Page 210) X 
(Page 21
0) 

X (Page 210) X (Page 210) 

Redundant 
maintenance 
server 

--- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

--- (Page 210) X 
(Page 21
0) 

--- (Page 210) X (Page 210) 

BATCH server --- (Page 210) X 
(Page 210) 

X 
(Page 
210) 

--- (Page 210) X 
(Page 21
0) 

X (Page 210) X (Page 210) 

Redundant 
BATCH server 

--- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

--- (Page 210) X 
(Page 21
0) 

--- (Page 210) X (Page 210) 

Route Control 
server 

--- (Page 210) X 
(Page 210) 

X 
(Page 
210) 

X (Page 210) X 
(Page 21
0) 

--- (Page 210) X (Page 210) 

Redundant 
Route Control 
server 

--- (Page 210) --- 
(Page 210) 

X 
(Page 
210) 

--- (Page 210) X 
(Page 21
0) 

--- (Page 210) X (Page 210) 
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5.3.3 Information on configurations 

5.3.3.1 Information on configuration type "X" 

No restrictions 
Read the configuration notes for the respective standard configurations. 

5.3.3.2 Information on configuration type "-" 

Restriction 
This configuration is not approved. 

5.3.3.3 Information on configuration type "A" 

Restriction 
If process mode is activated for an OS on the ES, simultaneous OS engineering can only be 
performed for this activated OS. 

5.3.3.4 Information on configuration type "B" 

Restrictions 
● No additional installation of an OS client is necessary since the OS workstation is already 

included in the standard configuration "Engineering Station". 
● Only one PCS 7 application on a PC station can be active during OS configuration 

(engineering station or OS workstation - no simultaneous operation possible). You cannot 
use the PC station as an OS workstation during AS configuration. 

Notes on configuration 
● You configure a stand-alone OS client within the project in SIMATIC Manager for this 

OS workstation. 
● You cannot and should not download the OS client project. 
Notes on process mode 
● SIMATIC Manager must be closed when opening the client project. If not, the OS client 

reads the server data from the engineering station! 
● Activate the OS client: 

1. Open WinCC Explorer 
2. Select the OS client project 
3. Change to process mode 
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Add-ons, 156 
Approved configurations, 213 
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Installation, 96 
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Basic engineering, 168 

Software, 168 
Basic information, 7 
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Additional services, 85 
Single station, 35 
Software, 171 

BATCH station, 14, 28, 136 
Calculating process objects, 136 
Determining the license key, 136 
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BCE, 108 
Bundle, 54 
Bundle PC, 138 

Preparing, 138 
Burner software, 160 
Bus connection, 46 

C 
Calculating the process objects for the central archive 
server, 133 
Changing the mode, 149 
Changing the transmission rate, 149 
Commissioning, 86 

Setting the color scheme, 86 
Setting the font size, 86 

Commissioning wizard, 146 
Configuration Console, 146 

Communication module, 144 
Selecting, 144 

Communication modules, 105, 106 
Driver, 105 
Installation, 106 

Components, 81 
Additional, 81 

Configuration, 61, 84 
Archive servers, central, 84 

Configurations with server operating system client 
installation on server, 209 
Connecting, 48, 57 

Plant bus, 48, 57 
Terminal bus, 48, 57 

CP 1613, 112 
Creating a backup, 87 

D 
Data communication, 157 
Data exchange using OPC, 43 
DCF77 module, 118 
Defragmentation, 165 
DiagMonitor, 161 
Disable, 110 
Disabling 

Network adapter energy saving options, 110 
Driver, 105 

Additional, 114 
Communication modules, 105 
PCS 7, 114 
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E 
Energy saving options, 110 

Disabling, 110 
Network adapters, 110 

Engineering station, 14, 18, 19, 23, 24, 25, 129 
Calculating process objects, 129 
Determining the license key, 129 
Single station, 25 
Single Station, 25 
Small system, 25 

F 
Firewall, 70, 152 

H 
Hardware, 54, 60, 64 

Optional, 60 
PC, 64 

Hotfixes, 151 
How to activate the firewall settings for OPEN PCS 
7, 153 
How to create user groups for SIMATIC Logon, 139 
How to create users for the OS, 141 
How to install the Message Queuing Service for 
Windows Server 2003, 80 

I 
Information on configuration, 210 
Information on configuration type -, 210 
Information on configuration type B, 210 
Information on configuration type X, 210 
Installation, 64, 66, 72, 79, 82, 88, 91, 92, 96, 106 

Archive servers, 96 
Communication modules, 106 
Message Queuing service, 79 
MS SQL Server, 82 
Operating system, 72 
Partitioning hard disks, 66 
PC, 64 
PCS 7, 88, 91, 92 
Software, 66 

Installing, 85 
Services for SIMATIC BATCH, 85 

L 
Language settings, 142 

License, 119 
License key, 119, 129, 130, 134, 136, 137, 175, 191, 
195, 201, 205 

BATCH station, 136 
Engineering station, 129 
Maintenance station, 134 
Operator station, 130 
Route control station, 137 
Software, 175, 191, 195, 201, 205 

License keys, 122, 124 
Selecting, 124 
Selection, 124 
Transferring, 122 

Licenses, 7 
Licensing, 119 
Long-term archiving, 32 

Archive servers, 32 

M 
Maintenance station, 14, 30, 37, 134 

Calculating process objects, 134 
Determining the license key, 134 
Multiple station system, 30 
Single station system, 37 

Maintenance Station 
Multiple station system, 30 

Message Queuing service, 79 
Installation, 79 

Monitoring the plant bus, 112 
MS SQL Server, 82 

Installation, 82 
MUI, 142 
Multiple station system, 26, 29, 30 

Maintenance station, 30 
Operator station, 26 
Route control station, 29 

Multiple station systems, 28 
BATCH station, 28 

N 
Network, 70 

Protection, 70 
Network adapters, 110 

Disabling energy saving options, 110 
Network configuration, 155 

PC stations, 155 
Network security, 70 
Network settings, 70 
Note on installation, 67 



 Index 
  

PC Configuration and Authorization 
Operating Manual, 09/2007, A5E00783465-02 213 

Operating system, 67 

O 
Operating system, 67, 72 

Installation, 72 
Note on installation, 67 

Operator station, 14, 25, 26, 33, 40, 130 
Access over a Web client, 40 
Calculating process objects, 130 
Determining the license key, 130 
Intranet/Internet, 40 
Multiple station system, 26 
Single station, 25, 33 
Small system, 25 
Web client, 40 
Web server, 40 

Operator stations, 170 
Software, 170 

Option, 60 
Hardware, 60 

Options, 173 
Software, 173 

Order, 61 
OS 

Redundancy connection, 144 
OS/BATCH server, 98 

Activating redundancy, 98 

P 
Paged memory, 76 
Paging file, 76 
Partitioning hard disks, 66 

Installation, 66 
PC, 64 

Hardware, 64 
Installation, 64 
Software, 64 

PC configuration, 70 
Security settings, 70 

PC configurations, 38 
SIMATIC PCS 7 BOX, 38 

PC station, 146, 213 
Approved configurations, 213 
Commissioning wizard, 146 
Setting, 146 

PC stations, 138, 155 
Network configuration, 155 
Overview of the preparations, 138 

PCS 7, 88, 91, 92, 114 

Additional drivers, 114 
Installation, 88, 91, 92 
Software, 88 

Plant bus, 14, 46, 48, 57 
Connecting, 48, 57 

Process objects, 129, 130, 134, 136 
BATCH station, 136 
Engineering station, 129 
Maintenance station, 134 
Operator station, 130 

Product bundle, 54 
Programs, 165 

Additional, 156 
Defragmentation, 165 

R 
Recommended basic hardware configuration, 54 
Redundancy, 16 
Redundancy connection 

OS, 144 
Reinstallation, 103 
Route control, 36 

Single station, 36 
Route control station, 29, 137 

Calculating routes, 137 
Determining the license key, 137 
Multiple station system, 29 

Route Control Station, 14 
Routes, 137 

Route control station, 137 

S 
Screen savers, 164 
Security, 70, 152 
Security patches, 151 
Security settings, 70, 152 
Service pack, 75, 151 

Installing, 75 
Service packs, 151 
Setting, 146 

PC station, 146 
Setting the color scheme, 86 
Setting the font size, 86 
Setting up a user, 140 
Settings, 86, 148 

Color scheme, 86 
Font size, 86 
Standard network adapters, 148 

SIMATIC BATCH, 35, 171 
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Single station, 35 
Software, 171 

SIMATIC PCS 7 BOX, 38 
PC configurations, 38 

SIMATIC PCS 7 BOX, 14 
SIMATIC PCS 7 Web option, 98 
SIMATIC Shell 

Redundancy, 144 
Single station, 25, 33, 35, 36 

Engineering station, 25 
Operator station, 25, 33 
Route control, 36 
SIMATIC BATCH, 35 

Single station system, 37 
Maintenance station, 37 

Softnet CP, 108 
Software, 64, 66, 88, 168, 170, 171, 173, 175, 191, 
195, 201, 205 

Authorizations, 175, 191, 195, 201, 205 
Basic engineering, 168 
Installation, 66 
License key, 175, 191, 195, 201, 205 
Operator stations, 170 
Optional, 173 
PC, 64 
PCS 7 installation, 88 
SIMATIC BATCH, 171 

Software packages for SIMATIC Route Control, 172 
Sound card, 117 
Standard communication modules, 108 
Standard network adapters, 148 

Settings, 148 
StoragePlus, 32, 96 
System settings, 77 
System setup, 92 

T 
Terminal bus, 14, 46, 48, 57 

Connecting, 48, 57 
Time synchronization, 51 
Transferring, 122 

License keys, 122 

U 
Update, 103 
Updates, 151 
Utilities, 156 

V 
Validity, 7 
Virus scanners, 160 

W 
Web client, 40 

Operator station, 40 
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